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1
Safety
This chapter contains:

• Notices and Safety... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
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Your printer and the recommended supplies have been designed and tested to meet strict safety
requirements. Attention to the following information ensures the continued safe operation of your
Xerox printer.



Notices and Safety
Read the following instructions carefully before operating your printer. Refer to these instructions to
ensure the continued safe operation of your printer.

Your Xerox® printer and supplies are designed and tested to meet strict safety requirements. These
include safety agency evaluation and certification, and compliance with electromagnetic regulations
and established environmental standards.

The safety and environment testing and performance of this product have been verified using Xerox®

materials only.

Note: Unauthorized alterations, which can include the addition of new functions or connection
of external devices, can affect the product certification. For more information, contact your
Xerox representative.
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Electrical Safety

GGeenneerraall GGuuiiddeelliinneess
WARNING:

• Do not push objects into slots or openings on the printer. Touching a voltage point or
shorting out a part could result in fire or electric shock.

• Do not remove the covers or guards that are fastened with screws unless you are installing
optional equipment and are instructed to do so. Power off the printer when performing
these installations. Disconnect the power cord when removing covers and guards for
installing optional equipment. Except for user-installable options, there are no parts that
you can maintain or service behind these covers.

The following are hazards to your safety:

• The power cord is damaged or frayed.

• Liquid is spilled into the printer.

• The printer is exposed to water.

• The printer emits smoke, or the surface is unusually hot.

• The printer emits unusual noise or odors.

• The printer causes a circuit breaker, fuse, or other safety device to activate.

If any of these conditions occur, do the following:

1. Power off the printer immediately.

2. Disconnect the power cord from the electrical outlet.

3. Call an authorized service representative.

PPoowweerr CCoorrdd
Use the power cord supplied with your printer.

• Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the
cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check
the outlet.

WARNING: To avoid risk of fire or electrical shock, do not use extension cords, power
strips, or power plugs for more than 90 days. When a permanent outlet receptacle
cannot be installed, use only one factory-assembled extension cord of the appropriate
gauge for each printer or multifunction printer. Always adhere to national and local
building, fire, and electrical codes regarding length of cord, conductor size, grounding,
and protection.

• Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have
a ground connection terminal.

• Verify that the printer is plugged into an outlet that is providing the correct voltage and power.
Review the electrical specification of the printer with an electrician if necessary.

• Do not place the printer in an area where people can step on the power cord.

Xerox® VersaLink® C8000/C9000 Color Printer
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• Do not place objects on the power cord.

• Do not plug or unplug the power cord while the power switch is in the On position.

• If the power cord becomes frayed or worn, replace it.

• To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power
cord.

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is
necessary to disconnect all electrical power from the printer, disconnect the power cord from the
electrical outlet.

EEmmeerrggeennccyy PPoowweerr OOffff
If any of the following conditions occur, power off the printer immediately and disconnect the power
cord from the electrical outlet. Contact an authorized Xerox service representative to correct the
problem if:

• The equipment emits unusual odors or makes unusual noises.

• The power cable is damaged or frayed.

• A wall panel circuit breaker, fuse, or other safety device has been tripped.

• Liquid is spilled into the printer.

• The printer is exposed to water.

• Any part of the printer is damaged.
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Operational Safety
Your printer and supplies were designed and tested to meet strict safety requirements. These include
safety agency examination, approval, and compliance with established environmental standards.

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your
printer.

OOppeerraattiioonnaall GGuuiiddeelliinneess
• Do not remove any trays when the printer is printing.

• Do not open the doors when the printer is printing.

• Do not move the printer when it is printing.

• Keep hands, hair, neckties, and so on, away from the exit and feed rollers.

• Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove
the protective covers.

• Do not override any electrical or mechanical interlock devices.

• Do not attempt to remove paper that is jammed deeply inside the printer. Switch off the printer
promptly and contact your local Xerox representative.

WARNING:

• The metallic surfaces in the fuser area are hot. Always use caution when removing paper
jams from this area and avoid touching any metallic surfaces.

• To avoid a tip hazard, do not push or move the device with all the paper trays extended.

OOzzoonnee RReelleeaassee
This printer produces ozone during normal operation. The amount of ozone produced is dependent on
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone.
Install the printer in a well-ventilated room.

For more information in the United States and Canada, go to www.xerox.com/about-xerox/
environment/enus.html. In other markets, please contact your local Xerox representative or go to
www.xerox.co.uk/about-xerox/environment/engb.html.

PPrriinntteerr LLooccaattiioonn
• Place the printer on a level, solid, non-vibrating surface with adequate strength to hold its weight.

To find the weight for your printer configuration, refer to Physical Specifications.

• Do not block or cover the slots or openings on the printer. These openings are provided for
ventilation and to prevent overheating of the printer.

• Place the printer in an area where there is adequate space for operation and servicing.

• Place the printer in a dust-free area.

• Do not store or operate the printer in an extremely hot, cold, or humid environment.

• Do not place the printer near a heat source.
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• Do not place the printer in direct sunlight to avoid exposure to light-sensitive components.

• Do not place the printer where it is directly exposed to the cold air flow from an air conditioning
system.

• Do not place the printer in locations susceptible to vibrations.

• For optimum performance, use the printer at the elevations specified in Elevation.

PPrriinntteerr SSuupppplliieess
• Use the supplies designed for your printer. The use of unsuitable materials can cause poor

performance and a possible safety hazard.

• Follow all warnings and instructions marked on, or supplied with, the product, options, and
supplies.

• Store all consumables in accordance with the instructions given on the package or container.

• Keep all consumables away from the reach of children.

• Never throw toner, toner cartridges, drum cartridges, or waste cartridges into an open flame.

• When handling cartridges, for example toner and such, avoid skin or eye contact. Eye contact can
cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can
increase the risk of skin or eye contact.

Caution: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service
Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or
degradation of performance caused by use of non-Xerox supplies, or the use of Xerox supplies
not specified for this printer. The Total Satisfaction Guarantee is available in the United States
and Canada. Coverage could vary outside these areas. Please contact your Xerox representative
for details.
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Maintenance Safety
• Do not attempt any maintenance procedure that is not specifically described in the documenta-

tion supplied with your printer.

• Clean with a dry lint-free cloth only.

• Do not burn any consumables or routine maintenance items. For information on Xerox® supplies
recycling programs, go to www.xerox.com/recycling.

WARNING: Do not use aerosol cleaners. Aerosol cleaners can cause explosions or fires when
used on electromechanical equipment.

When installing the device in a hallway or similar restricted area, additional space requirements can
apply. Ensure that you comply with all workspace safety regulations, building codes, and fire codes for
your area.
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Printer Symbols
For details about all the printer symbols that appear on your printer, refer to the Printer Symbols
guide:

• Xerox® VersaLink® C8000 Color Printer: www.xerox.com/support/VLC8000docs

• Xerox® VersaLink® C9000 Color Printer: www.xerox.com/support/VLC9000docs

Symbol Description

Warning:

Indicates a serious hazard that can result in death or serious injury if not avoided.

Hot Warning:

Hot surface on or in the printer. Use caution to avoid personal injury.

Warning: Moving parts. To avoid personal injury, use caution.

Caution:

Indicates a mandatory action to take in order to avoid damage to the property.

Caution:

To avoid damage to the property, be careful not to spill toner when handling the
waste cartridge.

Do not touch the part or area of the printer.

Do not expose the drum cartridges to direct sunlight.

Do not burn the toner cartridges.

Do not burn the waste cartridge.
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Symbol Description

Do not burn the drum cartridges.

Do not use paper attached with staples or any form of binding clip.

Do not use folded, creased, curled, or wrinkled paper.

Do not use inkjet paper.

Do not use transparencies or overhead projector sheets.

Do not reload paper previously printed on or used.

Do not copy money, revenue stamps, or postage stamps.

Xerox® VersaLink® C8000/C9000 Color Printer
User Guide

17

Safety



Environmental, Health, and Safety Contact
Information
For more information on Environment, Health, and Safety in relation to this Xerox product and sup-
plies, contact:

• United States and Canada: 1-800-ASK-XEROX (1-800-275-9376)

• Europe: EHS-Europe@xerox.com

For product safety information in the United States and Canada, go to www.xerox.com/about-xerox/
environment.

For product safety information in Europe, go to www.xerox.com/about-xerox/environment_europe.
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Parts of the Printer
FFrroonntt VViieeww

1. Paper Trays (configurations vary from 2 to
4 trays)

2. USB Port

3. Control Panel

4. Center Top Tray

5. Center Bottom Tray

6. Front Door

IInntteerrnnaall PPaarrttss

1. Transfer Roller

2. Fuser

3. Toner Cartridges

4. Main Power Switch

5. Transfer Belt Cleaner

6. Waste Cartridge

7. Drum Cartridges

8. Waste Toner Transport Unit
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RReeaarr VViieeww

1. Power Connection

2. Foreign Device Interface

3. Wi-Fi Connectivity Port

4. Ethernet Port

5. USB Host Port

6. USB Device Port

7. Right Rear Cover

8. Door A

9. Bypass Tray

10. Door B

PPaappeerr TTrraayy OOppttiioonnss

1. Base Model

2. Printer with Tandem Tray Module

3. Printer with Two-Tray Module

4. Printer with Two-Tray Module and High-
Capacity Feeder
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FFiinniisshhiinngg OOppttiioonnss

OOffffiiccee FFiinniisshheerr LLXX

1. Front Transport Cover

2. Hole-Punch Waste Container (optional)

3. Hole-Punch Unit (optional)

4. Horizontal Transport Unit, Center Catch
Tray

5. Finisher Top Cover

6. Booklet Maker Staple Cartridge (optional)

7. Booklet Maker Side Cover (optional)

8. Booklet Maker (optional)

9. Right Tray Attachment

10. Right Tray

11. Creaser Unit (optional)

12. Staple Cartridge

13. Finisher Front Cover

14. Office Finisher LX

BBuussiinneessss RReeaaddyy FFiinniisshheerr wwiitthh BBooookklleett MMaakkeerr
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1. Horizontal Transport Unit (Center Tray)

2. Finisher Front Cover

3. Right Top Tray

4. Right Middle Tray

5. Staple Cartridge

6. Booklet Maker Tray (Right Bottom Tray)

7. Booklet Staple Unit

8. Booklet Maker Unit

CCoonnttrrooll PPaanneell
The control panel consists of a touch screen and buttons that you press to control the functions
available on the printer. The control panel:

• Displays the current operating status of the printer.

• Provides access to printing features.

• Provides access to reference materials.

• Provides access to Tools and Setup menus.

• Prompts you to load paper, replace supplies, and clear jams.

• Displays errors and warnings.

• Provides the Power/Wake button used for powering on or off the printer. This button also supports
the power-saver modes, and blinks to indicate the power status of the printer.

Item Name Description

1 NFC Area

(Optional)

Near Field Communication (NFC), is a technology that enables
devices to communicate when they are within 10 cm (4 in.) of
each other. Use the NFC area to obtain a network interface or to
establish a TCP/IP connection between your device and the
printer.

Note: The indicator is visible when NFC is activated.

2 Home Button This button provides access to the Home menu for access to
printer features.
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Item Name Description

3 Touch Screen Display The screen displays information and provides access to printer
functions.

4 Power/Wake Button This button serves several power-related functions.
• When the printer is powered off, this button powers on the

printer.
• When the printer is powered on, pressing this button displays

a menu on the control panel. From this menu, you can choose
to enter Sleep mode, restart or power off the printer.

• When the printer is powered on, but in a low-power mode or
Sleep mode, pressing this button wakes the printer.

• When the printer is powered on, holding this button for 10
seconds turns off the printer.

• This button blinks to indicate the power status of the printer.
• When the light blinks slowly, the printer is in low-power mode

or Sleep mode.
• When the light blinks rapidly, the printer is powering down, or

exiting a low-power mode.

5 Status LED This light blinks blue or amber to indicate printer status.
• Blue

– Blinks blue once to acknowledge a successful
Authentication request.

– Blinks blue once slowly for a print job initiated at the
control panel.

– Blinks blue twice slowly for a print job received from the
network.

– Blinks blue rapidly while the printer is powering up, or to
signal detection of a Wi-Fi Direct connection request.

• Amber

– Blinks amber to indicate an error condition or warning
that requires your attention. For example, an out-of-toner
condition, a paper jam, or an out-of-paper condition for
the current job.

– It also blinks amber to indicate a system error, which
typically is associated with an error code.

6 Pause Icon When a job is being scanned or processed, a Pause icon appears
in the notification banner area. To pause the current job, touch
the Pause icon. The job pauses with the option to resume or
delete the job.

7 Notification Banner Notifications and messages are displayed in a pop-up banner
below the apps area. To view the full notification, touch the
center of the banner. After you have reviewed the information,
touch X to close.
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Power Options
The Power/Wake button is a single multifunction button on the control panel.

• When used in conjunction with the main power switch, the Power/Wake button powers on the
printer.

• If the printer is already powered on, the Power/Wake button can be used to:

– Restart the printer

– Enter or exit sleep mode

– Enter or exit low-power mode

• The Power/Wake button also flashes when the printer is in low-power mode.

PPoowweerr SSaavveerr
You can set the time the printer spends idle in ready mode before the printer transitions to a lower
power level.

There are two levels of power-saver mode.

• Low-Power Timeout: The printer shifts from Ready mode to Low-Power mode to reduce standby
power consumption.

• Sleep Timeout: The printer shifts from Low-Power mode to Sleep mode for a greater reduction in
power consumption.

EEnntteerriinngg aanndd EExxiittiinngg SSlleeeepp MMooddee aanndd LLooww--PPoowweerr
MMooddee
After the printer is powered on but is in Sleep Mode or Low-Power Mode:

• The touch screen appears blank and unresponsive.

• The printer exits Low-Power mode or Sleep mode automatically when it receives data from a
connected device.

To wake the printer manually, press the Power/Wake button.
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PPoowweerriinngg OOnn tthhee PPrriinntteerr
To power on the printer:

1. Open the front door, then press the main power switch to the On position.

2. Close the front door.

3. At the printer control panel, press the Power/Wake button.

Caution: To avoid damage to the printer, do not unplug the power cord while the printer
powers up.
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PPoowweerriinngg OOffff tthhee PPrriinntteerr
To power off the printer:

1. At the printer control panel, press the Power/Wake button, then touch Power Off.

2. Wait for the printer to complete the power-off procedure. When complete, the touch screen
appears blank.

Caution: To avoid damage to the printer, do not unplug the power cord while the printer
powers down.

3. Open the front door, then press the main power switch to the Off position.

4. Close the front door.
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Accessing the Printer

LLooggggiinngg IInn
Logging in is the process by which you identify yourself to the printer for authentication. If
authentication is set, to access printer features, you log in with your user credentials.

LLooggggiinngg IInn aatt tthhee CCoonnttrrooll PPaanneell
1. At the printer control panel, press the Home button.

2. Touch Log In.

3. Type the User Name using the keypad, then touch Enter.

4. If prompted, enter the password, then touch Enter.

Note: For more information on logging in as system administrator, refer to the System
Administrator Guide at www.xerox.com/support/VLC8000docs or www.xerox.com/support/
VLC9000docs.

5. Touch OK.

Note: To access each password-protected service, enter the User Name and password.

CCoonnvveenniieennccee AAuutthheennttiiccaattiioonn
When Convenience Authorization is enabled, users swipe a pre-programmed identification card
through a Proximity Card Reader at the control panel. To use this method, purchase and install a USB
card reader and an authentication server that supports the Xerox® Convenience Authentication API.
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Introduction to Apps
Xerox Apps are a gateway to the features and functions of your device. Standard Apps are already in-
stalled on the device and appear on the Home screen. Some Apps are installed as standard, but hid-
den the first time you use the device.

When you log in, the Apps configured for your personal account appear on the control panel.

You can download more Apps for your device from the Xerox® App Gallery. For more information, refer
to Xerox® App Gallery.

Xerox® VersaLink® C8000/C9000 Color Printer
User Guide

29

Getting Started



Information Pages
Your printer has a set of information pages that you can print. These pages include configuration and
font information, demonstration pages, and more.

The following Information Pages are available:

Name Description

Configuration Report The Configuration Report provides printer information including
installed options, network settings, port setup, tray information,
and more.

Billing Summary Report The Billing Summary Report provides information about the de-
vice and a detailed listing of the billing meters and sheet
counts.

Supplies Usage Report The Supplies Usage Report provides coverage information and
part numbers for reordering supplies.

PostScript Font List The PostScript Font List provides a printout of all PostScript
fonts that are available on the printer.

PCL Font List The PCL Font List provides a printout of all PCL fonts that are
available on the printer.

Demonstration Print Demonstration Print provides a demonstration of the current
print quality.

Startup Page The Startup Page provides basic printer configuration and net-
work information.

Job History Report The printer retains information on previous print jobs, including
the date, time, job type, document name, output color, paper
size, number of pages, and results. The status of a maximum of
200 jobs prints on the Job History Report.

PPrriinnttiinngg IInnffoorrmmaattiioonn PPaaggeess
1. At the printer control panel, press the Home button.

2. Touch Device→About→Information Pages.

3. To print an information page, touch the needed page.

4. To return to the Home screen, press the Home button.
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CCoonnffiigguurraattiioonn RReeppoorrtt
The Configuration Report provides product information including installed options, network settings,
port setup, tray information, and more.

PPrriinnttiinngg tthhee CCoonnffiigguurraattiioonn RReeppoorrtt
1. At the printer control panel, press the Home button.

2. Touch Device→About→Information Pages.

3. Touch Configuration Report.

4. To return to the Home screen, press the Home button.
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The Embedded Web Server
The Embedded Web Server is the administration and configuration software that is installed in the
printer. It allows you to configure and administer the printer from a Web browser.

The Embedded Web Server requires:

• A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux
environments.

• TCP/IP and HTTP enabled in the printer.

• A network-connected computer with a Web browser that supports JavaScript.

AAcccceessssiinngg tthhee EEmmbbeeddddeedd WWeebb SSeerrvveerr
At your computer, open a Web browser. In the address field, type the IP address of the printer, then
press Enter or Return.

FFiinnddiinngg tthhee IIPP AAddddrreessss ooff YYoouurr PPrriinntteerr
To install the print driver for a network-connected printer, it is often necessary to know the IP address
of your printer. Also, the IP address is used to access the settings of your printer through the
Embedded Web Server. You can view the IP address of your printer on the control panel or on the
Configuration Report.

Note: To view the TCP/IP address on the control panel, wait until the printer has been on for 2
minutes. If the TCP/IP address is 0.0.0.0, or begins with 169, it indicates a network connectivity
issue. However, if Wi-Fi is set as the primary Ethernet connection, 0.0.0.0 is displayed as the IP
address for the printer.

VViieewwiinngg tthhee IIPP PPrriinntteerr AAddddrreessss oonn tthhee CCoonnttrrooll PPaanneell
To view the IP address of the printer on the control panel:

1. At the printer control panel, press the Home button.

2. Touch Device→About.

3. Record the IP address from the display.

4. To return to the Home screen, press the Home button.

OObbttaaiinniinngg tthhee PPrriinntteerr IIPP AAddddrreessss ffrroomm tthhee CCoonnffiigguurraattiioonn RReeppoorrtt
To obtain the printer IP address from the Configuration Report:

1. At the printer control panel, press the Home button.

2. Touch Device→About→Information Pages.

3. Touch Configuration Report.

The IP address appears in the Connectivity section of the Configuration Report for IPv4 or IPv6.

4. To return to the Home screen, press the Home button.
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DDoowwnnllooaaddiinngg tthhee CCoonnffiigguurraattiioonn RReeppoorrtt ffrroomm tthhee
EEmmbbeeddddeedd WWeebb SSeerrvveerr
From the Embedded Web Server, you can download and save a copy of the Configuration Report to
your computer hard drive. Use Configuration Reports from multiple devices to compare software
versions, configurations, and compliance information.

To download a copy of the Configuration Report from the Embedded Web Server:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer,
then press Enter or Return.

Note: For details about obtaining the IP address of your printer, refer to Finding the IP
Address of Your Printer.

2. To download the Configuration Report scroll to the bottom of the page, then, in the Quick Links
section, click Download Configuration Report.

Note: If this feature does not appear, log in as a system administrator.

The document is saved automatically as an XML file in the default download location on your
computer hard drive. To open the Configuration Report, use an XML viewer.
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Installation and Setup
For reference:

• Installation Guide packaged with your printer.

• Online Support Assistant at www.xerox.com/support/VLC8000support or www.xerox.com/support/
VLC9000support.

IInnssttaallllaattiioonn aanndd SSeettuupp OOvveerrvviieeww
Before you print, ensure that your computer and the printer are plugged in, powered on, and
connected. Configure the initial settings of the printer, then install the print driver software and
utilities on your computer.

You can connect to your printer directly from your computer using USB, or connect to a network using
an Ethernet cable or wireless connection. Hardware and cabling requirements vary for the different
connection methods. Routers, network hubs and switches, modems, Ethernet cables, and USB cables
are not included with your printer and must be purchased separately. Xerox recommends an Ethernet
connection because it is typically faster than a USB connection, and it provides access to the
Embedded Web Server.

For more information, refer to the System Administrator Guide at www.xerox.com/support/
VLC8000docs or www.xerox.com/support/VLC9000docs.

SSeelleeccttiinngg aa LLooccaattiioonn ffoorr tthhee PPrriinntteerr

WARNING: To avoid personal injury and damage to the printer, professional installation of the
printer is required.

1. Select a dust-free area with temperatures from 10–32° C (50–90° F), and relative humidity 15–
85%.

Note: Sudden temperature fluctuations can affect print quality. Rapid heating of a cold
room can cause condensation inside the printer, directly interfering with image transfers.

2. Place the printer on a level, solid, non-vibrating surface with adequate strength to hold the weight
of the printer. The printer must be horizontal with all four feet in solid contact with the surface.
To find the weight for your printer configuration, refer to Weights and Dimensions.

3. Select a location with adequate clearance to access supplies and to provide proper ventilation.
To find the clearance requirements for your printer, refer to Total Space Requirements.

4. After positioning the printer, you are ready to connect it to the power source and computer or
network.

RReemmoovviinngg aanndd RReeppllaacciinngg tthhee RReeaarr AAcccceessss CCoovveerr
To install specific options, it is necessary to remove and replace the rear access cover.

1. To remove the cover, remove the two thumbscrews securing the cover. Lift the cover away from
the printer.
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2. To replace the cover, place the bottom hooks over the slots in the printer frame. Raise the cover
into place, then replace the two screws.
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Connecting the Printer

SSeelleeccttiinngg aa CCoonnnneeccttiioonn MMeetthhoodd
You can connect the printer to your computer using a USB cable, Ethernet cable, or wireless
connection. The method that you select depends on how your computer is connected to the network.
A USB connection is a direct connection and is the easiest to set up. An Ethernet connection is used
to connect to a network. If you are using a network connection, it is important to understand how
your computer is connected to the network.

Note: Hardware and cabling requirements vary for the different connection methods. Routers,
network hubs, network switches, modems, Ethernet cables, and USB cables are not included
with your printer and must be purchased separately.

USB
If you connect the printer to one computer and do not have a network, use a USB connection. A
USB connection offers fast data speeds, but typically not as fast as a network connection.

Note: To access the Embedded Web Server, a network connection is required.

Network
If your computer is connected to an office network or home network, use an Ethernet cable to
connect the printer to the network. You cannot connect the printer directly to the computer. A
connection through a router or network switch is required. An Ethernet network can be used for
one or more computers and supports many printers and systems simultaneously. An Ethernet
connection is typically faster than USB and allows you direct access to the settings of the printer
using the Embedded Web Server.

Wireless Network
If your environment includes a wireless router or wireless access point, you can connect the printer
to the network with a wireless connection. A wireless network connection provides the same access
and services as a wired connection. A wireless network connection is typically faster than USB and
allows direct access to the settings of the printer using the Embedded Web Server.

CCoonnnneeccttiinngg ttoo aa CCoommppuutteerr UUssiinngg aa UUSSBB CCaabbllee
To connect the printer to a computer using a USB cable, you need one of these operating systems:

• Windows 7, Windows 8, Windows 8.1, Windows Server2008 R2, Windows 10, WindowsServer2008
R2, Windows Server 2012, and Windows Server 2016.

• Macintosh OS X version 10.10 and later.

• UNIX and Linux: Your printer supports connection to various UNIX platforms through the network
interface.

To connect the printer to a computer using a USB cable:

1. Connect the B end of a standard A/B USB 2.0 or USB 3.0 cable to the USB Port on the back of the
printer.

2. Connect the A end of the USB cable to the USB port on the computer.
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3. If the Windows Found New Hardware Wizard appears, cancel it.

4. Install the print driver.

For more information, refer to Installing the Software.

CCoonnnneeccttiinngg ttoo aa WWiirreedd NNeettwwoorrkk
1. Ensure that the printer is powered off.

2. To remove the right rear cover, pull the cover away from the printer.

3. Attach a Category 5 or better Ethernet cable from the printer to the network or router socket. Use
an Ethernet switch or router, and two or more Ethernet cables. Connect the computer to the
switch or router with one cable, then connect the printer to the switch or router with the second
cable. Connect to any port on the switch or router except the uplink port.

4. To replace the cover, position the tabs on each side of the cable, then raise the cover until it clicks
into place.
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5. Power on the printer.

6. Set the network IP printer address, or set up the printer for automatic printer IP detection. For
more information, refer to the System Administrator Guide at www.xerox.com/support/
VLC8000docs or www.xerox.com/support/VLC9000docs.

CCoonnnneeccttiinngg ttoo aa WWiirreelleessss NNeettwwoorrkk
A wireless local area network (WLAN) provides the means to connect 2 or more devices in a LAN
without a physical connection. The printer can connect to a wireless LAN that includes a wireless
router or wireless access point. Before connecting the printer to a wireless network, the wireless router
must be configured with a service set identifier (SSID) and any necessary credentials.

Note: Wireless networking is available only on printers with the optional Wireless Network
Adapter installed.

IInnssttaalllliinngg tthhee WWiirreelleessss NNeettwwoorrkk AAddaapptteerr
The optional wireless network adapter plugs in to the back of the control board. After the adapter is
installed, and wireless networking is enabled and configured, the adapter is able to connect to a
wireless network.

To install the Wireless Network Adapter:

1. Power off the printer.

a. At the control panel, press the Power/Wake button, then touch Power Off.
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b. Open the front door, then press the main power switch to the Off position.

Caution: To avoid damage to the printer, do not unplug the power cord while the
printer powers down.

2. Remove the packaging from the Wireless Network Adapter.

3. To install the Wireless Network Adapter, follow the instructions provided with the Wireless
Network Adapter.

Caution: Pulling on the adapter can cause damage. After the adapter is installed, remove it
only as needed, and as directed in the Wireless Network Adapter removal instructions. For
details, refer to Removing the Wireless Network Adapter.

4. Configure the Wi-Fi settings. For details about configuring the Wi-Fi settings, refer to the System
Administrator Guide at www.xerox.com/support/VLC8000docs or www.xerox.com/support/
VLC9000docs.

RReemmoovviinngg tthhee WWiirreelleessss NNeettwwoorrkk AAddaapptteerr
To remove the Wireless Network Adapter:

1. Power off the printer:
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a. At the printer control panel, press the Power/Wake button, then touch Power Off.

b. Wait for the printer to complete a power-off procedure. When complete, the touch screen
appears blank.

c. Open the front door, then press the main power switch to the Off position.

Caution: To avoid damage to the printer, do not unplug the power cord while the
printer powers down.

2. To release the Wireless Network Adapter from the connection panel on the side of the printer,
gently grasp the adapter and push the release lever to the side. Carefully pull the adapter away
from the printer.

Caution: Do not use force to pull on the Wireless Network Adapter. If the latch is released
properly, the adapter pulls out easily. Pulling on the adapter can damage it.
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3. Connect the printer to your computer with a USB cable or to the network with an Ethernet cable.

4. Power on the printer:

a. Open the front door, then press the main power switch to the On position.

b. At the printer control panel, press the Power/Wake button.

Note: If the printer was installed previously in a wireless network environment, it could retain
setup and configuration information from that environment. To prevent the printer from
attempting to connect to the previous network, reset the wireless settings. For more
information, refer to the System Administrator Guide at www.xerox.com/support/VLC8000docs
or www.xerox.com/support/VLC9000docs.
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RReesseettttiinngg WWiirreelleessss SSeettttiinnggss
If the printer was previously installed in a wireless network environment, it could retain setup and
configuration information. To prevent the printer from attempting to connect to the previous
network, reset the wireless settings.

To reset the wireless settings:

1. At the printer control panel, press the Home button.

2. Touch Device→Connectivity→Wi-Fi.

3. Touch the network selection that you want to reset.

4. Touch Forget This Network.

5. At the prompt, touch Forget & Reboot.

CCoonnnneeccttiinngg ttoo aa NNeettwwoorrkk wwiitthh aa WWii--FFii PPrrootteecctteedd SSeettuupp
Wi-Fi Protected Setup (WPS) is a network standard for setting up a wireless network. The WPS proto-
cols enable you to set up devices in a secure wireless network without having wireless networking ex-
perience. With a WPS-certified router, you can use tools in the router and the printer to connect the
printer to the network. To use the tools, ensure that the wireless router is configured properly and is
compliant with the WPS.

• Push Button Connection (PBC) is the easiest way to connect the printer to a wireless network. It
automatically connects when you push a button on the router and on the printer. After the router
and printer exchange information, the printer accepts the security and configuration information
from the router and connects to the network. The PBC is a moderately secure way to connect the
printer to the network. You do not need to enter any information to make the network connection.

• PIN (Personal Identification Number) automatically connects the printer to a wireless router using
a common PIN. The printer generates and prints a PIN for use in the setup process. When you en-
ter the PIN into the router, the router broadcasts network information using the PIN. When both
devices recognize the PIN, the router provides the security and configuration information to the
printer, which uses it to connect to the network.

CCoonnnneeccttiinngg ttoo aa WWPPSS WWiirreelleessss NNeettwwoorrkk UUssiinngg tthhee PPIINN MMeetthhoodd
To connect to a Wi-Fi Protected Setup (WPS) wireless network using the PIN method:

Note: Before you install the printer, ensure that you connect and configure the wireless router
for the network.

1. At the printer control panel, press the Home button.

2. If Wi-Fi is Off, turn it on.

a. Touch Device→Connectivity→Wi-Fi.

b. To toggle Wi-Fi from Off to On, touch the Wi-Fi toggle button.

c. To activate your Wi-Fi setting changes, press the Home button.

d. At the prompt, touch Restart Now.

Note: The following steps can vary with different router manufacturers. For more
information, refer to your router documentation.
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3. At your computer, open the wireless router control panel, then select Add WPS Client.

4. Select PIN Method. The wireless router control panel opens to a dialog box ready for the PIN
number.

5. At the printer control panel, touch Device→Connectivity→Wi-Fi.

6. Touch Manual Setup.

7. Touch Wi-Fi Protected Setup (WPS).

Note: If Wi-Fi Protected Setup (WPS) is not visible, at the top of the screen, touch Manual
Setup.

8. Touch PIN.

9. Record the PIN from the screen, then touch OK.

The printer starts advertising using the displayed PIN Code.

Note: The printer continues to advertise for 120 seconds. If the printer does not locate the
wireless router within 120 seconds, the connection attempt stops.

10. At your computer, in the wireless router control panel Client PIN Code field, enter the PIN code,
then click Next.

The printer communicates with the wireless router to resolve setup and configuration
information. When the printer has the correct information, it connects to the router and restarts
with the proper setup and configuration information.

If the router does not connect with the printer within 120 seconds, the connection attempt stops.

11. After the printer restarts, wait 20 seconds, then to get the network information that includes the
IP address, print a Configuration Report. For more information, refer to Printing the Configuration
Report.

CCoonnnneeccttiinngg ttoo aa WWiirreelleessss NNeettwwoorrkk MMaannuuaallllyy
When connecting to a wireless network that does not include a WPS-compliant router, set up and
configure the printer manually. Before starting, obtain the router setup and configuration
information, such as name and passphrase. For assistance, contact your system administrator.

To connect to a wireless network manually:

1. At the printer control panel, press the Home button.

2. Touch Device→Connectivity→Wi-Fi.

3. If Wi-Fi is Off, turn it on.

a. To toggle Wi-Fi from Off to On, touch the Wi-Fi toggle button.

b. To activate your Wi-Fi setting changes, press the Home button.

c. At the prompt, touch Restart Now.

d. After the printer restarts, touch Device→Connectivity→Wi-Fi.

4. To connect to a network:
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• Touch the name of the network, enter the password for the selected network, then touch OK.
• If the desired network does not appear, touch Manual Setup, then configure the wireless

network settings.

• For Enter the Network Name (SSID), type the name (SSID) of your network, then press OK.

• Touch Security, then select the security method that your wireless network uses.

• Touch Enter Password, then enter the password for your wireless network.

• Touch OK.

5. To activate your Wi-Fi setting changes, press the Home button.

6. At the prompt, touch Restart Now.

7. After the printer restarts, wait two minutes, then to get the network information that includes the
IP address, print a Configuration Report. For more information, refer to Printing the Configuration
Report.

CCoonnnneeccttiinngg ttoo WWii--FFii DDiirreecctt
You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or smart-
phone, using Wi-Fi Direct. Wi-Fi Direct is disabled by default. For more information, refer to the System
Administrator Guide at www.xerox.com/support/VLC8000docs or www.xerox.com/support/
VLC9000docs.

Note: Wireless networking is available only on printers with the optional Wireless Network
Adapter installed.

Connecting with Wi-Fi Direct from Your Mobile Device

To connect with Wi-Fi Direct, follow the directions provided with your mobile device.

IInniittiiaall PPrriinntteerr SSeettuupp
Before installing the printer software, verify that the printer is set up correctly. Setup includes
enabling the optional features and assigning an IP address for the Ethernet network connection. The
installation wizard starts automatically the first time that the printer is powered on. The installation
wizard prompts the system administrator to configure the following settings:

• Language

• Network Connection

• Proxy Server Setup

• Date and Time

• Measurements

• LDAP Settings

• Apps Setup

• Security Settings

For more information on configuring the printer settings, refer to the System Administrator Guide at
www.xerox.com/support/VLC8000docs or www.xerox.com/support/VLC9000docs.
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CCoonnffiigguurriinngg AAiirrPPrriinntt
AirPrint® is a software feature that allows you to print from wired or wireless Apple iOS-based mobile
devices and Mac OS-based devices without the need to install a print driver. AirPrint-enabled printers
allow you to print directly from a Mac, an iPhone, iPad, or iPod touch. You can use AirPrint to print
from a wired device or a wireless device without using a print driver.

Note:

• Not all applications support AirPrint®.

• Wireless devices must join the same wireless network as the printer.

• For AirPrint to function, both IPP and Bonjour® (mDNS) protocols must be enabled.

• The device that submits the AirPrint job must be on the same subnet as the printer. To allow
devices to print from different subnets, configure your network to pass multicast DNS traffic
across subnets.

• The Mac OS device must be Mac OS 10.10 or later.

• AirPrint-enabled printers work with all models of iPad, iPhone (3GS or later), and iPod touch
(third generation or later), running the latest version of iOS.

1. At your computer, open a Web browser. In the address field, type the IP address of the printer,
then press Enter or Return.

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of
Your Printer.

2. In the Embedded Web Server, click Home→Connectivity.

Note: If this feature does not appear, log in as a system administrator.

3. For Mobile Printing, click AirPrint.

4. To enable AirPrint, click the Enable toggle button.

Note: AirPrint is enabled by default when IPP and Bonjour® (mDNS) are both enabled.
• To change the printer name, in the Name field, enter a new name.
• To enter a location for the printer, in the Location field, enter the location of the printer.
• To enter a physical location or address for the printer, in the Geo-Location field, enter the

geographic latitude and longitude coordinates in decimal form. For example, use coordinates
such as 45.325026, -122.766831 for a location.

5. Click OK.

6. To activate your changes, at the prompt, click Restart Now.

CCoonnffiigguurriinngg GGooooggllee CClloouudd PPrriinntt
Google Cloud Print allows you to print documents that are stored in the cloud without using a print
driver.

Before you begin:
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• Set up a Google email account.

• Configure the printer to use IPv4.

• Configure Proxy Server settings as needed.

To configure Google Cloud Print:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer,
then press Enter or Return.

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of
Your Printer.

2. In the Embedded Web Server, click Home→Connectivity.

3. For Mobile Printing, click Google Cloud Print.

4. To enable Google Cloud Print, click the Enable toggle button.

5. Click OK.

6. Restart the printer, then wait 2 minutes for the printer to connect.

7. Refresh your Web browser, then for Mobile Printing, click Google Cloud Print.

8. Click Printer Registration.

9. Click Register.

A printer registration page prints.

10. To register the printer, in your Web browser, type the URL provided, or use your mobile phone to
scan the barcode.

After the printer is registered, a confirmation status window appears.

11. To access the Google Cloud Print feature, in your Google account, click Manage Your Printer.

Note: The default printer name appears in this format: Model name (MAC address).
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Installing the Software
Before installing driver software, verify that the printer is plugged in, powered on, connected correctly,
and has a valid IP address. The IP address usually appears in the upper right corner of the control pan-
el. If you cannot find the IP address, see Finding the IP Address of Your Printer.

Note: If the Software and Documentation disc is not available, download the latest drivers from
www.xerox.com/support/VLC8000drivers or www.xerox.com/support/VLC9000drivers.

OOppeerraattiinngg SSyysstteemm RReeqquuiirreemmeennttss
• Windows 7, Windows 8, Windows 8.1, Windows Server2008 R2, Windows 10, WindowsServer2008

R2, Windows Server 2012, and Windows Server 2016.

• Macintosh OS X version 10.10 and later.

• UNIX and Linux: Your printer supports connection to various UNIX platforms through the network
interface.

IInnssttaalllliinngg tthhee PPrriinntt DDrriivveerrss ffoorr aa WWiinnddoowwss NNeettwwoorrkk
PPrriinntteerr
1. Insert the Software and Documentation disc into the appropriate drive on your computer. If the

installer does not start automatically, navigate to the drive, then double-click the Setup.exe
installer file.

2. Click Install Print Driver.

3. At the License Agreement, click I Agree.

4. From the list of discovered printers, select your printer.

Note: When you install print drivers for a network printer, if your printer does not appear in
the list, click IP Address or DNS Name . In the IP Address or DNS Name field, type the IP
address of your printer, then to locate and select your printer, click Search. If you do not
know the IP address of the printer, refer to Finding the IP Address of Your Printer.

5. Click Next.

6. If needed, type a name in the Queue Name field.

7. Select a Print Driver.

8. Click Install.

9. If needed, set the printer as the default printer.

Note: Before you select Share Printer, contact your system administrator.

10. To complete the installation, click Finish, then click Close.
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IInnssttaalllliinngg tthhee PPrriinntt DDrriivveerr bbyy SSppeecciiffyyiinngg tthhee IIPP
AAddddrreessss ffoorr WWiinnddoowwss 1100
To install the printer by specifying the IP address:

1. At your computer, open the Settings folder, then click Add Printer.

2. Click The printer that I want isn't listed, then click Add a local printer or network printer with
manual settings.

3. To use a previously established port, select Use an existing port, then from the list, select a
Standard TCP/IP Port.

4. To create a Standard TCP/IP port:

a. Select Create a New Port.

b. For Type of port, select Standard TCP/IP Port, then click Next.

c. In the Hostname or IP address field, type the printer IP address or host name.

d. To disable the feature, clear the check box for Query the printer and automatically select
the driver to use, then click Next.

5. Click Have Disk.

6. Click Browse. Browse to, then select the driver.inf file for your printer. Click Open.

Note: The Xerox print driver installation wizard places files at C:\Xerox.

7. Select your printer model, then click Next.

8. If a prompt appears because the print driver was installed previously, click Use the driver that is
currently installed (recommended).

9. In the Printer name field, type a name for your printer.

10. To install the print driver, click Next.

11. If needed, set the printer as the default printer.

Note: Before selecting Share Printer, contact your system administrator.

12. To send a test page to the printer, click Print a test page.

13. Click Finish.

IInnssttaalllliinngg tthhee PPrriinntt DDrriivveerrss ffoorr aa WWiinnddoowwss UUSSBB PPrriinntteerr
1. Connect the B end of a standard A/B USB 2.0 or USB 3.0 cable to the USB Port on the back of the

printer.

2. Connect the A end of the USB cable to the USB port on the computer.

3. If the Windows Found New Hardware Wizard appears, cancel it.

4. Insert the Software and Documentation disc into the appropriate drive on your computer. If the
installer does not start automatically, navigate to the drive, then double-click the Setup.exe
installer file.

5. Click Install Print Driver.

6. At the License Agreement, select I Agree.
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7. From the list of discovered printers, select your printer, then click Next.

8. If needed, type a name in the Queue Name field.

9. Select the Print Driver check box for either Postscript (recommended), PCL 6, or both as needed.

10. Click Install.

11. If needed, set the printer as the default printer.

Note: Before you select Share Printer, contact your system administrator.

12. To complete the installation, click Finish.

IInnssttaalllliinngg tthhee PPrriinntteerr aass aa WWeebb SSeerrvviiccee oonn DDeevviicceess
Web Services on Devices (WSD) allows a client to discover and access a remote device and its
associated services across a network. WSD supports device discovery, control, and use.

IInnssttaalllliinngg aa WWSSDD PPrriinntteerr UUssiinngg tthhee AAdddd DDeevviiccee WWiizzaarrdd
1. At your computer, click Start, then select Devices and Printers.

2. To launch the Add Device Wizard, click Add a Device.

3. In the list of available devices, select the device that you want to use, then click Next.

Note: If the printer that you want to use does not appear in the list, click the Cancel
button. To add the printer manually, use the IP address of the printer. For details, refer to
Installing the Print Driver by Specifying the IP Address for Windows 10.

4. Click Close.

IInnssttaalllliinngg tthhee DDrriivveerrss aanndd UUttiilliittiieess ffoorr MMaacciinnttoosshh OOSS XX
1. Download the latest print driver from www.xerox.com/support/VLC8000support or www.xerox.

com/support/VLC9000support.

2. Open Xerox® Print Drivers 4.xx.x.dmg/.pkg as needed for your printer.

3. To run Xerox® Print Drivers 4.xx.x.dmg/.pkg, double-click the appropriate file name.

4. When prompted, click Continue.

5. To accept the license agreement, click I Agree.

6. To accept the current installation location, click Install, or select another location for the
installation files, then click Install.

7. If prompted, enter your password, then click OK.

8. From the list of discovered printers, select your printer, then click Next.

9. If your printer does not appear in the list of discovered printers:

a. Click the Network Printer Icon.

b. Type the IP address of your printer, then click Continue.

c. Select your printer in the list of discovered printers, then click Continue.

Xerox® VersaLink® C8000/C9000 Color Printer
User Guide

49

Getting Started

http://www.support.xerox.com/support/versalink-c8000/support
http://www.support.xerox.com/support/versalink-c9000/support
http://www.support.xerox.com/support/versalink-c9000/support


10. If your printer was not detected, verify that the printer is powered on and that the Ethernet or
USB cable is connected properly.

11. To accept the print queue message, click OK.

12. Select or clear the Set Printer as Default and Print a Test Page check boxes.

13. Click Continue, then click Close.

AAddddiinngg tthhee PPrriinntteerr ffoorr MMaacciinnttoosshh OOSS XX
For networking, set up your printer using Bonjour® (mDNS), or connect using the IP address of your
printer for an LPD/LPR connection. For a non-network printer, create a desktop USB connection.

For more information, go to the Online Support Assistant at: www.xerox.com/support/
VLC8000support or www.xerox.com/support/VLC9000support.

Adding the Printer Using Bonjour
To add the printer using Bonjour®:

1. From the computer Applications folder or from the dock, open System Preferences.

2. Click Printers & Scanners.

The list of printers appears on the left of the window.

3. For the list of printers, click the Plus icon (+).

4. At the top of the window, click the Default icon.

5. Select your printer from the list, then click Add.

Note: If your printer is not detected, verify that the printer is powered on and that the
Ethernet cable is connected properly.

Adding the Printer by Specifying the IP Address
To add the printer by specifying the IP address:

1. From the computer Applications folder or from the dock, open System Preferences.

2. Click Printers & Scanners.

The list of printers appears on the left of the window.

3. Under the list of printers, click the Plus icon (+).

4. Click IP.

5. From the Protocol list, select the protocol.

6. In the Address field, enter the IP address of the printer.

7. In the Name field, enter a name for the printer.

8. From the Use list, choose Select a driver to use.

9. From the printer software list, select the print driver for your printer model.

10. Click Add.
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IInnssttaalllliinngg DDrriivveerrss aanndd UUttiilliittiieess ffoorr UUNNIIXX aanndd LLiinnuuxx
For more information on installing print drivers and utilities for UNIX and Linux, refer to UNIX and
Linux Printing.
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More Information
You can obtain more information about your printer from these sources:

Resource Location

Installation Guide Packaged with the printer.

Other documentation for your printer • www.xerox.com/support/VLC8000docs
• www.xerox.com/support/VLC9000docs

Recommended Media List • United States: www.xerox.com/rmlna
• European Union: www.xerox.com/rmleu

Technical support information for your printer, includ-
ing online technical support, Online Support Assis-
tant, and print driver downloads.

• www.xerox.com/support/VLC8000support
• www.xerox.com/support/VLC9000support

Information Pages Print from the control panel. For details, refer to:
Printing Information Pages

Order supplies for your printer www.xerox.com/supplies

Local sales and Technical Customer Support www.xerox.com/worldcontacts

Printer registration www.xerox.com/register

Xerox® Direct online store www.direct.xerox.com/
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Customize and Personalize
This chapter contains:

• Customize and Personalize Overview ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

• Customizing or Personalizing the Home Screen... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

• Customizing or Personalizing the Apps ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56



Customize and Personalize Overview
This chapter provides information on how to customize and personalize your device to meet the
specific demands of your workflows.

You can customize your apps, hide or show apps on the Home screen, and
rearrange the app order to suit your job priorities. For certain apps, you
can hide or show individual features and configure default settings to
meet the needs of your workgroup. You can save job settings for repeated
use.
Customization enables users to work more productively.

When individual user accounts are configured on the device, you can
personalize the device to meet specific user needs. You can configure your
personal Home page to hide or show only the apps that you use. You can
tailor an app feature list to your job requirements and specify default
settings. You can save settings for regular jobs.
Personalization options ensure that the features and functions displayed
on the control panel meet individual user needs, improving efficiency.

Note: The customize and personalize settings are configured by a system administrator. For
details, contact your system administrator, or refer to the System Administrator Guide at www.
xerox.com/support/VLC8000docs.
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Customizing or Personalizing the Home Screen

HHiiddiinngg oorr SShhoowwiinngg aann AApppp oonn tthhee HHoommee SSccrreeeenn
1. At the printer control panel, press the Home button.

2. Touch Customize. The Customize Home window appears.

3. To display an installed app that is hidden initially:

a. Touch Add. A list of available apps appears.

b. Touch the app that you want to appear on the control panel.

c. Touch Done.

Note: If all apps are already displayed, the Add feature is disabled.

4. To hide an installed app:

a. For the app, touch X.

b. Touch Done.

5. Verify that only the selected apps appear on the Home screen.

RReeaarrrraannggiinngg AAppppss oonn tthhee HHoommee SSccrreeeenn
1. At the printer control panel, press the Home button.

2. Touch Customize.

Note: For logged-in administrators, a window appears that asks you to confirm if the
changes are for a Guest or for you.

3. Touch and hold the required app.

4. Drag the app to the new location.

5. Release the app.

6. Touch Done.

7. Verify that the app appears in the correct location on the Home screen.
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Customizing or Personalizing the Apps
Customization enables you to modify the features available, delete a saved preset, or remove custom-
ized settings applied to an app.

CCuussttoommiizziinngg oorr PPeerrssoonnaalliizziinngg tthhee FFeeaattuurree LLiisstt
To customize the Feature List for an app:

1. At the printer control panel, press the Home button.

2. Touch the app required.

3. Scroll to the bottom, then touch Customize.

Note: To customize the Print from USB App, insert the USB Flash drive into the USB
memory port. If the Browse USB window appears, to close it, touch X.

4. Touch Feature List.

Note: For logged-in administrators, a window appears that asks you to confirm if the
changes are for a Guest or for you.

5. Touch the particular option.
• To hide a feature, for the required feature, touch the Eye icon. To signify that the feature is

hidden, the Eye icon appears with a line across it.
• To show a feature, for the required feature, touch the Eye icon. To signify a feature is visible,

the Eye icon appears with no line across it.

6. To reorder the app features, touch and drag the features into the required order.

7. To save the current configuration, touch Done.

SSaavviinngg PPrreesseettss
You can use this feature to save a particular combination of app settings for future jobs. You can save
the settings with a name and retrieve them for later use.

To save the current app settings:

1. At the printer control panel, press the Home button.

2. Touch the app required.

3. Select the job settings.

4. Scroll to the bottom, then touch Save.

5. Touch Save as New Preset.

6. Touch Enter Preset Name, then to enter a preset name, use the keypad.

7. Touch Next.

8. Select an icon that best suits the preset that you are creating.

9. Touch Done.

Note: The preset is stored within the Preset feature.
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DDeelleettiinngg aa SSaavveedd PPrreesseett
To delete a saved preset:

1. At the printer control panel, press the Home button.

2. Touch the app required.

3. Scroll to the bottom, then touch Customize.

4. Touch Presets.

5. Touch the Trash icon that corresponds with the preset that you want to delete.

6. At the prompt, touch Delete.

7. Touch Done.

RReemmoovviinngg AApppp CCuussttoommiizzaattiioonn uussiinngg tthhee CCoonnttrrooll PPaanneell
To remove the current app customization settings:

1. At the printer control panel, press the Home button.

2. Touch the app required.

3. Scroll to the bottom, then touch Customize.

4. Touch Remove App Customization.

5. At the prompt, touch OK.

CCuussttoommiizziinngg AApppp DDeeffaauulltt SSeettttiinnggss
To customize the default settings for an app:

1. At the control panel, press the Home button.

2. Touch the app required.

3. Configure the required default settings.

4. Touch Save.

5. Touch Save Defaults. The new settings override the previous default settings.
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4
Xerox® Apps
This chapter contains:

• Xerox® App Gallery .. .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

• Device... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63

• Jobs ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66

• Print from USB .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

• @PrintByXerox .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73

Xerox® Apps are a gateway to the features and functions of your device. There are standard apps
already installed and displayed on the Homescreen. There are also apps that are installed as standard
but are hidden when your device is used for the first time.

For more information about customizing the Home screen and the apps features, refer to Customize
and Personalize.

A range of apps is available for download and installation from the Xerox® App Gallery. These include
Xerox® Extensible Interface Platform (EIP) Apps. EIP Apps enable you to install secure, signed apps on
compatible printers.



Xerox® App Gallery

XXeerrooxx®® AApppp GGaalllleerryy OOvveerrvviieeww

Use the Xerox® App Gallery to find apps that provide new features or
capabilities for your device. The Xerox® App Gallery provides direct access to
apps that can improve your productivity, simplify workflows, and enhance your
user experience.

The Xerox® App Gallery enables you to browse and update apps easily. You can browse through the
app library without logging in. The moving banner provides an active display of apps, or you can
scroll the full list of apps. To get more details on an app, touch the app name in the list.

To use the Xerox® App Gallery App, ensure that your device uses either the wireless or the wired
network connection.

Note: If a local server inside a firewall hosts your device and a proxy is enabled, set a proxy
exception at the device.

For more information and instructions on using the Xerox® App Gallery, refer to the Xerox® App
Gallery User Guide available at www.xerox.com/support/xerox-app-gallery.

CCrreeaattiinngg aa XXeerrooxx®® AApppp GGaalllleerryy AAccccoouunntt
With an App Gallery account, you have direct access to all the available apps for your device. An App
Gallery account allows you to view and acquire apps, install apps on your device, and manage your
apps and licenses.

Note: If you have an existing Xerox® App Gallery Account, refer to Logging into your Xerox®

App Gallery Account.

To create an App Gallery account using the control panel:

1. At the printer control panel, press the Home button.

2. Touch Xerox App Gallery.

3. Do one of the following:
• On the blue scrolling panel, touch Create an App Gallery Account Now.
• To log in, touch the Person icon. Touch the top of the Log In page, then touch Request an

Account.

Note: The keypad covers the Request an Account link. To reveal the Request an Account
link, touch the top of the Log In page, or minimize the keypad.

4. Enter a valid email address using the touch screen keypad, then touch Enter.

A message appears stating that completion instructions have been sent to the email address that
you entered. Touch Close.

5. Access the email account for the email address that you provided to the Xerox® App Gallery.

6. Open the account request email, then click the URL link provided to access the create account
page. Click Agree.

7. Review and accept the Terms of Use. To continue creating an account, click Agree.
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8. Enter the information required into the appropriate fields:
• User ID
• Password
• Confirm Password
• First and Last Name
• Company Name
• Country

9. Click OK.

After the account is created, a confirmation message appears.

10. At the printer control panel, log in to your App Gallery Account.

LLooggggiinngg iinnttoo yyoouurr XXeerrooxx®® AApppp GGaalllleerryy AAccccoouunntt
When you are logged in to the App Gallery, you can browse available apps, and install and update
apps.

To log in to your App Gallery Account:

1. At the printer control panel, press the Home button.

2. Touch Xerox® App Gallery.

3. To log in, touch the Person icon.

4. Enter your User Name using the touch screen keypad, then touch Enter.

5. Enter your Password using the touch screen keypad, then touch Enter or OK.

The Xerox® App Gallery opens.

IInnssttaalllliinngg oorr UUppddaattiinngg aann AApppp ffrroomm tthhee XXeerrooxx®® AApppp
GGaalllleerryy
Xerox® Apps add, extend, or customize the functionality of your device. You can use the Xerox® App
Gallery to browse and install apps at your device control panel.

IInnssttaalllliinngg aann AApppp ffrroomm tthhee AApppp GGaalllleerryy
To install an app from the App Gallery:

1. At the printer control panel, press the Home button.

2. Touch Xerox App Gallery. The App Gallery opens.

Note: You can browse the App Gallery and view app descriptions without being logged in.
To install apps, you must be logged in to the App Gallery.

3. Touch the Person icon.

a. Enter your User Name using the touch screen keypad, then touch Enter.

b. Enter your Password using the touch screen keypad, then touch Enter or OK.

4. Touch the desired app, then touch Install. The License Agreement appears.
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5. Touch Agree. The installation process begins.

Note: If the app does not install successfully, to attempt the installation process again,
touch Install.

6. When the installation completes, touch X.

The app appears in the list of installed apps.

UUppddaattiinngg aann AApppp ffrroomm tthhee AApppp GGaalllleerryy
To update an app from the Xerox® App Gallery:

1. At the printer control panel, press the Home button.

2. Touch Xerox App Gallery. The App Gallery opens.

Note: You can browse the App Gallery and view app descriptions without being logged in.
To update apps, you must be logged in to the App Gallery.

3. Touch the Person icon.

a. Enter your User Name using the touch screen keypad, then touch Enter.

b. Enter your Password using the touch screen keypad, then touch Enter or OK.

4. Touch Installed. The list shows all installed apps, and any apps eligible for update. You can
update apps individually or all apps at once. Touch the desired app, then touch Update or
Update All. The License Agreement appears for each app.

Note: If no updates are available, the Update feature does not appear.

5. To accept the license agreements, touch Agree for each app.

6. When the update completes, touch X.

LLooggggiinngg oouutt ooff yyoouurr AApppp GGaalllleerryy AAccccoouunntt
To log out of your Xerox® App Gallery account:

1. Touch the Person icon.

2. Touch Logout.

62 Xerox® VersaLink® C8000/C9000 Color Printer
User Guide

Xerox® Apps



Device
DDeevviiccee OOvveerrvviieeww

The Device App gives you access to information about your printer, including
the serial number and model. You can view the status of the paper trays,
billing and supplies information, and print Information Pages.

You can configure many Device options to meet your individual needs. For details about configuring
all Device settings, refer to the System Administrator Guide at www.xerox.com/support/
VLC8000support.

DDeevviiccee OOppttiioonnss
The following Device options are available:

Option Description

Language Language allows you to set the language that appears on the control
panel.

About The About option provides an overview of your device and its current set-
tings and status. You can access Printing Information Pages and reports
using this option.

Software Update Use this option to check for software updates and configure update
settings.

Notifications Use the Notifications option to see details of current alerts or faults on
the device. A History button displays fault codes and the date that the
fault occurred on the device.

Paper Trays Use the Paper Trays option to see the paper size, type, and color set for
each paper tray and the tray-capacity status.

Supplies Use the Supplies option to monitor the status of the components you can
replace. The supply level and estimated number of impressions or days
left for each unit is displayed.

Billing/Usage Use the Billing/Usage option to view the serial number and the total num-
ber of impressions made by your device.

General Use the General option to customize settings such as the power-saver
modes, date and time, and control panel brightness. You can configure
the General settings using the device control panel, or by using the Em-
bedded Web Server.
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Option Description

Connectivity Use the Connectivity option to configure network settings at the control
panel, or join another wireless network.

Support Use this option to access and print the Support Pages to assist with trou-
bleshooting errors.

Resets Use the Resets option to reset device settings and font, forms, and macros
to the factory-default settings.

Note: To configure Device settings using the Embedded Web Server, refer to the System Admin-
istrator Guide at www.xerox.com/support/VLC8000docs.

SSuuppppllyy SSttaattuuss
You can check the status and percentage of life remaining for your printer supplies at the control
panel or from the Embedded Web Server. When printer supplies near their replacement time, warning
alerts appear on the control panel. You can customize the alerts that appear on the control panel and
configure email alert notifications.

To check the supplies status and set up alerts using the Embedded Web Server, refer to the System
Administrator Guide at www.xerox.com/support/VLC8000docs.

CChheecckkiinngg tthhee SSuupppplliieess SSttaattuuss aatt tthhee CCoonnttrrooll PPaanneell
1. To view status information for the printer supplies, touch Device→Supplies.

2. To view details about a specific item, including part numbers for reordering, touch the specific
item.

3. To return to the Supplies screen, touch X.

4. To return to the Device screen, touch the back arrow.

CCuussttoommiizziinngg SSuupppplliieess AAlleerrtt SSeettttiinnggss
To customize supplies alert settings, log in as an administrator. For details, refer to the System
Administrator Guide at www.xerox.com/support/VLC8000docs.

1. To customize the alerts that appear for printer supplies, touch Device→Supplies→Alerts Setup.

2. To enable supplies alerts that appear on the control panel, touch the Enable Alerts toggle button.

3. To customize the alerts for each supply item, or to enable or disable an alert, touch the toggle
button.

4. To configure the printer to display an alert when an item reaches a specific usage percentage
level, touch the item, then select the percentage.

5. To accept the changes, touch OK.

64 Xerox® VersaLink® C8000/C9000 Color Printer
User Guide

Xerox® Apps

http://www.support.xerox.com/support/versalink-c8000/documentation
http://www.support.xerox.com/support/versalink-c8000/documentation
http://www.support.xerox.com/support/versalink-c8000/documentation


6. To return to the Supplies screen, touch X.

7. To return to the Device screen, touch the back arrow.

SSeettttiinngg UUpp EEmmaaiill AAlleerrttss
To set up alerts, log in as an administrator. For details, refer to the System Administrator Guide at
www.xerox.com/support/VLC8000docs.

1. To set up alerts to send to an email address, touch Device→Supplies→Email Alerts.

2. To enter an email address, touch Add Email, then touch Enter Email Address.

3. Use the touch screen keyboard to enter an email address, or select an entry from the Address
Book, then touch OK.

4. Add more email addresses if necessary.

5. To customize the alerts for each supply item, or to enable or disable an alert, touch the toggle
button.

6. To return to the Supplies screen, touch X.

7. To return to the Device screen, touch the back arrow.

BBiilllliinngg aanndd UUssaaggee CCoouunntteerrss
The Billing/Usage menu displays the total number of impressions that the printer generated or
printed during its lifetime. You cannot reset the counters. A page is counted as one side of a sheet of
paper. For example, a sheet of paper that is printed on two sides counts as two impressions.

To view the Billing and Usage Counters:

1. At the printer control panel, press the Home button.

2. Touch Device→Billing/Usage.

3. To view more details, touch Usage Counters, then select an option.
• Impression Counters: This option provides the number of impressions made by the printer.

The number of impressions cannot equal the number of sheets counted, depending on the
printer setup. If your printer counts large sheets as large impressions or as multiple smaller
impressions, the number of impressions can differ.

• Sheet Counters: This option provides the number of impressions made by the printer.
Impressions for 2-sided sheets are listed on a separate line from 1-sided sheets.

• All Usage Counters: This option provides all printer usage information.

4. To return to the Billing/Usage screen, touch the back arrow.

5. To return to the Device screen, touch the back arrow.

RReemmoottee SSeerrvviicceess
You can use the Remote Services option in the Embedded Web Server to send error and usage
information to the Xerox support team to help them resolve problems quickly.

For information about enabling Remote Services and uploading information to Xerox, refer to the
System Administrator Guide at www.xerox.com/support/VLC8000docs.
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Jobs
JJoobbss OOvveerrvviieeww

Use Jobs to view current jobs, print saved, personal, and secure jobs, and view
details of completed jobs. You can pause, delete, print, or view job progress or
job details for a selected job.

MMaannaaggiinngg JJoobbss
From the Jobs App, you can view lists of active jobs, secure jobs, or completed jobs. You can pause,
delete, print, or view job progress or job details for a selected job.

From the Jobs window in the Embedded Web Server, you can view a list of active and completed print
jobs. For more information, refer to Managing Jobs Using the Embedded Web Server.

A print job can be held by the printer when it is unable to complete. For example, when the printer
needs attention, paper, or supplies. When the condition is resolved, the printer automatically resumes
printing. When you send a Secure Print job, the job is held until you type a passcode at the control
panel. For more information, refer to Managing Special Job Types.

PPaauussiinngg tthhee PPrriinntt JJoobb wwiitthh tthhee OOppttiioonn ttoo DDeelleettee IItt
1. At the printer control panel, press the Home button.

2. Touch Jobs, then touch the name of the print job.

3. Do one of the following:
• To pause the print job, touch Pause. To resume the print job, touch Resume.
• To delete the print job, touch Delete. At the prompt, touch Delete.

Note: If you do not make a selection within 60 seconds, the job resumes automatically.

4. To return to the Home screen, press the Home button.

VViieewwiinngg,, PPrriinnttiinngg,, oorr DDeelleettiinngg SSaavveedd aanndd SSeeccuurree JJoobbss
Note:

• The system administrator can restrict users from deleting jobs. If a system administrator
has restricted job deletion, you can view the jobs, but not delete them.

• Only the user that sent the job or the system administrator can delete a Secure Print job.

1. At the printer control panel, press the Home button.

2. To view a list of active and completed jobs, touch Jobs.

3. To view a list of specific job types, touch an option.
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• To view Saved Jobs, touch Saved Jobs. To print the job, touch the job, enter the quantity, then
touch OK. To delete the job, touch the Trash icon, then touch Delete.

• To view Personal jobs, touch Personal & Secure Jobs. To print the jobs, touch the folder, then
touch Print All, or Delete All.

• For Secure Jobs, touch Personal & Secure Jobs. Touch the folder, enter the passcode number,
then touch OK. To print a Secure Job, touch the job. To print or delete all the jobs in the folder,
touch Print All, or Delete All.

4. To view details about a job, touch the job.

5. To return to the Home screen, press the Home button.

PPrriinnttiinngg aa JJoobb HHeelldd ffoorr RReessoouurrcceess
1. At the printer control panel, press the Home button.

2. Touch Jobs.

3. From the jobs list, touch the held job name. The resources required for the job appear on the
control panel.

4. Do one of the following:
• To print the job, replenish the resources required. The job resumes automatically when the

required resources are available. If the job does not print automatically, touch Resume.
• To delete the print job, touch Delete. At the prompt, touch Delete.

5. To return to the Home screen, press the Home button.

MMaannaaggiinngg SSppeecciiaall JJoobb TTyyppeess
Special job types allow you to send a print job from your computer, then print it from the printer
control panel. Select special job types in the print driver, Printing Options tab, under Job Type.

SSaavveedd JJoobbss
Saved Jobs are documents sent to the printer and, unless deleted, are stored there for future use. Any
user can print or delete a Saved Job.

To print a Saved Job, refer to Printing a Saved Job.

Releasing a Saved Job
1. At the printer control panel, press the Home button.

2. Touch Jobs.

3. To view Saved Jobs, touch Saved Jobs.

4. To print a Saved Job, touch the job name, enter the quantity, then touch OK.

5. To delete the document after printing, for that job, touch the Trash icon, then at the prompt,
touch Delete.

6. To return to the Home screen, press the Home button.
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SSeeccuurree PPrriinntt
Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the
printer until you enter your passcode at the printer control panel.

To print a Secure Print job, refer to Printing a Secure Print Job.

Releasing a Secure Print job
1. At the printer control panel, press the Home button.

2. Touch Jobs.

3. To view Secure Print jobs, touch Personal & Secure Jobs.

4. Touch your folder.

5. Enter the passcode number, then touch OK.

6. Select an option:
• To print a Secure Print job, touch the job.
• To print all the jobs in the folder, touch Print All.
• To delete a Secure Print job, touch the Trash icon. At the prompt, touch Delete.
• To delete all the jobs in the folder, touch Delete All.

Note: After a Secure Print job is printed, it is deleted automatically.

7. To return to the Home screen, press the Home button.

PPeerrssoonnaall PPrriinntt
Personal Print allows you to store a document in the printer, then print it from the control panel.

Personal Print is a type of saved job with these features:

• A Personal Print job appears in a folder named after the user ID associated with the print job.

• A Personal Print job does not use a passcode.

• Any user can print or delete a Personal Print job.

• You can print all jobs in the list at once, delete an individual job, or delete all jobs in the list.

• After a Personal Print job is printed, it is deleted automatically.

To print using Personal Print, refer to Printing a Personal Print Job.

Releasing a Personal Print Job
1. At the printer control panel, press the Home button.

2. Touch Jobs.

3. To view Personal Print jobs, touch Personal & Secure Jobs.

4. Touch your folder.

5. If prompted for a passcode, touch Skip.

Note: When your folder contains Secure Print jobs and Personal Print jobs, the passcode
prompt appears.

6. Select an option.
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• To print a Personal Print job, touch the job.
• To print all the jobs in the folder, touch Print All.
• To delete all the jobs in the folder, touch Delete All.

7. To return to the Home screen, press the Home button.

SSaammppllee SSeett
The Sample Set job type prints one copy of a multiple-copy print job before printing the remaining
copies. After reviewing the sample set, you can either print the remaining copies or delete them at
the printer control panel.

Sample Set is a type of saved job with these features:

• A Sample Set job appears in a folder named after the user ID associated with the print job.

• A Sample Set job does not use a passcode.

• Any user can print or delete a Sample Set job.

• A Sample Set prints one copy of a job to allow you to proofread the job before printing any re-
maining copies.

After a Sample Set job is printed, it is deleted automatically.

To print a Sample Set, refer to Printing a Sample Set.

Releasing a Sample Set
1. At the printer control panel, press the Home button.

2. To view available jobs, touch Jobs.

3. Touch the Sample Set job.

Note: The Sample Set file description shows the job as Held for Future Printing, and shows
the number of remaining copies of the job.

4. Select an option.
• To print the remaining copies of the job, touch Release.
• To delete the remaining copies of the job, touch Delete.

5. To return to the Home screen, press the Home button.

MMaannaaggiinngg JJoobbss UUssiinngg tthhee EEmmbbeeddddeedd WWeebb SSeerrvveerr
You can view a list of active jobs and delete print jobs from the Active Jobs list in the Embedded Web
Server. You can use the Embedded Web Server to submit jobs for printing at the device. You can print .
pdf, .ps, .pcl, .prn, .xps, .jpg, .tif and .txt files directly from the Embedded Web Server. You do not
have to open another application or the print driver to print these files. You can store files on a local
computer hard drive, mass storage device, or network drive.

1. At your computer, open a Web browser. In the address field, type the IP address of the printer,
then press Enter or Return.

2. In the Embedded Web Server, click Jobs.

3. Click the job name.

4. Do one of the following:
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• To delete the print job, click Delete. At the confirmation prompt, click Delete.
• To close the window, click Close.

5. To return to the Home screen, click Home.

SSuubbmmiittttiinngg JJoobbss ffoorr PPrriinnttiinngg UUssiinngg tthhee EEmmbbeeddddeedd WWeebb SSeerrvveerr
1. At your computer, open a Web browser. In the address field, type the IP address of the printer,

then press Enter or Return.

2. In the Embedded Web Server, click Home.

3. In the Quick Links area, click Submit File.

4. Click Select.

5. In the selection window, select a file to print, then click Open.

6. To print the document, click Submit.
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Print from USB
PPrriinntt ffrroomm UUSSBB OOvveerrvviieeww

Use Print from USB to print jobs already stored on a USB drive. You can print
jobs in a print-ready format, such as .pdf, .tif, or .jpg.

To create a print-ready file, when you print your documents from programs such as Microsoft Word,
select Print to File. From advanced publishing programs, there can be several methods to create print-
ready files.

PPrriinnttiinngg ffrroomm aa UUSSBB FFllaasshh DDrriivvee
You can print a file stored on a USB Flash drive. The USB port is on the front of the printer.

Note:

• If the device is in Power Saver mode, before proceeding with the Print job, to wake the
device, press the Power/Wake button.

• Only USB Flash drives formatted to the typical FAT32 file system are supported.

1. Insert the USB Flash drive into the USB memory port on the printer.

2. At the USB Drive has been detected screen, touch Print from USB.

Note: If this feature does not appear, enable the feature or contact the system
administrator. For more information, see the System Administrator Guide at www.xerox.
com/support/VLC8000docs.

3. Add files using the Browse USB screen.
• To print a group of print-ready files, for the USB drive or folder, touch the Select All icon.

Verify that your files are selected.
• To print a specific file, browse to that file, then touch the file name or icon.

4. Touch OK.

5. Confirm that the required files are listed.
• To select more files, touch Add Documents, then touch OK.
• To remove a file name from the list, touch the file name, then touch Remove.

6. Select the paper supply, quantity, output color, and 2-sided printing options.

7. Touch Print.

8. When you are finished, remove the USB Flash drive.
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PPrriinnttiinngg ffrroomm aa UUSSBB FFllaasshh DDrriivvee AAllrreeaaddyy IInnsseerrtteedd iinn
tthhee PPrriinntteerr
1. If the USB Flash drive is already in the USB memory port, press the Home button.

2. Touch Print from USB.

Note: If this feature does not appear, enable the feature or contact the system
administrator. For more information, see the System Administrator Guide at www.xerox.
com/support/VLC8000docs.

3. Add files using the Browse USB screen.
• To print a group of print-ready files, for the USB drive or folder, touch the Select All icon.

Verify that your files are selected.
• To print a specific file, browse to that file, then touch the file name or icon.

4. Touch OK.

5. Confirm that the desired documents appear. If the documents do not appear, touch Add
Documents, select additional documents, then touch OK.

6. Select the paper supply, quantity, output color, and 2-sided printing options.

7. Touch Print.
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@PrintByXerox

@@PPrriinnttBByyXXeerrooxx OOvveerrvviieeww

You can use the Xerox® @PrintByXerox App to print email attachments and 
documents sent to your devices.
When your Xerox device is connected to the Internet, the @PrintByXerox App 
works with the Xerox® simple email-based printing.

Note: The @PrintByXerox App and Xerox® Workplace Cloud require specific licenses,
configuration settings, and minimum system specifications. For details, refer to the Xerox®
@PrintByXerox App Quick Start Guide available at www.xerox.com/support/xerox-app-gallery.

PPrriinnttiinngg wwiitthh tthhee @@PPrriinnttBByyXXeerrooxx AApppp
1. Send an email with an attachment containing a supported file type to Print@printbyxerox.com.

First-time users receive a response email with a user ID and password.

2. At the Xerox device control panel, press the Home button.

3. Touch @PrintByXerox.

A Loading Details message appears.

4. Enter your email address, then touch Save.

5. On the Enter password screen, use the onscreen keyboard to enter your password, then touch
Save.

6. Select the documents that you want to print.

7. Touch Print Options, then touch OK.

8. Touch Print.
• The Submitting Jobs to Print message and conversion state appears.
• When the documents begin to print, a green check mark appears.

9. When finished, to return to the Home screen, touch Exit.
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Printing Overview
Before you print, ensure that your computer and the printer are plugged in, powered on, and
connected to an active network. Ensure that you have the correct print driver software installed on
your computer. For details, refer to Installing the Software.

Note:

• Not all options described are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or print driver type.

• The Windows PostScript print driver and the Macintosh print driver provide the widest range
of features.

To send a job to the printer:

1. Select the appropriate paper.

2. Load paper in the appropriate tray. At the printer control panel, specify the paper size, color, and
type.

3. Access the print settings in your software application. For most software applications, press CTRL
+P for Windows, or CMD+P for Macintosh.

4. Select your printer.

5. To access the print driver settings, for Windows, select Printer Properties, Print Options, or
Preferences. For Macintosh, select Xerox Features. The title of the button can vary depending on
your application.

6. Modify the print driver settings as necessary, then click OK.

7. To send the job to the printer, click Print.

To print a file stored on a USB Flash drive, refer to Printing from a USB Flash Drive.
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Selecting Printing Options
Printing options, also called print driver software options, are specified as Printing preferences in Win-
dows and Xerox® Features in Macintosh. Printing options include settings for 2-sided printing, page
layout, and print quality. Printing options that are set from Printing preferences within the Devices
and Printers window become the default setting. Printing options that are set from within the soft-
ware application are temporary. The application and the computer do not save the settings after the
application is closed.

PPrriinntt DDrriivveerr HHeellpp
Xerox® print driver software Help information is available from the Printing Preferences window. Click
the Help button (?) in the bottom, left corner of the Printing Preferences window to see the Help.

Information about Printing Preferences appears in the Help window. From there, you can select by
topic or use the search field to enter the topic or function for which you need information.
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WWiinnddoowwss PPrriinnttiinngg OOppttiioonnss

SSeettttiinngg DDeeffaauulltt PPrriinnttiinngg OOppttiioonnss ffoorr WWiinnddoowwss
When you print from any software application, the printer uses the print job settings specified in the
Printing Preferences window. You can specify your most common printing options and save them so
that you do not have to change them every time you print.

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in
Printing Preferences.

1. Navigate to the list of printers on your computer:
• For Windows Server 2008 and later, click Start→Settings→Printers.
• For Windows 7, click Start→Devices and Printers.
• For Windows 8, click Start→Control Panel→Devices and Printers.
• For Windows 10, click Start→Settings→Devices→Printers & scanners. Scroll down in the

window, then under Related settings, click Devices and printers.

Note: If you are using a custom Start Menu application, it can change the navigation path
to your list of printers.

2. In the list of printers, right-click the icon for your printer, then click Printing preferences.

3. In the Printing Preferences window, click a tab, then select the options. To save the settings, click
OK.

Note: For more information about Windows print driver options, click the Help button (?) in the
Printing Preferences window.

SSeelleeccttiinngg PPrriinnttiinngg OOppttiioonnss ffoorr aann IInnddiivviidduuaall JJoobb ffoorr WWiinnddoowwss
To use special printing options for a particular job, you can change the Printing Preferences before
sending the job to the printer.

1. With the document open in your software application, access the print settings. For most
software applications, click File→Print or press CTRL+P.

2. Select your printer and click the Properties or Preferences button to open the Printing
Preferences window. The title of the button can vary depending on your application.

3. Click a tab in the Printing Preferences window, then make selections.

4. To save and close the Printing Preferences window, click OK.

5. To send the job to the printer, click Print.
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SSeelleeccttiinngg FFiinniisshhiinngg OOppttiioonnss ffoorr WWiinnddoowwss
If your printer has a finisher installed, you can select finishing options in the Properties window of the
print driver. Finishing options allow you to select how your document is delivered. For example, you
can select hole-punching, stapling, folding, or printing in a booklet format.

Note: Not all options listed are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or print driver type.

To select finishing options in the PostScript and PCL print drivers:

1. In the print driver, click the Printing Options tab.

2. To select a finishing option, for Finishing, click the arrow.

Note: The print driver displays stapling positions for paper fed on the long edge. If paper
feeds on the short edge instead of the long edge, the finisher can insert the staple in the
wrong location.

3. To select the output tray, for Output Destination, click the arrow, then select an option:
• Automatic: Use this option to have the printer determine the output destination based on

the number of sets and the stapling option selected. The printer sends multiple sets or stapled
sets to the finisher output tray.

• Center Tray: Use this option to select the output tray in the center of the printer.
• Center Top Tray: Use this option to select the upper output tray in the center of the printer.
• Center Bottom Tray: Use this option to select the lower output tray in the center of the

printer.
• Output Tray: Use this option to select the output tray on the right side of the Office Finisher.
• Right Top Tray: Use this option to select the output tray on the top of the Business Ready

Finisher.
• Right Middle Tray: Use this option to select the output tray in the middle of the Business

Ready Finisher.
• Right Bottom Tray: Use this option to select the output tray on the bottom of the Business

Ready Booklet Maker Finisher.

4. To send the job to the printer, click OK, then click Print.

SSeelleeccttiinngg PPrriinnttiinngg DDeeffaauullttss iinn WWiinnddoowwss ffoorr aa SShhaarreedd NNeettwwoorrkk
PPrriinntteerr
1. Navigate to the list of printers on your computer:

• For Windows Server 2008 and later, click Start→Settings→Printers.
• For Windows 7, click Start→Devices and Printers.
• For Windows 8, click Start→Control Panel→Devices and Printers.
• For Windows 10, click Start→Settings→Devices→Printers & scanners. Scroll down in the

window. For Related settings, click Devices and printers.

Note: If the Control Panel icon does not appear on the desktop, right-click the desktop,
then select Personalize→Control Panel Home→Devices and Printers.

2. In the list of printers, right-click the icon for your printer, then select Printer properties.

3. In the printer Properties dialog box, click the Advanced tab.

4. On the Advanced tab, click Printing Defaults.
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5. Make your selections on the print driver tabs as needed, then click Apply.

6. To save the settings, click OK.

SSaavviinngg aa SSeett ooff CCoommmmoonnllyy UUsseedd PPrriinnttiinngg OOppttiioonnss ffoorr WWiinnddoowwss
You can define and save a set of options, so that you can apply them to future print jobs. In Xerox®

App Gallery, you can save an app as default, so you can have app-by-app default settings for printing.

To save a set of printing options:

1. With the document open in your application, click File→Print.

2. To open the Printing Preferences window, select your printer, then click Properties or Preferences.

3. In the Printing Properties window, click the tabs, then select the required settings.

4. In the Printing Properties window, click Saved Settings, then click Save As.

5. To save the set of options in the Saved Settings list, type a name for the set of printing options,
then click OK.

OOnnee TToouucchh PPrreesseettss
The One Touch tab shows previously defined print presets that have been marked as One Touch pre-
sets. The presets include the default Xerox options and the options you define. When you select a One
Touch preset button, it enables the settings and closes the Printer Preferences window.

Note: Not all options listed are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or print driver type.

SSaavviinngg PPrriinnttiinngg OOppttiioonnss aass aa OOnnee TToouucchh PPrreesseett
1. With the document open in your application, click File→Print.

2. To open the Printing Preferences window, select your printer, then click Printer Properties.

3. Click Print Settings.

4. At the bottom of the page, click Presets→Save As.

5. Type a name for the preset, then choose an icon for the preset.

6. Select preset options:
• To enable the preset as One Touch, select One Touch Preset.
• To share the preset in all print drivers, select Show the Preset in All Drivers.

7. Click OK.

8. To print with these settings:
• Select the name from the Presets list.
• For a One Touch preset, select the preset from the One Touch tab.
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MMaacciinnttoosshh PPrriinnttiinngg OOppttiioonnss

SSeelleeccttiinngg PPrriinnttiinngg OOppttiioonnss ffoorr MMaacciinnttoosshh
To use specific printing options, change the settings before sending the job to the printer.

1. With the document open in your application, click File→Print.

2. Select your printer.

3. In the Print window, in the print options list, click Xerox Features.

Note: To see all printing options, click Show Details.

4. Select any other required printing options from the lists.

5. To send the job to the printer, click Print.

SSeelleeccttiinngg FFiinniisshhiinngg OOppttiioonnss ffoorr MMaacciinnttoosshh
If your printer has a finisher installed, select finishing options in the Xerox®Features of the print
driver.

To select finishing options in the Macintosh print driver:

1. In the Print window, in the print options list, click Xerox Features.

Note: To see all printing options, click Show Details.

2. To select stapling options, for Finishing, click the arrow, then select an option.

3. To select the output tray, for Output Destination, click the arrow, then select an option.

• Automatic: Use this option to have the printer determine the output destination based on
the number of sets and the stapling option selected. The printer sends multiple sets or stapled
sets to the finisher output tray.

• Center Tray: Use this option to select the output tray in the center of the printer.

• Center Top Tray: Use this option to select the upper output tray in the center of the printer.

• Center Bottom Tray: Use this option to select the lower output tray in the center of the
printer.

• Output Tray: Use this option to select the output tray on the right side of the Office Finisher.

• Right Top Tray: Use this option to select the output tray on the top of the Business Ready
Finisher.

• Right Middle Tray: Use this option to select the output tray in the middle of the Business
Ready Finisher.

• Right Bottom Tray: Use this option to select the output tray on the bottom of the Business
Ready Booklet Maker Finisher.

4. To send the job to the printer, click Print.
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SSaavviinngg aa SSeett ooff CCoommmmoonnllyy UUsseedd PPrriinnttiinngg OOppttiioonnss ffoorr MMaacciinnttoosshh
You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:

1. With the document open in your application, click File→Print.

2. Select your printer from the Printers list.

3. Select the required printing options from the lists in the Print dialog box.

Note: To see all printing options, click Show Details.

4. Click Presets→Save Current Settings as Preset

5. Type a name for the printing options.

6. For Preset Available For, select an option:
• Only this printer: Use the preset in this print driver only.
• All printers: Share the preset in all print drivers.

7. To save the set of options in the Presets list, click OK.

8. To print using these options, select the name from the Presets list.

UUNNIIXX aanndd LLiinnuuxx PPrriinnttiinngg
The Xerox® Print Driver package provides tools for you to manage printers connected in UNIX and
Linux environments.

The Xerox® print drivers provide a GUI-based (Graphical User Interface) driver dialog for printer
feature selections. You can select print drivers based on your operating system.

XXeerrooxx®® PPrriinntteerr MMaannaaggeerr
Xerox® Printer Manager is an application that allows you to manage and print to multiple printers in
UNIX and Linux environments.

Xerox® Printer Manager allows you to:

• Configure and check the status of network connected printers.

• Set up a printer on your network and monitor the operation of the printer once installed.

• Perform maintenance checks and view supplies status at any time.

• Provide a common look and feel across the many different suppliers of UNIX and Linux operating
systems.

Installing Xerox® Printer Manager
Before you begin, ensure that you have root or superuser privileges to install Xerox® Printer Manager.

To install Xerox® Printer Manager:

1. Download the appropriate package for your operating system. To locate print drivers for your
printer, go to www.xerox.com/support/VLC8000drivers.

2. On the print driver website, navigate to your printer model.

3. For your printer model, click Drivers & Downloads.
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4. From the Operating System menu, select your operating system.

5. To identify the print driver for your printer model, review the list of available print drivers.

Note: For additional information on each driver, click Description.

6. To select the print driver for your printer model and operating system, click the print driver name.

7. To begin the download, read the End User License Agreement, then click Accept.

The file automatically downloads to the default location for your computer file downloads.

8. To install the Xerox® Print Driver package:

a. Open the package with your OS package manager.

b. To install using a command-line utility, change to the directory where you downloaded the
file. To run the installer, type the appropriate command-line utility for your operating system.
For example:

• Red Hat: rpm -U <filename>.rpm

• Debian-based Linux: dpkg -i <filename>.deb

• AIX: rpm -U <filename>.rpm

• HPUX: <filename>.depot.gz

• Solaris: pkgadd -d <filename>.pkg

Note: Most installations create a Xerox directory in /opt/Xerox/prtsys. For additional
information about utilities included in the OS package manager, refer to the manual
included with the package. For example, man xeroxprtmgr.

Launching Xerox® Printer Manager
To launch Xerox® Printer Manager, do one of the following tasks.

• For UNIX, log in as root. From a terminal window, type xosdprtmgr, then press Enter or Return.

• For Linux, type sudo xeroxprtmgr, then press Enter or Return.

PPrriinnttiinngg wwiitthh xxeerrooxxpprriinntt
Xerox has its own print command. You can use the following command:

xeroxprint -d<Some_Queue→ -o[Options] <Somefile

PPrriinnttiinngg ffrroomm aa LLiinnuuxx WWoorrkkssttaattiioonn
To print from a Linux workstation, install either a Xerox® print driver for Linux or a CUPS (Common
UNIX Printing System) print driver. You do not need both drivers.

Xerox recommends that you install one of the full-featured custom print drivers for Linux. To locate
drivers for your printer, go to www.xerox.com/drivers.

If you use CUPS, ensure that CUPS is installed and running on your workstation. The instructions for
installing and building CUPS are contained in the CUPS Software Administrators Manual, written and
copyrighted by Easy Software Products. For complete information on CUPS printing capabilities, refer
to the CUPS Software Users Manual available from www.cups.org/documentation.php.
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Installing the PPD File on the Workstation
1. If available, download the Xerox® PPD for CUPS (Common UNIX Printing System) from the

Drivers and Downloads page on the Xerox Support website.

2. Copy the PPD file into the CUPS ppd/Xerox folder on your workstation. If you are unsure of the
location of the folder, use the Find command to locate the PPD files.

3. Follow the instructions that are included with the PPD file.

Adding the Printer
1. Verify that the CUPS (Common UNIX Printing System) daemon is running.

2. Open a Web browser and type http://localhost:631/admin, then click Enter or Return.

3. For User ID, type root. For password, type the root password.

4. Click Add Printer, then follow the onscreen prompts to add the printer to the CUPS printer list.

Printing with CUPS (Common UNIX Printing System)
CUPS supports the use of both the System V (lp) and Berkeley (lpr) printing commands.

1. To print to a specific printer in System V, type lp -dprinter filename, then click Enter.

2. To print to a specific printer in Berkeley, type lpr -Pprinter filename, then click Enter.

MMoobbiillee PPrriinnttiinngg OOppttiioonnss
This printer can print from iOS and Android mobile devices. For more information, refer to Configuring
Google Cloud Print.

PPrriinnttiinngg wwiitthh WWii--FFii DDiirreecctt
You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or smart-
phone, using Wi-Fi Direct.

For details, refer to Connecting to Wi-Fi Direct.

For details on using Wi-Fi Direct, refer to the documentation provided with your mobile device.

Note: Depending on which mobile device you are using, the printing procedure varies.

PPrriinnttiinngg wwiitthh AAiirrPPrriinntt
You can print directly from your iPhone, iPad, iPod touch, or Mac using AirPrint®. To enable AirPrint®

for your printer, refer to Configuring AirPrint. To use AirPrint®, ensure that your mobile device is
connected to the same wireless network as the printer.

To print with AirPrint®:

1. Open the email, photograph, website page, or document that you want to print.

2. Tap the Action icon.

3. Tap Print.

4. Select your printer, then set the printer options.

5. Tap Print.
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PPrriinnttiinngg ffrroomm aa MMOOPPRRIIAA--EEnnaabblleedd MMoobbiillee DDeevviiccee
MOPRIA™ is a software feature that enables users to print from mobile devices without requiring a
print driver. You can use MOPRIA™ to print from your mobile device to MOPRIA™-enabled printers.

Note:

• MOPRIA™ and all of its required protocols are enabled by default.

• Ensure that you have the latest version of the MOPRIA™ Print Service installed on your mo-
bile device. You can obtain a free download from the Google Play Store.

• Wireless devices must join the same wireless network as the printer.

• The name and location of your printer appears in a list of MOPRIA™-enabled printers on con-
nected devices.

To print using MOPRIA™, follow the directions provided with your mobile device.
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Print Jobs
MMaannaaggiinngg PPrriinntt JJoobbss
From the Jobs App, you can view lists of active jobs, secure jobs, or completed jobs. You can pause,
delete, print, or view job progress or job details for a selected job. From the Jobs window in the
Embedded Web Server, you can view a list of active and completed print jobs. For more information,
refer to Managing Jobs Using the Embedded Web Server.

A print job can be held by the printer when it is unable to complete. For example, when the printer
needs attention, paper, or supplies. When the condition is resolved, the printer automatically resumes
printing. When you send a Secure Print job, the job is held until you release it by typing a passcode at
the control panel. For more information, refer to Printing Special Job Types.

PPaauussiinngg tthhee PPrriinntt JJoobb wwiitthh tthhee OOppttiioonn ttoo DDeelleettee IItt
1. At the printer control panel, press the Home button.

2. Touch Jobs, then touch the name of the print job.

3. Do one of the following:
• To pause the print job, touch Pause. To resume the print job, touch Resume.
• To delete the print job, touch Delete. At the prompt, touch Delete.

Note: If you do not make a selection within 60 seconds, the job resumes automatically.

4. To return to the Home screen, press the Home button.

VViieewwiinngg,, PPrriinnttiinngg,, oorr DDeelleettiinngg SSaavveedd aanndd SSeeccuurree JJoobbss
Note:

• The system administrator can restrict users from deleting jobs. If a system administrator
has restricted job deletion, you can view the jobs, but not delete them.

• Only the user that sent the job or the system administrator can delete a Secure Print job.

1. At the printer control panel, press the Home button.

2. To view a list of active and completed jobs, touch Jobs.

3. To view a list of specific job types, touch an option.
• To view Saved Jobs, touch Saved Jobs. To print the job, touch the job, enter the quantity, then

touch OK. To delete the job, touch the Trash icon, then touch Delete.
• To view Personal jobs, touch Personal & Secure Jobs. To print the jobs, touch the folder, then

touch Print All, or Delete All.
• For Secure Jobs, touch Personal & Secure Jobs. Touch the folder, enter the passcode number,

then touch OK. To print a Secure Job, touch the job. To print or delete all the jobs in the folder,
touch Print All, or Delete All.

4. To view details about a job, touch the job.

5. To return to the Home screen, press the Home button.
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PPrriinnttiinngg SSppeecciiaall JJoobb TTyyppeess
Special job types allow you to send a print job from your computer, then print it from the printer
control panel. To select special job types from the print driver, select Printing Options→Job Type.

SSaavveedd JJoobbss
Saved Jobs are documents sent to the printer and, unless deleted, are stored there for future use. Any
user can print or delete a Saved Job.

To print a Saved Job, refer to Printing a Saved Job.

Printing a Saved Job
1. In your software application, access the print settings. For most software applications, press CTRL

+P for Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
• For Windows, click Printer Properties. Depending on your application, the title of the button

can vary.
• For Macintosh, in the Print window, in the print options list, click Xerox Features.

3. For Job Type, select Saved Job.

a. Type a job name or select a name from the list.

b. Type a folder name or select a name from the list.

c. To add a passcode, click Private, type the passcode, then confirm the passcode.

d. Click OK.

4. Select other required printing options.
• For Windows, click OK, then click Print.
• For Macintosh, click Print.

Releasing a Saved Job
1. At the printer control panel, press the Home button.

2. Touch Jobs.

3. To view Saved Jobs, touch Saved Jobs.

4. To print a Saved Job, touch the job name, enter the quantity, then touch OK.

5. To delete the document after printing, for that job, touch the Trash icon, then at the prompt,
touch Delete.

6. To return to the Home screen, press the Home button.

SSeeccuurree PPrriinntt
Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the
printer until you enter your passcode at the printer control panel.

To print a Secure Print job, refer to Printing a Secure Print Job.
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Printing a Secure Print Job
1. In your software application, access the print settings. For most software applications, press CTRL

+P for Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
• For Windows, click Printer Properties. Depending on your application, the title of the button

varies.
• For Macintosh, in the Print window, in the print options list, click Xerox Features.

3. For Job Type, select Secure Print.

4. Type the passcode, confirm the passcode, then click OK.

5. Select any other required printing options.
• For Windows, click OK, then click Print.
• For Macintosh, click Print.

Releasing a Secure Print job
1. At the printer control panel, press the Home button.

2. Touch Jobs.

3. To view Secure Print jobs, touch Personal & Secure Jobs.

4. Touch your folder.

5. Enter the passcode number, then touch OK.

6. Select an option:
• To print a Secure Print job, touch the job.
• To print all the jobs in the folder, touch Print All.
• To delete a Secure Print job, touch the Trash icon. At the prompt, touch Delete.
• To delete all the jobs in the folder, touch Delete All.

Note: After a Secure Print job is printed, it is deleted automatically.

7. To return to the Home screen, press the Home button.

PPeerrssoonnaall PPrriinntt
Personal Print allows you to store a document in the printer, then print it from the control panel.

Personal Print is a type of saved job with these features:

• A Personal Print job appears in a folder named after the user ID associated with the print job.

• A Personal Print job does not use a passcode.

• Any user can print or delete a Personal Print job.

• You can print all jobs in the list at once, delete an individual job, or delete all jobs in the list.

• After a Personal Print job is printed, it is deleted automatically.

To print using Personal Print, refer to Printing a Personal Print Job.
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Printing a Personal Print Job
1. In your software application, access the print settings. For most software applications, press CTRL

+P for Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
• For Windows, click Printer Properties. Depending on your application, the title of the button

varies.
• For Macintosh, in the Print window, in the print options list, click Xerox Features.

3. For Job Type, select Personal Print.

4. Select any other required printing options.
• For Windows, click OK, then click Print.
• For Macintosh, click Print.

Releasing a Personal Print Job
1. At the printer control panel, press the Home button.

2. Touch Jobs.

3. To view Personal Print jobs, touch Personal & Secure Jobs.

4. Touch your folder.

5. If prompted for a passcode, touch Skip.

Note: When your folder contains Secure Print jobs and Personal Print jobs, the passcode
prompt appears.

6. Select an option.
• To print a Personal Print job, touch the job.
• To print all the jobs in the folder, touch Print All.
• To delete all the jobs in the folder, touch Delete All.

7. To return to the Home screen, press the Home button.

SSaammppllee SSeett
The Sample Set job type prints one copy of a multiple-copy print job before printing the remaining
copies. After reviewing the sample set, you can either print the remaining copies or delete them at
the printer control panel.

Sample Set is a type of saved job with these features:

• A Sample Set job appears in a folder named after the user ID associated with the print job.

• A Sample Set job does not use a passcode.

• Any user can print or delete a Sample Set job.

• A Sample Set prints one copy of a job to allow you to proofread the job before printing any re-
maining copies.

After a Sample Set job is printed, it is deleted automatically.

To print a Sample Set, refer to Printing a Sample Set.
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Printing a Sample Set
1. In your software application, access the print settings. For most software applications, press CTRL

+P for Windows or CMD+P for Macintosh.

2. Select your printer, then open the print driver.
• For Windows, click Printer Properties. Depending on your application, the title of the button

varies.
• For Macintosh, in the Print window, in the print options list, click Xerox Features.

3. For Job Type, select Sample Set.

4. Select any other required printing options.
• For Windows, click OK, select the number of copies, then click Print.
• For Macintosh, select the number of copies, then click Print.

Note: If the number of copies is set to 1, one copy will be printed and the job will not be
held at the printer.

Releasing a Sample Set
1. At the printer control panel, press the Home button.

2. To view available jobs, touch Jobs.

3. Touch the Sample Set job.

Note: The Sample Set file description shows the job as Held for Future Printing, and shows
the number of remaining copies of the job.

4. Select an option.
• To print the remaining copies of the job, touch Release.
• To delete the remaining copies of the job, touch Delete.

5. To return to the Home screen, press the Home button.
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Printing Features

SSeelleeccttiinngg PPaappeerr OOppttiioonnss ffoorr PPrriinnttiinngg
There are two ways to select the paper for your print job. You can let the printer select which paper to
use based on the document size, paper type, and paper color you specify. You can also select a
specific tray loaded with the desired paper.

SSccaalliinngg
Scaling reduces or enlarges the original document to match the selected output paper size.

• For Windows, the scale options are on the Printing Options tab, in the Paper field.

• For Macintosh, the scale options are in the Print window. To view more printing options, click Show
Details.

Note: Not all options described are supported on all printers. Some options apply only to a spe-
cific printer model, configuration, operating system, or print driver type.

The following scaling options are available:

• Fit to New Paper Size scales the document to fit the new paper size.

• Change Document Size does not change the size of the page image printed on the output paper.
Use this setting to match the paper size selected in your application.

• Automatically Scale scales the document to fit the selected Output Paper Size. The scaling
amount appears in the percentage box below the sample image.

• No Scaling does not change the size of the page image printed on the output paper, and 100%
appears in the percentage box. If the original size is larger than the output size, the page image is
cropped. If the original size is smaller than the output size, extra space appears around the page
image.

• Manually Scale scales the document by the amount entered in the percentage box below the pre-
view image.

PPrriinnttiinngg oonn BBootthh SSiiddeess ooff tthhee PPaappeerr

PPrriinnttiinngg aa 22--SSiiddeedd DDooccuummeenntt
If your printer supports Automatic 2-Sided Printing, the options are specified in the print driver. The
print driver uses the settings for portrait or landscape orientation from the application for printing the
document.

Note: Ensure that the paper size and weight are supported. For details, refer to Supported
Paper Types and Weights for Automatic 2-Sided Printing.

22--SSiiddeedd PPaaggee LLaayyoouutt OOppttiioonnss
You can specify the page layout for 2-sided printing, which determines how the printed pages turn.
These settings override the application page orientation settings.
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• 1-Sided Print: This option prints on one side of the media. Use this option when printing on enve-
lopes, labels, or other media that cannot be printed on both sides.

• 2-Sided Print: This option prints the job on both sides of the paper to allow binding on the long
edge of the paper. The following illustrations show the result for documents with portrait and land-
scape orientation, respectively:

• 2-Sided Print, Flip on Short Edge: This option prints on both sides of the paper. The images print
to allow binding on the short edge of the paper. The following illustrations show the result for
documents with portrait and landscape orientations, respectively:

Note: 2-Sided Printing is part of the Earth Smart settings.

To change your default print driver settings, refer to Setting Default Printing Options for Windows.

XXeerrooxx BBllaacckk aanndd WWhhiittee
You can select printing in color or black and white.

• Off (use Document Color): Use this option to print in color.

• On: Use this option to print in black and white.

PPrriinntt QQuuaalliittyy
Print-quality modes:

• Standard print-quality mode: 600 x 600 dpi

• Enhanced print-quality mode: 1200 x 2400 dpi

• Photo Mode: 1200 x 2400 dpi

Note: Enhanced and Photo Mode are not available with the PCL driver.

IImmaaggee OOppttiioonnss
Image Options controls how the printer uses color to produce your document. The Windows
PostScript print driver and the Macintosh print drivers provide the widest range of color controls and
corrections on the Image Options tab.

IImmaaggee SShhiifftt
Image Shift allows you to modify the location of the image on the page. You can shift the printed im-
age along the X and Y axes of each sheet of paper.
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CCoolloorr CCoorrrreeccttiioonn
Color Correction matches printer colors on PostScript jobs to colors on other devices, such as your com-
puter screen or a printing press.

Color Correction options:

• Xerox Black and White: This option converts all color in the document to black and white, or
shades of gray.

• Xerox Automatic Color: This option applies the best color correction to text, graphics, and images.
Xerox recommends this setting.

There are more Color Correction options, including Vivid RGB and Commercial.

CCoolloorr AAddjjuussttmmeennttss
Use Color Adjustments to adjust particular characteristics of the printed color. Characteristics include
lightness, contrast, saturation, and color cast.

Note: Not all options listed are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or driver type.

Lightness
The Lightness feature allows you to adjust the overall lightness or darkness of the text and images in
your printed job.

Contrast
You can use the Contrast feature to adjust the variation between light and dark areas of the print job.

Saturation
Saturation allows you to adjust the color strength and the amount of gray in the color.

Color Cast
Use Color Cast settings to adjust the amount of a selected color in the print job while preserving
lightness.

The following options are available:

• The Cyan to Red option allows you to adjust the color balance between cyan and red. For example,
when you increase the cyan levels, the red levels decrease.

• The Magenta to Green option allows you to adjust the color balance between magenta and green.
For example, when you increase the magenta levels, the green levels decrease.

• The Yellow to Blue option allows you to adjust the color balance between yellow and blue. For ex-
ample, when you increase the yellow levels, the blue levels decrease.

PPrriinnttiinngg MMuullttiippllee PPaaggeess ttoo aa SSiinnggllee SShheeeett
When printing a multiple-page document, you can print more than one page on a single sheet of
paper.

To print 1, 2, 4, 6, 9, or 16 pages per side, select Pages Per Sheet on the Layout tab.
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To print a border around each page, for Page Borders, select Enabled.

PPrriinnttiinngg BBooookklleettss
With 2-sided printing, you can print a document in the form of a small booklet. You can create
booklets from any paper size that is supported for 2-sided printing.

The print driver automatically reduces each page image and prints four page images per sheet of
paper, two page images on each side. The pages are printed in the correct order so that you can fold
and staple the pages to create the booklet.

• For Windows, Booklet Layout is on the Page Layout tab. Page Layout is on the Document Options
tab.

• For Macintosh, in the Print window, in Xerox Features, Booklet Layout is on the Paper/Output list.

When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter
and creep.

• Gutter: Specifies the horizontal distance in points between the page images. A point is 0.35 mm
(1/72 in.).

• Creep: Specifies how much the page images shift outward in tenths of a point. Shifting
compensates for the thickness of the folded paper, which can cause the page images to shift
outward slightly when folded. You can select a value from zero to 1 point.

Gutter Creep

UUssiinngg SSppeecciiaall PPaaggeess
The Special Pages options control how covers, inserts, and exception pages are added to your printed
document.

• For Windows, the Special Pages tab is on the Document Options tab.

• For Macintosh, in the Print window, in Xerox Features, Special Pages is on the Paper/Output list.
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PPrriinnttiinngg CCoovveerr PPaaggeess
A cover page is the first or last page of a document. You can select paper sources for the cover pages
that are different from the source used for the body of a document. For example, you can use your
company letterhead for the first page of a document. You can also use heavyweight paper for the first
and last pages of a report. You can use any applicable paper tray as the source for printing cover
pages.

Select one of these options for printing cover pages:

• No Covers: This option does not print cover pages. No cover pages are added to the document.

• Front Only: This option prints the first page on paper from the specified tray.

• Back Only: This option prints the back page on paper from the specified tray.

• Front and Back: Same prints the front and back cover pages from the same tray.

• Front and Back: Different prints the front and back cover pages from different trays.

After making a selection for printing the cover pages, you can select the paper for the front and back
covers by size, color, or type. You can also use blank or pre-printed paper, and you can print side one,
side two, or both sides of the cover pages.

PPrriinnttiinngg IInnsseerrtt PPaaggeess
You can add blank or pre-printed insert pages before page one of each document or after designated
pages within a document. Adding an insert after designated pages within a document separates sec-
tions, or acts as a marker or placeholder. Ensure that you specify the paper to use for the insert pages.

• Insert Options provides the options to place an insert After Page X, where X is the specified page,
or Before Page 1.

• Insert Quantity specifies the number of pages to insert at each location.

• Pages: Specifies the page or range of pages that use the exception page characteristics. Separate
individual pages or page ranges with commas. Specify pages within a range with a hyphen. For ex-
ample, to specify pages 1, 6, 9, 10, and 11, type 1,6,9-11.

• Paper: Displays the default size, color, and type of paper selected in Use Job Settings.

• Job Setting: Displays the attributes of the paper for the remainder of the job.

PPrriinnttiinngg EExxcceeppttiioonn PPaaggeess
Exception pages have different settings from the rest of the pages in the job. You can specify differen-
ces such as page size, page type, and page color. You can also change the side of the paper on which
to print as your job requires. A print job can contain multiple exceptions.

For example, your print job contains 30 pages. You want five pages to print on only one side of a spe-
cial paper, and the remainder of the pages printed 2-sided on regular paper. You can use exception
pages to print the job.

In the Add Exceptions window, you can set the characteristics of the exception pages and select the
alternate paper source:
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• Pages: Specifies the page or range of pages that use the exception page characteristics. Separate
individual pages or page ranges with commas. Specify pages within a range with a hyphen. For ex-
ample, to specify pages 1, 6, 9, 10, and 11, type 1,6,9-11.

• Paper: Displays the default size, color, and type of paper selected in Use Job Settings.

• 2-Sided Printing allows you to select 2-sided printing options. Click the Down arrow to select an
option:

– 1-Sided Print prints the exception pages on one side only.

– 2-Sided Print prints the exception pages on both sides of the paper and flips the pages on
the long edge. The job then can be bound on the long edge of the pages.

– 2-Sided Print, Flip on Short Edge prints the exception pages on both sides of the paper and
flips the pages on the short edge. The job then can be bound on the short edge of the pages.

– Use Job Setting prints the job using the attributes shown in the Job Settings box.

• Job Setting: Displays the attributes of the paper for the remainder of the job.

Note: Some combinations of 2-sided printing with certain paper types and sizes can produce
unexpected results.

PPrriinnttiinngg AAnnnnoottaattiioonnss ffoorr WWiinnddoowwss
An annotation is special-purpose text or an image that you can print across one or more pages. You
can preview annotations in the Annotations Preview pane.

The Annotations setup for your print job appears in the Annotations summary list. From this list, you
can select an annotation to edit or delete.

Note:

• This feature is available only on a Windows computer printing to a network printer.

• Not all options listed are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or print driver type.

To print an annotation:

1. In the print driver, click the Document Options tab.

2. Click the Annotations tab.

3. To add a text annotation, click Add Comment. Enter the text in the field, select the required
settings, then click OK.

4. For a date or time stamp, click Add Time Stamp. Specify the date and time option, select the
required settings, then click OK.

5. To add a picture annotation, click Add Picture. To locate the picture, click the Browse icon. Select
the required settings, then click OK.
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6. For each annotation, the following options are available:

• To specify the font, click the Font button.

• For a picture annotation, select the scaling option that specifies the size of the picture in
relation to the original image. Use the arrows to scale the image in increments of 1%.

• To define the angle of the annotation on the page, specify the position option. Or, to rotate
the annotation left or right by increments of 1, use the arrows.

• To define the location of the annotation on the page, specify the position option. Or, to move
the annotation in each direction in increments of 1, use the arrows.

• To adjust the transparency of the annotation, move the slider to the right to increase
transparency, or to the left to decrease transparency.

• For Layering, select an option:

– Print in Background: This option prints the annotation behind the text and graphics in
the document.

– Print in Foreground: This option prints the annotation over the text and graphics in the
document.

• For Pages, select the pages to print the annotation:

– Print on All Pages: This option prints the annotation on all pages of your document.

– Print on Page 1 Only: This option prints the annotation only on the first page of the
document.

7. To save the annotation, click the Save Annotation icon.

8. To load a previously saved annotation, click the Load Annotation icon.

9. Click OK.

PPrriinnttiinngg WWaatteerrmmaarrkkss ffoorr WWiinnddoowwss
A watermark is special-purpose text that can be printed across one or more pages. For example, you
can add a word like Copy, Draft, or Confidential as a watermark instead of stamping it on a document
before distribution.

Note:

• This feature is available only on a Windows computer printing to a network printer.

• Not all options listed are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or print driver type.

• Watermarks are not supported for some print drivers when booklet is selected or when more
than one page is printed on a sheet of paper.

To print a watermark:

1. In the print driver, click the Document Options tab.

2. Click the Watermark tab.

3. From the Watermark menu, select the watermark. You can choose from preset watermarks, or
create a customized watermark. You can also manage watermarks from this menu.

4. Under Text, select an option:
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• Text: Enter the text in the field, then specify the font.
• Time Stamp: Specify the date and time options, then specify the font.
• Picture: To locate the picture, click the Browse icon.

5. Specify the scaling angle and position of the watermark:
• Select the scaling option that specifies the size of the picture in relation to the original image.

Use the arrows to scale the image in increments of 1%.
• To define the angle of the image on the page, specify the position option or to rotate the

image left or right by increments of 1, use the arrows.
• To define the location of the image on the page, specify the position option, or to move the

image in each direction in increments of 1, use the arrows.

6. Under Layering, select how to print the watermark:
• Print in Background: This option prints the watermark behind the text and graphics in the

document.
• Blend: This option combines the watermark with the text and graphics in the document. A

blended watermark is translucent, so you can see both the watermark and the document
content.

• Print in Foreground: This option prints the watermark over the text and graphics in the
document.

7. Click Pages, then select the pages to print the watermark:
• Print on All Pages: This option prints the watermark on all pages of your document.
• Print on Page 1 Only: This option prints the watermark only on the first page of the

document.

8. If you select a picture as a watermark, specify the lightness settings for the image.

9. Click OK.

OOrriieennttaattiioonn
Orientation allows you to select the direction that the page prints.

• For Windows, the Orientation tab is on the Document Options tab.

Note: The orientation setting in your application print dialog box may override the orientation
options in the print driver.

• For Macintosh, Orientation options are in the Print window.

The following options are available:

• Portrait: Orients the paper so that the text and images print across the short dimension of the
paper.

• Landscape: Orients the paper so that the text and images print across the long dimension of the
paper.

• Rotated Landscape: Orients the paper so that the content is rotated 180 degrees and with the
long bottom side up.
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Note: For Macintosh, to print portrait text and images in landscape orientation, clear
the Auto Rotate check box.

AAddvvaanncceedd PPrriinnttiinngg OOppttiioonnss
You can use the Advanced button or tab to set advanced printing options. Advanced printing
selections apply to all jobs that you print with the print driver.

Note: Not all options listed are supported on all printers. Some options apply only to a specific
printer model, configuration, operating system, or print driver type.

JJoobb IIddeennttiiffiiccaattiioonn
You can use the Job ID feature to change the job identification setting for your print job. You can
print the job identification on a separate banner page or on the pages of your document.

The following options are available:

• Disable Job ID: This option directs the printer not to print a banner page.

• Print ID on a Banner Page: This option prints the job identification on a banner page.

• Print ID in Margins - First Page Only: This option prints the job identification on the first page of
the document in the top-left margin.

• Print ID in Margins - All Pages: This option prints the job identification in the top-left margin on
every page of the document.

PPrriinnttiinngg MMiirrrroorr IImmaaggeess
If the PostScript driver is installed, you can print pages as a mirror image. Images mirror left to right
when printed.

JJoobb NNoottiiffiiccaattiioonn ffoorr WWiinnddoowwss
You can select to be notified when your job finishes printing. A message appears on your computer
screen with the name of the job and the name of the printer where it was printed.

Note: This feature is only available on a Windows computer printing to a network printer.

The following options are available:

• Notify for Completed Jobs: This option provides a notification when the job has completed.

• Notify for Completed, but Altered Jobs: This option provides a notification on all jobs that
completed with restrictions.

• Notify for Failed or Canceled Jobs: This option provides notification of all jobs that failed to print
or were canceled.

• Play Alert Tone: This option sounds an alert tone when a notification appears.
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Using Custom Paper Sizes
You can print on custom paper sizes that are within the minimum and maximum size range supported
by the printer. For more information, refer to Supported Custom Paper Sizes.

PPrriinnttiinngg oonn CCuussttoomm PPaappeerr SSiizzeess
Note: Before printing on a custom paper size, use the Custom Paper Sizesfeature in Printer
Properties to define the custom size. For more information, refer to Defining Custom Paper
Sizes.

PPrriinnttiinngg oonn CCuussttoomm PPaappeerr SSiizzee ffrroomm WWiinnddoowwss
Note: Before printing on custom-size paper, define the custom size in the Printer Properties.

1. Load the custom-size paper in the tray.

2. In the application, click File→Print, then select your printer.

3. In the Print dialog box, click Printer Properties.

4. On the Printing Options tab, from the Paper list, select the required custom paper size and type.

5. Select any other required options, then click OK.

6. In the Print dialog box, click Print.

PPrriinnttiinngg oonn CCuussttoomm--SSiizzee PPaappeerr ffrroomm aa MMaacciinnttoosshh CCoommppuutteerr
1. Load the custom-size paper.

2. In the application, click File→Print.

3. From the Paper Size list, select the custom paper size.

4. Click Print.

DDeeffiinniinngg CCuussttoomm PPaappeerr SSiizzeess
To print custom paper sizes, define the custom width and length of the paper in the print driver
software and on the printer control panel. When setting the paper size, ensure that you specify the
same size as the paper in the tray. Setting the wrong size paper can cause a printer error. Print driver
settings override control panel settings when you print using the print driver software on your
computer.

CCrreeaattiinngg aanndd SSaavviinngg CCuussttoomm PPaappeerr SSiizzeess iinn tthhee PPrriinntt DDrriivveerr
You can print custom-size paper from any paper tray. Custom-size paper settings are saved in the print
driver and are available for you to select in all your applications.

For more information on supported paper sizes for each tray, refer to Supported Custom Paper Sizes.
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Creating and Saving Custom Sizes for Windows
1. In the print driver, click the Printing Options tab.

2. For Paper, click the arrow, then select Other Size→Advanced Paper Size→Output Paper
Size→New.

3. In the New Custom Paper Size window, enter the height and width of the new paper size.

4. To specify the units of measurement, at the bottom of the window, click the Measurements
button, then select Inches or Millimeters.

5. To save, in the Name field, type a title for the new size, then click OK.

Creating and Saving Custom Sizes for Macintosh
1. In the application, click File→Print.

2. Click Paper Size, then select Manage Custom Sizes.

3. To add a new size, in the Manage Paper Sizes window, click the Plus icon (+).

4. Double-click Untitled, then type a name for the new custom paper size.

5. Enter the height and width of the new custom paper size.

6. Click the arrow for the Non-Printable Area field, then select the printer from the list. Or, for User
Defined margins, set the top, bottom, right, and left margins.

7. To save the settings, click OK.

DDeeffiinniinngg aa CCuussttoomm PPaappeerr SSiizzee aatt tthhee CCoonnttrrooll PPaanneell
You can print custom-size paper from the following paper trays:

• Trays 1 and 2.

• Trays 3 and 4 of the 2-Tray Module.

• The Bypass Tray.

Custom-size paper settings are saved in the print driver and are available for you to select in all your
applications.

Note: The tray setting requirement is Fully Adjustable. To configure the tray settings for Fully
Adjustable, refer to Configuring Tray Settings.

1. Open the paper tray, then load the custom-size paper.

2. Close the tray.

3. At the control panel, to define the new paper size, touch Size, then touch Custom.

4. In the Custom Paper Size window, enter the height and width of the new paper size, then touch
OK.

5. To confirm the settings, touch Confirm.
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Paper and Media Overview
The printer can have up to six paper trays, depending on the paper tray configuration.

1. Base Model
2. Configuration with Tandem Tray Module
3. Configuration with 2-Tray Module
4. Configuration with 2-Tray Module and High-Capacity Feeder

• For all configurations, Trays 1 and 2 are adjustable paper trays used to load a range of paper sizes.

• For the configuration with the 2-Tray Module, Trays 3 and 4 are adjustable trays similar to Trays 1
and 2.

• The Bypass Tray is used to load small amounts of special paper.

• The Tandem Tray Module is mostly used for standard pre-set sizes of media.

• The optional Envelope Tray can replace Tray 1.

• Tray 6 is an optional high-capacity paper tray.

The printer can use various media types, such as plain, recycled, or colored paper, letterhead, pre-
printed, cardstock, labels, and envelopes. Ensure that you use the correct media for the tray that you
load.

Labels are affixed inside each tray to show how to load certain types of media in the correct
orientation. The MAX label shows the maximum fill line for the tray.
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Supported Paper
Your printer is designed to use various paper and other media types. To ensure the best print quality
and to avoid jams, follow the guidelines in this section.

For best results, use Xerox paper and media recommended for your printer.

OOrrddeerriinngg PPaappeerr
To order paper or other media, contact your local reseller or visit www.xerox.com/supplies.

GGeenneerraall PPaappeerr LLooaaddiinngg GGuuiiddeelliinneess
• Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray.

• Adjust the paper guides to fit the paper size.

• Fan paper before loading it in the paper tray.

• If excessive jams occur, use paper or other approved media from a new package.

• Do not print on label media after a label has been removed from a sheet.

• Use only paper envelopes. Print envelopes 1-sided only.

PPaappeerr TThhaatt CCaann DDaammaaggee YYoouurr PPrriinntteerr
Some paper and other media types can cause poor output quality, increased paper jams, or damage
your printer. Do not use the following:

• Rough or porous paper

• Inkjet paper

• Non-laser glossy or coated paper

• Paper that has been photocopied

• Paper that has been folded or wrinkled

• Paper with cutouts or perforations

• Stapled paper

• Envelopes with windows, metal clasps, side seams, or adhesives with release strips

• Padded envelopes

• Plastic media

• Transparencies

Caution: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does
not cover damage caused by using unsupported paper or specialty media. The Xerox Total
Satisfaction Guarantee is available in the United States and Canada. Coverage could vary
outside these areas. Please contact your local representative for details.
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PPaappeerr SSttoorraaggee GGuuiiddeelliinneess
Storing your paper and other media properly contributes to optimum print quality.

• Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from
ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly
damaging to paper.

• Reduce the exposure of paper to strong lights for long periods of time.

• Maintain constant temperatures and relative humidity.

• Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to
collect moisture.

• Store paper flat, either on pallets, cartons, shelves, or in cabinets.

• Avoid food or drinks in the area where paper is stored or handled.

• Do not open sealed packages of paper until you are ready to load the paper into the printer.
Leave stored paper in the original packaging. The paper wrapper protects the paper from moisture
loss or gain.

• Some special media is packaged inside resealable plastic bags. Store the media inside the bag
until you are ready to use it. Keep unused media in the bag and reseal it for protection.

SSuuppppoorrtteedd PPaappeerr TTyyppeess aanndd WWeeiigghhttss

Trays Paper Types Weights

Trays 1 and 2

Trays 3 and 4 of the 2-Tray
Module

Bond

Hole-Punched

Letterhead

Plain

Pre-Printed

Recycled

Custom

64–105 g/m²

Lightweight Cardstock

Lightweight Glossy Cardstock

106–176 g/m²

Cardstock

Glossy Cardstock

177–220 g/m²

Heavyweight Cardstock

Heavyweight Glossy Cardstock

221–300 g/m²

Labels 106–176 g/m²

Postcards 106–220 g/m²
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Trays Paper Types Weights

Trays 3 and 4 of the Tandem Tray
Module

Bond

Hole-Punched

Letterhead

Plain

Pre-Printed

Recycled

Custom

64–105 g/m²

Lightweight Cardstock

Lightweight Glossy Cardstock

106–176 g/m²

Cardstock

Glossy Cardstock

177–220 g/m²

Bypass Tray Bond

Hole-Punched

Letterhead

Plain

Pre-Printed

Recycled

Custom

64–105 g/m²

Lightweight Cardstock

Lightweight Glossy Cardstock

106–176 g/m²

Cardstock

Glossy Cardstock

177–220 g/m²

Heavyweight Cardstock

Heavyweight Glossy Cardstock

221–300 g/m²

Labels 106–176 g/m²

Postcards 106–220 g/m²

Envelopes 75–90 g/m²

Note: C9000 only Extra Heavyweight Cardstock 301–350 g/m²
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Trays Paper Types Weights

Extra Heavyweight Glossy
Cardstock

Tray 6
Bond

Hole-Punched

Letterhead

Plain

Recycled

Custom

64–105 g/m²

Lightweight Cardstock

Lightweight Glossy Cardstock

106–176 g/m²

Cardstock

Glossy Cardstock

177–220 g/m²

Envelope Tray Envelopes 75–90 g/m²

Note: If Bond is not listed as an available Paper Type, ensure that the system software is up-to-
date. For details, refer to the System Administrator Guide at www.xerox.com/support/
VLC8000docs.

SSuuppppoorrtteedd SSttaannddaarrdd PPaappeerr SSiizzeess

Tray European Standard Sizes
North American Standard
Sizes

Trays 1 and 2

Trays 3 and 4 of the 2-Tray
Module

A5 (148 x 210 mm, 5.8 x 8.3 in.)

B5 (176 x 250 mm, 6.9 x 9.8 in.)

A4 (210 x 297 mm, 8.3 x 11.7 in.)

B4 (250 x 353 mm, 9.8 x 13.9 in.)

A3 (297 x 420 mm, 11.7 x 16.5 in.)

Statement (140 x 216 mm, 5.5 x
8.5 in.)

Executive (184 x 267 mm, 7.25 x
10.5 in.)

Letter (216 x 279 mm, 8.5 x 11 in.)

US Folio (216 x 330 mm, 8.5 x 13
in.)

Legal (216 x 356 mm, 8.5 x 14 in.)

Tabloid (432 x 279 mm, 17 x 11
in.)

Tray 2

Trays 3 and 4 of the 2-Tray
Module

SRA3 (320 x 450 mm, 12.6 x 17.7
in.)

12 x 18 (305 x 457 mm, 12 x 18
in.)
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Tray European Standard Sizes
North American Standard
Sizes

Trays 3 and 4 of the Tandem Tray
Module

B5 (176 x 250 mm, 6.9 x 9.8 in.)

A4 (210 x 297 mm, 8.3 x 11.7 in.)

Executive (184 x 267 mm, 7.25 x
10.5 in.)

Letter (216 x 279 mm, 8.5 x 11 in.)

Bypass Tray A6 (105 x 148 mm, 4.1 x 5.8 in.)

A5 (148 x 210 mm, 5.8 x 8.3 in.)

A4 (210 x 297 mm, 8.3 x 11.7 in.)

215 x 315 (215 x 315 mm, 8.5 x
12.4 in.)

A3 (297 x 420 mm, 11.7 x 16.5 in.)

SRA3 (320 x 450 mm, 12.6 x 17.7
in.)

B6 (125 x 176 mm, 4.9 x 6.9 in.)

B5 (176 x 250 mm, 6.9 x 9.8 in.)

B4 (250 x 353 mm, 9.8 x 13.9 in.)

Postcard (102 x 152 mm, 4 x 6 in.)

5 x 7 (127 x 178 mm, 5 x 7 in.)

Statement (140 x 216 mm, 5.5 x
8.5 in.)

Executive (184 x 267 mm, 7.25 x
10.5 in.)

8 x 10 (203 x 254 mm, 8 x 10 in.)

Letter (216 x 279 mm, 8.5 x 11 in.)

US Folio (216 x 330 mm, 8.5 x 13
in.)

Legal (216 x 356 mm, 8.5 x 14 in.)

Tabloid (279 x 432 mm, 11 x 17
in.)

12 x 18 (305 x 457 mm, 12 x 18
in.)

DL envelope (110 x 220 mm, 4.33
x 8.66 in.)

C6 envelope (114 x 162 mm, 4.5 x
6.38 in.)

C5 envelope (162 x 229 mm, 6.4 x
9 in.)

C4 envelope (229 x 324 mm, 9 x
12 in.)

Monarch envelope (98 x 190 mm,
3.9 x 7.5 in.)

No. 10 envelope (105 x 241 mm,
4.1 x 9.5 in.)

Tray 6
B5 (176 x 250 mm, 6.9 x 9.8 in.)

A4 (210 x 297 mm, 8.3 x 11.7 in.)

Executive (184 x 267 mm, 7.25 x
10.5 in.)

Letter (216 x 279 mm, 8.5 x 11 in.)

Envelope Tray DL envelope (110 x 220 mm, 4.33
x 8.66 in.)

C6 envelope (114 x 162 mm, 4.5 x
6.38 in.)

C4 envelope (229 x 324 mm, 9 x
12.8 in.)

Monarch envelope (98 x 190 mm,
3.9x7.5 in.)

No. 10 envelope (241 x 105 mm,
4.1 x 9.5 in.)
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SSuuppppoorrtteedd SSttaannddaarrdd PPaappeerr SSiizzeess ffoorr AAuuttoommaattiicc 22--
SSiiddeedd PPrriinnttiinngg

European Standard Sizes North American Standard Sizes

A5 (148 x 210 mm, 5.8 x 8.3 in.)

A4 (210 x 297 mm, 8.3 x 11.7 in.)

215 x 315 (215 x 315 mm, 8.5 x 12.4 in.)

A3 (297 x 420 mm, 11.7 x 16.5 in.)

B5 (176 x 250 mm, 6.9 x 9.8 in.)

B4 (250 x 353 mm, 9.8 x 13.9 in.)

Statement (140 x 216 mm, 5.5 x 8.5 in.)

Executive (184 x 267 mm, 7.25 x 10.5 in.)

8 x 10 (203 x 254 mm, 8 x 10 in.)

Letter (216 x 279 mm, 8.5 x 11 in.)

8.5 x 13 (216 x 330 mm, 8.5 x 13 in.)

Legal (216 x 356 mm, 8.5 x 14 in.)

Ledger (432 x 279 mm, 17 x 11 in.)

Postcard (152 x 229 mm, 6 x 9 in.)

SSuuppppoorrtteedd PPaappeerr TTyyppeess aanndd WWeeiigghhttss ffoorr AAuuttoommaattiicc 22--
SSiiddeedd PPrriinnttiinngg

Trays Paper Types Weights

Trays 1–4 Bond

Hole-Punched

Letterhead

Plain

Pre-Printed

Recycled

Custom

64–105 g/m²

Lightweight Cardstock

Lightweight Glossy Cardstock

106–176 g/m²

Cardstock

Glossy Cardstock

177–220 g/m²

Heavyweight Cardstock

Heavyweight Glossy Cardstock

221–300 g/m²

Tray 6
Bond

Hole-Punched

Letterhead

64–105 g/m²
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Trays Paper Types Weights

Plain

Recycled

Custom

Lightweight Cardstock

Lightweight Glossy Cardstock

106–176 g/m²

Cardstock

Glossy Cardstock

177–220 g/m²

Note: For Heavyweight Cardstock, for weights above 256 g/m², performance is not guaranteed.

SSuuppppoorrtteedd CCuussttoomm PPaappeerr SSiizzeess

Tray Number Paper Sizes

Tray 1 Minimum: 100 x 148 mm (3.9 x 5.8 in.)

Maximum: 297 x 432 mm (11.7 x 17 in.)

Tray 2

Trays 3 and 4 of the 2-Tray Module

Minimum: 100 x 148 mm (3.9 x 5.8 in.)

Maximum: 320 x 457 mm (12.6 x 18 in.)

Trays 3 and 4 of the Tandem Tray Module
Custom paper sizes are not supported

Bypass Tray Minimum: 89 x 98 mm (3.5 x 3.9 in.)

Maximum: 320 x 1320 mm (12.6 x 52 in.)

Tray 6
Custom paper sizes are not supported

Envelope Tray Minimum: 90 x 98 mm (3.5 x 3.9 in.)

Maximum: 241 x 332 mm (9.5 x 13 in.)
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Configuring Tray Settings
The system administrator can set the following paper trays to Fully Adjustable or Dedicated:

• Trays 1 and 2.

• Trays 3 and 4 of the 2-Tray Module.

When a paper tray is set to Fully Adjustable, you can change paper settings each time that you load
the tray. When a paper tray is set to Dedicated, the control panel prompts you to load a specific
paper size, type, and color.

Note: To configure tray settings, log in as the system administrator. For details, refer to the
System Administrator Guide at www.xerox.com/support/VLC8000docs.

To configure the tray settings:

1. At the printer control panel, touch Device.

2. Touch Paper Trays, then select the required tray.
• To set the mode, touch Tray Mode, then select an option.
• To specify the paper settings for a dedicated tray, ensure that Tray Mode is set to Dedicated,

then set the paper size, type, and color.
• To configure the printer to select the tray automatically, touch the Auto Select toggle button.
• To set the priority for each tray, touch the plus icon (+) or the minus icon (-). The printer uses

paper from the Priority 1 tray first. If that tray is empty, the printer uses paper from the
Priority 2 tray.

3. Touch OK.

4. To return to the Home screen, press the Home button.

CCoonnffiigguurriinngg TTrraayyss 33 aanndd 44 ooff tthhee TTaannddeemm TTrraayy
MMoodduullee
Trays 3 and 4 in the Tandem Tray Module are high-capacity paper trays. Configure Trays 3 and 4 to
support the paper in use.

If you are configuring the trays for the first time, configure them for the paper size that you need. If
you change the paper size, reconfigure the tray for the new paper size. For details on supported paper
sizes, refer to Supported Standard Paper Sizes.

To configure Trays 3 and 4 in the Tandem Tray Module:

Note: Before you make any tray adjustments, compare the paper size to the current Tray 3 and
4 configurations. If the paper size matches the tray configuration, no tray adjustment is
needed.

1. Remove any paper from the tray.

2. Pinch the guide lock on the front paper guide, then slide the paper guide to the required paper
size.

3. To lock the paper guides into place, release the guide lock.

Note: The paper guides lock into place only at the designated standard paper sizes.
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CCoonnffiigguurriinngg TTrraayy 66
Tray 6 is a dedicated high-capacity feeder. You can configure Tray 6 to support the paper size that
you use. For details on supported paper sizes, refer to Supported Standard Paper Sizes.

To configure Tray 6:

Note: Before you make any tray adjustments, compare the paper size to the current Tray 6
configuration. If the paper size matches the tray configuration, no tray adjustment is needed.

1. Remove the screw that holds the spacer plate at the back of the tray.

2. To remove the spacer plate, grasp the spacer plate and lift upward.

3. Place the tabs at the bottom of the spacer plate into the slots in the bottom of Tray 6 that
correspond with the paper size.
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4. Slide the top of the spacer plate down to engage the peg on the back of the tray into the
matching hole in the plate.

5. To secure the spacer plate, install the screw.

6. Repeat these steps for the spacer plate at the front of Tray 6.

7. On the top of the side gate, locate the pin.
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8. Lift the pin, then guide it to the required paper-size slot.

9. To lock the side gate into place, release the pin.
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Loading Paper

LLooaaddiinngg PPaappeerr iinn TTrraayyss 11––44
You use the same method to load paper in Trays 1 and 2, and for Trays 3 and 4 when they are part of
the 2-Tray Module. For instructions on how to load paper in Trays 3 and 4 when they are part of the
Tandem Tray Module, refer to Loading Paper in Trays 3 and 4 of the Tandem Tray Module.

The system administrator can set Trays 1–4 to Fully Adjustable mode or Dedicated mode. Each time a
tray is opened and closed, the paper settings appear on the control panel.

• When trays are configured as Fully Adjustable, you can confirm or change the media settings. The
tray guides automatically detect the size of paper that is loaded.

• When trays are configured as Dedicated, the control panel displays the media settings for the
tray. A warning message appears on the control panel when the wrong media is loaded in the
tray, or when the tray guides are set incorrectly.

Note: Only the system administrator can change the media settings for a Dedicated tray. For
details on how to configure tray settings, refer to Configuring Tray Settings.

When the paper in the tray is in short supply, or when a tray is empty, a warning message appears on
the control panel.

To load the paper in Trays 1–4:

1. Pull out the tray until it stops.

2. Remove any paper that is a different size or type.
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3. To move out the length or width paper guides, pinch the guide locks, then slide out the length or
width paper guides.

4. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface.
The procedure separates any sheets that are stuck together and reduces the possibility of jams.

Note: To avoid jams and misfeeds, do not remove the packaging from the paper until you
are ready to use it.

5. Load the paper in the tray. Do one of the following:
• For long-edge feed:

• Insert letterhead and pre-printed paper face down with the top edge toward the front.

• Load hole-punched paper with the holes to the left.

Note: Do not load the paper above the maximum fill line. Overfilling the tray can cause
paper jams.
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• For short-edge feed:

• Insert letterhead and pre-printed paper face down with the top edge to the left.

• Load hole-punched paper with the holes toward the front.

Note: Use short-edge feed for custom-size paper and special media.

6. To adjust the length and width guides to fit the paper, pinch the guide locks, then slide the paper
guides in until they touch the paper.

7. Slide the tray back into the printer.

8. At the control panel, select the correct paper size, type, and color.
• If letterhead paper is loaded in the printer, for type, select Letterhead.
• If pre-printed paper is loaded in the printer, for type, select Pre-printed.

9. To confirm the settings, touch OK.
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Note: To change the paper settings when the tray is set to Dedicated mode, refer to
Configuring Tray Settings.

LLooaaddiinngg PPaappeerr iinn TTrraayyss 33 aanndd 44 ooff tthhee TTaannddeemm TTrraayy
MMoodduullee
The control panel displays a warning message when the paper in the tray is in short supply, or when a
tray is empty.

To change the paper size in Trays 3 and 4, refer to Configuring Trays 3 and 4 of the Tandem Tray
Module.

To load the paper in Trays 3 and 4 of the Tandem Tray Module:

1. Pull out the tray until it stops. Wait for the tray to lower and stop.

2. Fan the edges of the paper before you load it into the paper trays. The procedure separates any
sheets of paper that are stuck together and reduces the possibility of paper jams.

Note: To avoid paper jams and misfeeds, do not remove the packaging from the paper
until you are ready to use it.
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3. Stack the paper against the left-rear corner of the tray.
• Insert letterhead and pre-printed paper face down with the top edge toward the front of the

tray.
• Load hole-punched paper with the holes to the left.

Note: Do not load the paper above the maximum fill line. Overfilling the tray can cause
paper jams.

4. Slide the tray back into the printer.

5. At the control panel, select the correct paper type and color.
• If letterhead paper is loaded in the printer, for type, select Letterhead.
• If pre-printed paper is loaded in the printer, for type, select Pre-printed.

6. To confirm the settings, touch OK.
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LLooaaddiinngg PPaappeerr iinn tthhee BByyppaassss TTrraayy
The Bypass Tray supports the widest variety of media types. The tray is intended primarily for small-
quantity jobs that use special media.

To load paper in the Bypass Tray:

1. Open the Bypass Tray. If the tray is loaded with paper, remove any paper that is a different size
or type.

2. Pull out the extension tray for larger sizes.

3. Move the width guides to the edges of the tray.
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4. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface.
The procedure separates any sheets that are stuck together and reduces the possibility of jams.

Note: To avoid jams and misfeeds, do not remove the packaging from the paper until you
are ready to use it.

5. Load the paper in the tray.
• For long-edge feed and 1-sided printing:

• Load letterhead paper face up with the top edge toward the front.

• Load hole-punched paper with the holes to the right.
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• Load pre-printed paper face down with the top edge toward the front.

• For long-edge feed and 2-sided printing:

• Load letterhead or pre-printed paper face up with the top edge toward the front.

• Load hole-punched paper with the holes to the left.

• For short-edge feed and 1-sided printing:

• Load letterhead paper face up with the top edge to the right.

• Load hole-punched paper with the holes toward the front.
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• Load pre-printed paper face down with the top edge to the right.

• For short-edge feed and 2-sided printing:

• Load letterhead or pre-printed paper face up with the top edge to the right.

• Load hole-punched paper with the holes toward the front.

Note: Do not load paper above the maximum fill line on the width guides. Overfilling the
tray can cause the printer to jam.

6. Adjust the width guides until they touch the edges of the paper.

7. At the control panel, select the correct paper size, type, and color.
• If letterhead paper is loaded in the printer, for type, select Letterhead.
• If pre-printed paper is loaded in the printer, for type, select Pre-printed.

8. To confirm the settings, touch OK.
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LLooaaddiinngg PPaappeerr iinn TTrraayy 66
The control panel displays a warning message when the paper in the tray is in short supply, or when
the tray is empty.

To change the paper size in Tray 6, refer to Configuring Tray 6.

To load paper in Tray 6:

1. At the high-capacity feeder, pull out Tray 6 until it stops. Open the side gate until it stops.

2. Wait for the tray to lower and stop.

3. The control panel displays the paper tray settings. Ensure that you load the correct paper type
into the tray.

Note: Do not load custom-size paper into Tray 6.

4. Fan the edges of the paper before loading it into the paper trays. The procedure separates any
sheets of paper that are stuck together and reduces the possibility of paper jams.

Note: To avoid paper jams and misfeeds, do not remove paper from the packaging until
necessary.
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5. Load the paper against the right side of the tray.
• Place letterhead or pre-printed paper face up with the top edge toward the front of the tray.
• Place hole-punched paper with the holes toward the left side of the tray.

Note: Do not load paper above the maximum fill line. Overfilling can cause paper jams.

6. Close the side gate, then close Tray 6.

7. At the control panel, select the correct type, and color.
• If letterhead paper is loaded in the printer, for type, select Letterhead.
• If pre-printed paper is loaded in the printer, for type, select Pre-printed.

8. To confirm the settings, touch OK.
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Printing on Special Paper
To order paper or other media, contact your local reseller or visit www.xerox.com/supplies.

For reference:

• www.xerox.com/rmlna Recommended Media List (United States)

• www.xerox.com/rmleu Recommended Media List (Europe)

EEnnvveellooppeess
You can print envelopes from the Bypass Tray. When the optional Envelope Tray is installed, you can
print envelopes from the Envelope Tray.

GGuuiiddeelliinneess ffoorr PPrriinnttiinngg EEnnvveellooppeess
• Use only paper envelopes.

• Do not use envelopes with windows or metal clasps.

• Print quality depends on the quality and construction of the envelopes. If you do not get the de-
sired results, try another envelope brand.

• Maintain constant temperatures and relative humidity.

• Store unused envelopes in their packaging to avoid excess moisture and dryness which can affect
print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or dur-
ing printing.

• Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book
on top of the envelopes.

• In the print driver software, select Envelope as the paper type.

• Do not use padded envelopes. Use envelopes that lie flat on a surface.

• Do not use envelopes with heat-activated glue.

• Do not use envelopes with press-and-seal flaps.
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LLooaaddiinngg EEnnvveellooppeess iinn tthhee BByyppaassss TTrraayy
The Bypass Tray holds the following standard envelope sizes:

• C4, C5, C6, and DL

• Monarch and No.10

To load envelopes in the Bypass Tray:

1. Open the Bypass Tray.

2. Move the width guides to the edges of the tray.

Note: If you do not load envelopes in the Bypass Tray right after they are removed from
the packaging, they can bulge. To avoid jams, flatten the envelopes.
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3. Load envelopes in the tray.
• For envelopes with the flap on a long edge, load envelopes face down with the flaps closed,

and flaps toward the right.

• For envelopes with a self-seal flap on a short edge, load envelopes face down with the flaps
closed, and flaps toward the right.

• For envelopes with a non-adhesive flap on a short edge, load envelopes face down with the
flaps open, and flaps toward the left.

Note: For envelopes to print correctly, when you load envelopes with the flaps open, in the
print driver, set the orientation as needed. To flip the images, in the print driver, select
Rotate Image 180 Degrees.

4. At the control panel, select the correct paper size, type, and color. Ensure that the paper type is
set to Envelope.

5. To confirm the settings, touch Confirm.
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LLooaaddiinngg tthhee EEnnvveellooppee TTrraayy
You can use the optional Envelope Tray in place of Tray 1. The Envelope Tray is a dedicated tray and
holds the following standard envelope sizes:

• C4, C6, and DL

• Monarch and No.10

To load the Envelope Tray:

1. Pull out the Envelope Tray until it stops.

2. Load the envelopes in the tray.
• For envelopes with the flap on a long edge, load the envelopes face up with the flaps closed,

and flaps toward the left.

• For envelopes with a self-seal flap on a short edge, load the envelopes face up with the flaps
closed, and flaps toward the left.
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• For envelopes with a non-adhesive flap on a short edge, load the envelopes face up with the
flaps open, and flaps toward the right.

Note: Adjust the paper guides so that they rest lightly against the edges of the envelopes.
Ensure that the maximum fill line is visible or that there are no more than 50 envelopes
loaded in the tray.

3. Close the tray.

4. At the control panel, select the correct paper size, type, and color. Ensure that the paper type is
set to Envelope.

5. To confirm the settings, touch Confirm.

LLaabbeellss
You can print labels from any tray.

GGuuiiddeelliinneess ffoorr PPrriinnttiinngg LLaabbeellss
• Use labels designed for laser printing.

• Do not use vinyl labels.

• Do not feed a sheet of labels through the printer more than once.

• Do not use dry gum labels.

• Print only on one side of the sheet of labels. Use full-sheet labels only.

• Store unused labels flat in their original packaging. Leave the label sheets inside the original pack-
aging until ready to use. Return any unused label sheets to the original packaging and reseal it.
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• Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Stor-
ing labels in extreme conditions can cause print-quality problems or cause labels to jam in the
printer.

• Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and
jam in the printer.

• In the print driver software, select Label as the paper type.

• Before loading labels, remove all other paper from the tray.

WARNING:

Do not use any sheet where labels are missing, curled, or pulled away from the backing sheet. It could
damage the printer.

LLooaaddiinngg LLaabbeellss iinn TTrraayyss 11--44
Note: To load labels in Trays 3 and 4 of the Tandem Tray Module, refer to Loading Labels in
Trays 3 and 4 of the Tandem Tray Module.

1. Pull out the tray until it stops.

2. Ensure that the paper guides are set in the correct position for the size labels you are loading.

3. Remove any paper that is a different size or type.

4. To move out the length or width paper guide, release the guide lock, then slide out the length or
width paper guide.

5. Load labels in the tray.
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• For long-edge feed, insert labels face up with the top edge toward the back.

• For short-edge feed, insert labels face up with the top edge to the left.

Note: Do not load paper above the maximum fill line. Overfilling the tray can cause
paper jams.

6. Adjust the length and width guides to fit the labels.
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7. Slide the tray back into the printer.

8. At the control panel, select the correct paper size, type, and color. Ensure that the paper type is
set to Labels.

Note: To change the paper settings when the tray is set to Dedicated mode, refer to
Configuring Tray Settings.

9. To confirm the settings, touch OK.

10. To return to the Home screen, press the Home button.

LLooaaddiinngg LLaabbeellss iinn TTrraayyss 33 aanndd 44 ooff tthhee TTaannddeemm TTrraayy MMoodduullee
1. Pull out Tray 3 or Tray 4 until it stops. Wait for the tray to lower and stop.

Note: Ensure that labels are the correct size for the tray. Do not load custom-size paper
into Trays 3 or 4. To change the paper size in Trays 3 and 4, refer to Configuring Trays 3
and 4 of the Tandem Tray Module.

2. To load labels in the tray, insert labels face up with the top edge toward the back. Stack the labels
against the left-rear corner of the tray as shown.

3. Slide the tray back into the printer.

4. At the control panel, select the correct paper type and color. Ensure that the paper type is set to
Labels.

5. To confirm the settings, touch OK.

6. To return to the Home screen, press the Home button.
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LLooaaddiinngg LLaabbeellss iinn tthhee BByyppaassss TTrraayy
1. Open the Bypass Tray, then for larger sizes of paper, pull out the extension tray. Remove any

paper that is a different size or type.

2. Move the width guides to the edges of the tray.

3. Load labels in the tray.
• For long-edge feed, load labels face down with the top edge toward the back of the printer.

• For short-edge feed, load labels face down with the top edge to the right.

Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the
printer to jam.
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4. Adjust the width guides until they touch the edges of the paper.

5. At the control panel, select the correct paper size, type, and color. Ensure that the paper type is
set to Labels.

6. To confirm the settings, touch OK.

7. To return to the Home screen, press the Home button.

BBaannnneerr PPaappeerr
You can print banner paper from the Bypass Tray.

LLooaaddiinngg BBaannnneerr PPaappeerr iinn tthhee BByyppaassss TTrraayy
1. Open the Bypass Tray, then pull out the extension tray. Remove any paper that is a different size

or type.

2. Move the width guides to the edges of the tray.
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3. Load banner paper in the tray. Load paper with the short edge leading into the printer.

4. Adjust the width guides until they touch the edges of the paper.

5. At the control panel, select the correct paper size, type, and color.

a. To define the paper size, touch Size, then touch Custom. In the Custom Paper Size window,
enter the width and length of the banner paper, then touch OK.

b. To define the paper type, touch Type, then select the correct paper type.

c. To define the paper color, touch Color, then select the correct paper color.

6. To confirm the settings, touch OK.

7. To return to the Home screen, press the Home button.

Note: As the paper feeds into the printer, support the paper with your hands. To prevent
paper jams, feed one sheet of paper at a time.
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General Precautions
WARNING:

• Internal parts of the printer can be hot. Use caution when doors and covers are open.

• Keep all cleaning materials out of the reach of children.

• Do not use pressurized spray cleaning aids on or in the printer. Some pressurized sprays
contain explosive mixtures and are not suitable for use in electrical applications. Use of
pressurized spray cleaners increases the risk of fire and explosion.

• Do not remove the covers or guards that are fastened with screws. You cannot maintain or
service any parts that are behind these covers and guards. Do not attempt any
maintenance procedure that is not described in the documentation supplied with your
printer.

Caution:

• When cleaning your printer do not use organic or strong chemical solvents or aerosol
cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials only
as directed in this documentation.

• Do not place anything on top of the printer.

• Do not leave the covers and doors open for any length of time, especially in well-lighted
places. Light exposure can damage the drum cartridges.

• Do not open covers and doors during printing.

• Do not tilt the printer while it is in use.

• Do not touch the electrical contacts or gears. Doing so could damage the printer and cause
the print quality to deteriorate.

• Ensure that any parts removed during cleaning are replaced before you plug in the printer.
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Cleaning the Printer

CClleeaanniinngg tthhee EExxtteerriioorr
Clean the exterior of the printer once a month.

• Wipe the paper tray, output tray, control panel, and other parts with a damp, soft cloth.

• After cleaning, wipe with a dry, soft cloth.

• For stubborn stains, apply a small amount of mild detergent to the cloth and gently wipe the stain
off.

Caution: Do not spray detergent directly on the printer. Liquid detergent could enter the printer
through a gap and cause problems. Never use cleaning agents other than water or mild
detergent.

CClleeaanniinngg tthhee IInntteerriioorr
Clean the interior of the printer regularly to prevent stains inside the printer that can deteriorate print
quality. Clean the printer interior whenever you replace a drum cartridge.

After clearing paper jams or replacing a toner cartridge, inspect inside the printer before closing the
printer covers and doors.

• Remove any remaining pieces of paper or debris. For details, refer to Clearing Paper Jams.

• Remove any dust or stains with a clean, dry, lint-free cloth.

WARNING: Never touch a caution-labeled area in the fuser. You can get burned. If a sheet of
paper is wrapped around the inside of the fuser, do not try to remove it immediately. Power off
the printer immediately and wait 40 minutes for the fuser to cool. Try to remove the paper jam
after the printer has cooled. If the error persists, contact your Xerox representative.
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CClleeaanniinngg tthhee PPrriinntthheeaadd LLeennsseess
The printer is constructed with four printhead lenses. The printhead lenses require regular cleaning to
maintain print quality. Clean the printhead lens every time the associated drum cartridge is replaced,
or if print quality starts to degrade. For example, if prints have voids or light streaks through one or
more colors, use the following instructions to clean the LED lenses.

WARNING: If you accidentally get toner on your clothes, lightly dust them off as best as you
can. If some toner remains on your clothes, use cool water, not hot, to rinse off the toner. If
toner gets on your skin, wash it off with cool water and a mild soap. If you get toner in your
eyes, wash it out immediately with cool water and consult a doctor.

Caution: Do not perform this procedure when the printer is copying or printing.

1. Open the front door of the printer.

2. Remove the waste toner transport unit:

a. To unlock the waste toner transport unit, rotate the locking lever 45 degrees
counterclockwise.
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b. To release the waste toner transport unit, press both orange tabs as shown, then pull out the
unit from the printer.

c. Place the removed waste toner transport unit on a level surface, with the openings facing up.

Caution: To avoid toner spills, do not lay the waste toner transport unit face down, or
on its side.

Xerox® VersaLink® C8000/C9000 Color Printer
User Guide

143

Maintenance



3. Remove the printhead LED lens-cleaning rod from inside the front door.

4. Slowly push the cleaning rod into the printer until it stops, then pull out the rod. Repeat this
action two more times.

5. Return the cleaning rod to its original location.

6. To insert the waste toner transport unit:
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a. Position the waste toner transport unit as shown.

b. Press the waste toner transport unit toward the printer, until both ends click into place.
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c. To lock the waste toner transport unit, rotate the locking lever 45 degrees clockwise.

7. Close the printer front door.
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Adjustments and Maintenance Procedures

CCoolloorr CCaalliibbrraattiioonn
Use Color Calibration to maintain consistent colors. You can adjust the color density, gray balance, or
both. For the best results, adjust the color density, then adjust the gray balance.

At the start of each color calibration procedure, three pages are printed.

1. An instruction sheet explaining the calibration and evaluation procedures that are used for both
color density calibration pages, and the gray balance calibration pages.

2. An initial Color Reference Page with color density patches, ranging from 5 percent to 100 percent.
Mark this initial page to identify it from the final Color Reference Page, which is printed
automatically at the completion of your adjustments. Comparing the initial print with the final
print allows you to compare visually the results of your adjustments.

3. A calibration page that changes, based on the adjustment procedure. The calibration page is your
primary tool for evaluating when an adjustment is required. To allow you to repeat an adjustment
until the calibration is complete, this page reprints each time you make an adjustment. All colors
on a calibration page reflect the previous adjustments. An adjustment is complete when the
center, or zero, position shows the best available color setting.

CCoolloorr DDeennssiittyy CCaalliibbrraattiioonn
Adjusting color density allows you to calibrate the density and balance of the four primary colors of
cyan, magenta, yellow, and black. The density settings adjust the printed output, based on the level
of color saturation. If you select the minus settings, the color density decreases and the output light-
ens. If you select the plus settings, the color density increases and the output darkens. Examples of
low density areas include faces and sky.

The third page printed at the start of your color density
adjustment is the Cyan/Magenta Calibration Page. This
page contains a range of density settings available for cy-
an and magenta. The current density setting for each of
the light, medium, and dark rows are numbered zero. The
available settings are printed in a comb pattern, against
a background representing the desired density setting. If
the best match is between two combs, select a value be-
tween the two printed combs.

Starting a Color Density Calibration
To begin your calibration and print the calibration pages:

1. At the printer control panel, press the Home button.

2. Log in as administrator. For details, refer to the System Administrator Guide at www.xerox.com/
support/VLC8000docs or www.xerox.com/support/VLC9000docs.

3. Touch Device→Support→Color Calibration.
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4. To select the type of lighting you use for viewing calibration pages, touch Lighting Type, then
touch a selection.

5. To select the Color Density adjustment, touch Color Density Only.

6. To begin your calibration and print the calibration pages, touch Next.

7. To run the calibration procedure, follow the onscreen instructions, or refer to Performing a Color
Density Calibration.

Performing a Color Density Calibration
To perform a Color Density Calibration:

1. To evaluate the current calibration for cyan and magenta density, hold the Cyan/Magenta
Calibration page at an arm length away.

Note: To obtain accurate adjustments, ensure that your environment lighting matches the
Lighting Type selected in Starting a Color Density Calibration.

2. To determine the best match, evaluate the comb pattern in the dark cyan and magenta rows,
labeled A. Mark the section where the bottom comb most closely blends into the background
color. If the best match is between two combs, write down a number value between the two
printed comb values. A close match for the zero comb means that the row is calibrated.

3. If the best comb for any row is a value other than zero, an adjustment is required. On the touch
screen, touch Edit, then for that color, touch A, then move the slider to the value you want.When
finished, to save the values and print a revised calibration page, touch OK.

4. Repeat the process by marking the best match for the medium and light rows, labeled B, and C.

5. Using the updated calibration page, repeat the process until the best comb for every cyan and
magenta row is zero. To continue to the green and black color density adjustments, touch Next.
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6. Hold the green and black calibration page at an arm length away and follow the previous
adjustment procedure, but for green and black.

7. When the best match for every green and black row is zero, touch Next.

8. To complete your calibration, follow the onscreen instructions, or refer to Evaluate and Save Your
Color Density Calibration.

Evaluate and Save Your Color Density Calibration
To evaluate your calibration and save your settings:

1. To see the results of your adjustments, compare your initial and final Color Reference Pages.

2. To save the adjustments, touch Save and Exit. Otherwise, touch Exit Without Saving.

3. To return to the Support menu, touch the back arrow.

4. To return to the Home screen, press the Home button.

GGrraayy BBaallaannccee CCaalliibbrraattiioonn
Adjusting gray balance calibrates cyan, magenta, and yellow color balances so that they closely
match pure black at the same color intensity.
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The third page printed at the start of a gray balance cali-
bration, is the Light Gray Calibration Page. This page uses
circles, or hexagons, of color to demonstrate the available
gray balance settings. The current gray balance setting is
the circle in the center, numbered zero. Each available set-
ting is printed against a background representing the de-
sired gray balance setting. To demonstrate the available
lightness/darkness calibration settings, the row at the bot-
tom of the page contains comb patterns. The comb pat-
tern labeled zero is the current setting. Together, the gray
balance circles and lightness/darkness combs allow for an
accurate gray balance setting.

Starting a Gray Balance Adjustment
To begin your calibration and print the calibration pages:

1. At the printer control panel, press the Home button.

2. Log in as administrator. For details, refer to the System Administrator Guide at www.xerox.com/
support/VLC8000docs or www.xerox.com/support/VLC9000docs.

3. Touch Device→Support→Color Calibration.

4. To select the type of lighting you use to view calibration pages, touch Lighting Type, then touch
a selection.

5. To select the Gray Balance adjustment, touch Gray Balance Only.

6. To begin your calibration and print the calibration pages, touch Next.

7. To run the calibration procedure, follow the onscreen instructions, or refer to Performing a Gray
Balance Calibration.

Performing a Gray Balance Calibration
To perform a Gray Balance Adjustment:

1. To evaluate the gray balance settings, hold the light-gray calibration page at an arm length
away.

2. To determine the best light-gray balance match, evaluate the circles. Mark the circle that appears
to be the most neutral gray. The center circle, zero, is the current gray-balance setting.
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3. To determine the best lightness/darkness match, evaluate the comb patterns in row C. Mark the
section where the comb most closely blends into the background color. If the best match is
between two combs, write down a number value between the two printed comb values. A close
match for the zero comb means that the lightness/darkness is calibrated.

4. If the best color match for a circle or a comb is a value other than zero, an adjustment is required.
On the touch screen, touch Edit.

5. To adjust the circle setting, touch Light Hexagon Number. Use the keypad to enter the number
for the best circle, then touch OK.

6. To adjust the lightness/darkness setting, touch Light Bar Number, then move the slider to the
value you want.

7. When finished, to save the values and print a revised calibration page, touch OK.

8. Using the updated light calibration page, repeat the process until the best choices for both
sections are zero.

9. When the best match for both sections is zero, to continue on to the next color adjustment, touch
Next.

10. Repeat this process for the medium and dark calibration pages.

11. To exit the adjustment procedures, touch Next.

12. To complete your calibration, follow the onscreen instructions, or refer to Evaluate and Save Your
Gray Balance Calibration.

Evaluate and Save Your Gray Balance Calibration
To evaluate your calibration and save your settings:

1. To see the results of your adjustments, compare your initial and final Color Reference Pages.

2. To save the adjustments, touch Save and Exit. Otherwise, touch Exit Without Saving.

3. To return to the Support menu, touch the back arrow.

4. To return to the Home screen, press the Home button.

CCoolloorr RReeggiissttrraattiioonn
The printer automatically adjusts the color registration when automatic adjustment is turned on. You
can also adjust color registration manually any time the printer is idle. You must adjust the color
registration any time the printer is moved. If you are having printing problems, adjust the color
registration.
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PPeerrffoorrmmiinngg aa CCoolloorr RReeggiissttrraattiioonn AAddjjuussttmmeenntt
A color-registration adjustment occurs every time a new toner cartridge is installed. You can run this
adjustment at other times as needed.

To perform a color-registration adjustment:

1. At the printer control panel, press the Home button.

2. Touch Device→Support→Color Registration.

3. To perform an Automatic Color Registration adjustment, touch Start.

4. At the successfully completed prompt, touch Close.

5. To exit the menu, touch X.

6. To return to the Home screen, press the Home button.

AAddjjuussttiinngg PPaappeerr RReeggiissttrraattiioonn
Use Image Position to adjust the placement of the printed image on the page. The adjustment
allows you to place the top, bottom, left, and right margins exactly where you want. You can specify
the image position on both the front and back sides of the paper, for each installed paper tray.

VVeerriiffyyiinngg PPaappeerr RReeggiissttrraattiioonn
1. At the printer control panel, press the Home button.

2. Log in as administrator. For details, refer to the System Administrator Guide at www.xerox.com/
support/VLC8000docs or www.xerox.com/support/VLC9000docs.

3. Touch Device→Support→Image Position.

4. Select the source paper tray for the registration print.

a. Touch Paper Supply.

b. Touch the tray that you want to use.

5. If your printer has automatic 2-sided printing, select the sides that you want to optimize.

• To select a sample registration page for adjusting side 1, touch Side to Adjust, then touch
Side 1.

• To select a sample registration page for adjusting both sides, touch Side to Adjust, then touch
Side 2.

6. Specify the consecutive number of sample pages to print.

a. Touch Print Settings.

b. To increase or decrease the number of sample pages, for Quantity, touch the Plus icon (+) or the
Minus icon (-), then touch OK.

7. To print the sample pages, touch Print Sample.

8. When printing is completed, touch Close.
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9. On the sample pages, for Side 1, use a ruler to measure the distance of the printed image from
the top, bottom, left, and right edges.

Note: For identification, a dot is printed on the bottom of the page. A single dot is
printed on Side 1, and two dots are printed on Side 2.

10. For Side 2, measure the distance of the printed image from the top, bottom, left, and right edges.

11. If the image is centered, no adjustment is required. If the image is not centered, adjust the paper
registration. For more information, refer to Performing a Paper Registration Adjustment.

PPeerrffoorrmmiinngg aa PPaappeerr RReeggiissttrraattiioonn AAddjjuussttmmeenntt
1. At the printer control panel, press the Home button.

2. Log in as administrator. For details, refer to the System Administrator Guide at www.xerox.com/
support/VLC8000docs or www.xerox.com/support/VLC9000docs.

3. Touch Device→Support→Image Position.

4. To adjust registration, select the source paper tray.

a. Touch Paper Supply.

b. Touch the desired tray.

5. Use the chart that you printed in Verifying Paper Registration, then select the side for registration.

• To adjust Side 1, touch Adjusted Side, then touch Side 1.

• To adjust Side 2, touch Adjusted Side, then touch Side 2.

6. To adjust the registration, touch Lead/Side Registration.

• To adjust the side-to-side registration, for Side Registration, touch the Plus icon (+) or the Minus
icon (-).

• To adjust the top-to-bottom registration, for Lead Registration, touch the Plus icon (+) or the
Minus icon (-).For reference, position the chart so that Side-1 or Side-2 dots are at the bottom
of the page.

– For Lead Registration, a positive value shifts the image down the page.

– For Side Registration, a positive value shifts the image to the left.

7. To save your settings, touch OK→Adjust.

8. As needed, to enter more values, repeat the previous steps.

9. Print another sample page, then repeat the process until you complete the registration
corrections.

10. To return to the Home screen, press the Home button.
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TTrraannssffeerr VVoollttaaggee AAddjjuussttmmeenntt
Use Transfer Voltage Adjustment to specify the bias transfer roller voltage for printing on the selected
paper type. If the printed image is too light, increase the voltage for the paper that you are using. If
the printed image is mottled or blotchy-looking, decrease the voltage for the paper that you are
using.

To adjust the transfer voltage:

1. At the printer control panel, press the Home button.

2. Log in as administrator. For details, refer to the System Administrator Guide at www.xerox.com/
support/VLC8000docs or www.xerox.com/support/VLC9000docs.

3. Load paper in the Bypass Tray.

4. Touch Device→Support→Transfer Voltage Adjustment.

5. To select the paper type for the adjustment, touch Paper Type, then touch the paper type.

6. To specify the paper size and 1-sided or 2-sided, touch Print Settings.

a. To specify the paper size, touch Paper Size, then touch the paper size.

b. To select 1-sided or 2-sided for the adjustment, touch 2-Sided, then touch the needed
selection.

c. To save the settings, touch OK.

7. To adjust the transfer voltage, touch Print Sample. At the successfully completed prompt, touch
Close.

8. To evaluate and adjust the transfer voltage, as needed, follow the instructions on the Calibrate for
Paper page.

a. To determine the numbered row with the best print quality, evaluate the density on the
printed pages.

b. Compare the best print-quality row available to the current setting number. The current
setting number is highlighted in red on the Calibrate for Paper page.

c. If the number for the current setting matches the best print-quality number, no adjustment is
required.

d. To adjust the transfer voltage, for Side 1 or Side 2, touch the Plus (+) icon or the Minus (-)
icon.

e. To accept the settings, touch OK.

9. To return to the Device screen, press the back arrow.

10. To return to the Home screen, press the Home button.
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Supplies

CCoonnssuummaabblleess
Consumables are printer supplies that become depleted during the operation of the printer.
Consumable supplies for this printer include Genuine Xerox® Toner Cartridges in Cyan, Magenta,
Yellow, and Black.

Note:

• Each consumable includes installation instructions. To replace consumables, refer to the
instructions included with the consumable supply.

• Only install new cartridges in your printer. If you install a used toner cartridge, the toner
remaining amount displayed can be inaccurate.

• To ensure print quality, the toner cartridge stops functioning at a predetermined point.

Caution: Use of toner other than genuine Xerox® Toner can affect print quality and printer
reliability. Xerox® Toner is the only toner designed and manufactured under strict quality
controls by Xerox for specific use with this printer.

RRoouuttiinnee MMaaiinntteennaannccee IItteemmss
Routine maintenance items are printer parts that have a limited life and require periodic replacement.
Replacements can be parts or kits. Routine maintenance items are typically customer replaceable.

Note: Each routine maintenance item includes installation instructions.

Routine maintenance items for this printer include the following:

• Cyan, Magenta, Yellow, and Black Drum Cartridges

• Waste Cartridge

• Hole-Punch Waste Container

• Staple Cartridge

• Booklet Staple Cartridge

• Feed Rollers

RReeppllaacciinngg tthhee DDrruumm CCaarrttrriiddggee
WARNING: Never throw drum cartridges into an open flame.

Caution: Do not expose the drum cartridge to direct sunlight or strong indoor fluorescent light-
ing. Do not touch or scratch the surface of the drum.

When a drum cartridge requires replacement, a message appears on the control panel.

Note: Each drum cartridge includes installation instructions.
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RReeppllaacciinngg tthhee WWaassttee CCaarrttrriiddggee
When a waste cartridge is almost full, a reorder message appears on the control panel. When the
waste cartridge is full, the printer stops printing, and a replace message appears on the control panel.

Caution: To avoid toner spills, do not lay the waste cartridge face down, or on its side.

Note: Each new waste cartridge includes installation instructions.
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RReeppllaacciinngg SSttaapplleess iinn tthhee OOffffiiccee FFiinniisshheerr LLXX

Replacing Staples in the Main Stapler of the Office Finisher LX

Caution: Do not perform this procedure when the printer is copying or printing.

1. Open the finisher front door.

2. Reach into the finisher cabinet and pull the stapler assembly toward you until it stops.

3. Push the stapler assembly to the right as shown.
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4. To remove the staple cartridge, grasp the orange handle, then pull it firmly toward you.

5. Pinch both sides of the staple pack and remove the staple pack from the cartridge.

6. Insert the front side of the new staple pack into the staple cartridge, then push the rear side of
the new staple pack into the cartridge.
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7. Grasp the new staple cartridge by the orange handle, then insert the cartridge into the stapler
assembly until you hear a click.

8. Close the finisher front door.
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Replacing Staples in the Booklet Maker of the Office Finisher LX

WARNING: Do not perform this procedure while the printer is printing.

1. Open the finisher side cover.

2. If the staple cartridges are not visible, grip the vertical panels at the left and right of the opening
and slide them to the center.

3. Hold the tabs on both sides of the staple cartridge and pull the cartridge out of the finisher.
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4. Hold the tabs on both sides of the new staple cartridge and insert it into the original position in
the finisher.

Note: If you have trouble inserting the cartridge, ensure that the staples are positioned
correctly in the cartridge.

Note: The booklet maker uses two staple cartridges. Booklet stapling requires that both
staple cartridges contain staples.

5. Repeat the procedure for the other staple cartridge.

6. Close the finisher side cover.
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RReeppllaacciinngg SSttaapplleess iinn tthhee BBuussiinneessss RReeaaddyy FFiinniisshheerr

Replacing Staples in the Main Stapler of the Business Ready Finisher

Caution: Do not perform this procedure when the printer is copying or printing.

1. Open the front door of the Business Ready Finisher.

2. Hold the stapler assembly by the orange lever R1 and push it to the right.

3. To remove the staple cartridge, grasp the orange handle, then firmly pull it toward you.
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4. Pinch both sides of the staple pack and remove the staple pack from the cartridge.

5. Insert the front side of the new staple pack into the staple cartridge, then push the rear side of
the staple pack into the cartridge.

6. Grasp the new staple cartridge by the orange handle, then insert the cartridge into the stapler
assembly until you hear a click.

7. Return the staple cartridge assembly to the original position.
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Replacing Staples in the Booklet Maker of the Business Ready Finisher

Caution: Do not perform this procedure when the printer is copying or printing.

1. Open the front door of the Business Ready Finisher.

2. Grasp the booklet maker handle and pull the unit toward you until the staple cartridges appear
on the top edge of the unit.

3. To unlock a staple cartridge from the booklet maker, push down on the orange staple cartridge
handle, as shown.
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4. To remove a staple cartridge from the booklet maker, pull the staple cartridge out and up.

5. Turn over the staple cartridge.

6. To permit the staple cartridge handle to open out and away from the staple pack, press in the
green tabs, then pull back the handle.
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7. To remove the staple pack, press the rear of the cartridge, then lift out the staple pack as shown.

8. Insert the front side of the new staple pack into the staple cartridge, then push the rear side into
the cartridge.

9. To close the staple cartridge, push back the cartridge handle until it clicks.
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10. To return the staple cartridge to the booklet maker, insert the staple cartridge and push up on the
cartridge handle as shown.

11. Return the booklet maker to its original position, then close the finisher door.

EEmmppttyyiinngg tthhee HHoollee PPuunncchh WWaassttee CCoonnttaaiinneerr
A message appears on the control panel when the hole punch waste container is full.
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Emptying the Hole Punch Waste Container in the Office Finisher LX

Caution: Do not perform this procedure when the printer is copying or printing.

1. Open the front door of the printer.

2. Lift the horizontal transport cover, then open the front transport cover.

3. Pull out the hole-punch waste container.
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4. Empty the container.

5. Insert the container all the way into the finisher.

6. Close the finisher front transport cover, then close the horizontal transport cover.

7. Close the printer front door.
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Emptying the Hole Punch Waste Container in the Business Ready Finisher

Caution: Do not perform this procedure when the printer is copying or printing.

1. Open the front door of the Business Ready Finisher.

2. Remove the hole-punch waste container, labeled R4, from its slot near the top left of the finisher.

Note:

• When you remove the hole-punch waste container, wait 10 seconds before you reinsert
it into the printer. The hole-punch counter resets after 10 seconds.

• If you remove the hole-punch waste container before the device instructs you to, empty
the container before you reinsert it into the finisher.

3. Empty the container.
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4. Insert the container all the way into the finisher.

5. Close the front door of the Business Ready Finisher.

OOrrddeerriinngg SSuupppplliieess

WWhheenn ttoo OOrrddeerr SSuupppplliieess
A warning appears on the control panel when supplies near their replacement time. Verify that you
have replacements on hand. Order these items when the messages first appear to avoid interruptions
to your printing. When it is time to replace a supply item, an error message appears on the control
panel.

Order supplies from your local reseller or go to www.xerox.com/supplies.

Caution: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agree-
ment, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of
performance caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for
this printer. The Total Satisfaction Guarantee is available in the United States and Canada. Cov-
erage could vary outside these areas. Contact your Xerox representative for details.

SSuuppppllyy SSttaattuuss IInnffoorrmmaattiioonn
You can check the supplies status, customize the alerts that appear on the control panel, and config-
ure email alert notifications. For more information, refer to the Supply Status.

SSuupppplliieess UUssaaggee RReeppoorrtt
The Supplies Usage Report provides coverage information and part numbers for reordering supplies.
The date a supply item was installed appears on the report.

To print the Supplies Usage Report:

1. At the printer control panel, press the Home button.

2. Touch Device→About→Information Pages.

3. Touch Supplies Usage Report.

4. To return to the Home screen, press the Home button.
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TToonneerr CCaarrttrriiddggeess

GGeenneerraall PPrreeccaauuttiioonnss
WARNING:

• When replacing a toner cartridge, be careful not to spill the toner. If any toner spills, avoid
contact with clothes, skin, eyes, and mouth. Do not inhale the toner dust.

• Keep toner cartridges out of the reach of children. If a child accidentally swallows toner,
have the child spit out the toner, and rinse the mouth with water. Consult a physician
immediately.

• Use a damp cloth to wipe off spilled toner. Never use a vacuum cleaner to remove spills.
Electric sparks inside the vacuum cleaner can cause a fire or explosion. If you spill a large
volume of toner, contact your local Xerox representative.

• Never throw a toner cartridge into an open flame. Remaining toner in the cartridge can
catch fire and cause burn injuries or an explosion.

RReeppllaacciinngg aa TToonneerr CCaarrttrriiddggee
A message appears on the control panel when a toner cartridge must be replaced.

Note: Each toner cartridge includes installation instructions.

Printer Status Message Cause and Solution

Reorder Toner The toner cartridge is low. Order a new toner
cartridge.

Out of Toner The toner cartridge is empty. Replace the toner car-
tridge with a new one.

RReeccyycclliinngg SSuupppplliieess
For more information on the Xerox® supplies recycling program, go to www.xerox.com/recycling.
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Managing the Printer

VViieewwiinngg tthhee MMeetteerr RReeaaddiinngg
The Billing/Usage menu displays the total number of impressions that the printer generated or
printed during its lifetime. You cannot reset the counters. A page is counted as one side of a sheet of
paper. For example, a sheet of paper that is printed on two sides counts as two impressions.

Note: If you provide regular billing information for your device, you can use the Remote
Services Upload feature to simplify the process. You can enable Remote Services to send billing
meter readings to Xerox automatically so that you do not have to collect the readings
manually. For more information, refer to the System Administrator Guide at www.xerox.com/
support/VLC8000docs or www.xerox.com/support/VLC9000docs.

To view the billing information for your printer:

1. At the printer control panel, press the Home button.

2. Touch Device→Billing/Usage.

3. To view more details, touch Usage Counters, then select an option.

4. After viewing the usage readings, to return to the Home screen, press the Home button.

PPrriinnttiinngg tthhee BBiilllliinngg SSuummmmaarryy RReeppoorrtt
The Billing Summary Report provides information about the device and a detailed listing of the billing
meters and sheet counts.

To print the Billing Summary Report:

1. At the printer control panel, press the Home button.

2. Touch Device→About→Information Pages.

3. Touch Billing Summary Report.

4. To return to the Home screen, press the Home button.
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Moving the Printer
Before you move the printer:

• Ensure that you power off the printer always and wait for it to shut down completely.

• Ensure that no jobs are in the print queue.

• Disconnect the power cord and other cables from the back of the printer.

WARNING: To prevent electric shock, never touch the power plug with wet hands. When
removing the power cord, ensure that you pull the plug and not the cord. When you pull the
cord, you can damage it, which can lead to fire or electric shock.

WARNING: Professional installation required.

Note:

• When moving the printer, do not tilt it more than 10 degrees in any direction. Tilting the
printer more than 10 degrees can cause toner spillage.

• When you move the printer over a long distance, to prevent toner from spilling, remove the
drum cartridge and toner cartridges.

Caution: Do not expose the drum cartridge to direct sunlight or strong indoor fluorescent
lighting. Do not touch or scratch the surface of the imaging drum.

Caution: Failure to repackage the printer properly for shipment can result in damage not
covered by the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. The
Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee do not cover damage to
the printer caused by improper moving.

After you move the printer:

1. Reinstall any parts that you removed.

2. Reconnect the printer to the cables and power cord.

3. Plug in and power on the printer.
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General Troubleshooting
This section contains procedures to help you locate and resolve problems. Resolve some problems by
simply restarting the printer.

PPrriinntteerr DDooeess NNoott PPoowweerr OOnn
Probable Causes Solutions

The power switch is not switched on. • Open the front door, then check that the power switch is in the
On position.

• At the printer control panel, press the Power/Wake button. For
details, refer to Powering On the Printer.

The power cord is not plugged into the
outlet correctly.

Power off the printer, then securely plug the power cord into the
outlet. If provided, use the bracket provided with the printer to
secure in place the power cord.

The power cord is not secured in place
correctly.

Use the bracket provided with the printer to secure in place the
power cord.

Something is wrong with the outlet
connected to the printer.

• Plug another electrical appliance into the outlet and check if it
operates properly.

• Try a different outlet.

The printer is connected to an outlet
with a voltage or frequency that does
not match the printer specifications.

Use a power source with the specifications listed in the Electrical
Specifications.

Caution: Directly plug the 3-wire cord with grounding prong into a grounded AC outlet.

PPrriinntteerr RReesseettss oorr PPoowweerrss OOffff FFrreeqquueennttllyy

Probable Causes Solutions

The power cord is not plugged into the
outlet correctly.

Power off the printer, confirm that the power cord is plugged in
correctly to the printer and the outlet, then power on the printer.

A system error occurred. Power off the printer, then power on again. For more information,
refer to Printing the Error History Report. If the error persists,
contact your Xerox representative.

The printer is connected to an
uninterruptible power supply.

Power off the printer, then connect the power cord to a suitable
outlet.
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Probable Causes Solutions

The printer is connected to a power strip
shared with other high-power devices.

Plug the printer directly into the outlet or into a power strip that is
not shared with other devices.

The Auto Power Off feature is enabled
to save power.

Increase the Auto Power Off timer setting or disable the Auto
Power Off feature. For more information, refer to the System
Administrator Guide at www.xerox.com/support/VLC8000docs or
www.xerox.com/support/VLC9000docs.

PPrriinntteerr DDooeess NNoott PPrriinntt
Probable Causes Solutions

The printer is in Power Saver mode. On the control panel, press the Power/Wake button.

The printer has an error. If the Status LED is blinking amber, follow the instructions on the
control panel to clear the error. If the error persists, contact your
Xerox representative.

The printer is out of paper. Load paper into the tray.

The incorrect paper is loaded for the
print job.

Load the correct paper in the appropriate tray. At the printer
control panel, specify the correct paper size, type and color.

The paper settings for the print job do
not match any paper loaded in the
paper trays at the printer.

• Load the correct paper type into the selected paper tray.
• From the print driver, select an available paper type for the

print job.

A toner cartridge is empty. Replace the empty toner cartridge.

The waste cartridge is full. Replace the waste cartridge.

No control panel indicators are lighted. Power off the printer, confirm that the power cord is plugged in
correctly to the printer and the outlet, then power on the printer.
If the error persists, contact your Xerox representative.

The printer is busy. • If the Status LED is flashing blue, a previous print job could be
the problem.
1 In the print driver, use the Printer Properties to delete all

print jobs in the print queue.
2 At the control panel, touch Jobs, then delete all pending

print jobs.
• Load the paper in the tray.
• If the Status LED does not flash once after you send a print

job, check the connection between the printer and the
computer. Power off the printer, then power on the printer.
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Probable Causes Solutions

The printer cable is disconnected. If the Status LED does not flash once after you send a print job,
check the connection between the printer and the computer.

There is a network-connectivity issue. If the printer is connected to a network:
1 Verify that the Ethernet cable is connected to the printer.
2 On the printer Ethernet connector, verify that the green LED is

On. If the green LED is not lighted, reseat both ends of the
Ethernet cable.

3 Examine the TCP/IP address in the Communication section of
the Configuration Report. For more information, refer to
Printing the Configuration Report.

4 If the TCP/IP address is 0.0.0.0, the printer needs more time to
acquire an IP address from the DHCP server. Wait 2 minutes,
then print the Configuration Report again.

5 If the TCP/IP address is unchanged, or begins with 169,
contact your network administrator.

There is a wireless network setup or
connectivity issue.

Verify that the Wireless Network Adapter is installed and properly
configured. For more information, refer to Connecting to a
Wireless Network.

PPrriinnttiinngg TTaakkeess TToooo LLoonngg

Probable Causes Solutions

The printer is set to a slower printing
mode. For example, the printer is set to
print on Heavyweight paper or
Envelopes.

It takes more time to print on certain types of special paper.
Ensure that the paper type is set properly in the print driver and at
the printer control panel. For details, refer to Print Speed.

The printer is in Power Saver mode. It takes time for printing to start when the printer is coming out of
Power Saver mode.

The way the printer was installed on the
network can be an issue.

Determine if a print spooler or a computer sharing the printer is
buffering all print jobs and then spooling them to the printer.
Spooling can slow print speeds. To test the speed of the printer,
print some information pages such as the Demonstration Print. For
details, refer to Printing Information Pages. If the page prints at
the rated speed of the printer, there can be a network or printer
installation issue. For more help, contact the system administrator.

The job is complex. Wait. No action needed.

The print-quality mode in the print
driver is set to Enhanced or Photo.

Change the print-quality mode in the print driver to Standard.
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DDooccuummeenntt PPrriinnttss ffrroomm WWrroonngg TTrraayy

Probable Causes Solutions

Application and print driver have
conflicting tray selections.

1 Check the tray selected in the print driver.
2 Access the page setup or printer settings of the application

from which you are printing.
3 Set the paper source to match the tray selected in the print

driver or set the paper source to Automatically Select.
4 Check that you have the latest print driver installed. For details,

go to www.xerox.com/support/VLC8000support or www.xerox.
com/support/VLC9000support.

Note: To have the print driver select the tray, set the tray
used as the paper source to Auto Selection Enabled.

AAuuttoommaattiicc 22--SSiiddeedd PPrriinnttiinngg PPrroobblleemmss

Probable Causes Solutions

Unsupported or incorrect paper. Ensure that you are using the correct paper. Do not use
transparencies, envelopes, labels, or reloaded paper for automatic
2-sided printing. For details, see Supported Standard Paper Sizes
for Automatic 2-Sided Printing.

Incorrect setting. On the print driver Printing Options tab, select 2-sided Printing.

PPrriinntteerr iiss MMaakkiinngg UUnnuussuuaall NNooiisseess

Probable Causes Solutions

There is an obstruction or debris inside the printer. Power off the printer, then remove the
obstruction or debris. If you cannot remove the
obstruction, contact your Xerox representative.

CCoonnddeennssaattiioonn HHaass FFoorrmmeedd IInnssiiddee tthhee PPrriinntteerr
Moisture can condense in the printer when room humidity exceeds 85% or when a cold printer is
located in a warm room. Condensation can form in a printer after it has been sitting in a cold room
that is heated quickly.
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Probable Causes Solutions

The printer has been sitting in a cold
room.

Allow the printer to operate for several hours at room
temperature.

The relative humidity of the room is too
high.

• Reduce the humidity in the room.
• Move the printer to a location where the temperature and

relative humidity are within the operating specifications. For
more information, refer to Environmental Specifications.
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Paper Jams

LLooccaattiinngg PPaappeerr JJaammss
WARNING: Never touch a labeled area on or near the heat roller in the fuser. You can get
burned. If a sheet of paper is wrapped around the heat roller, do not try to remove the paper
immediately. Power off the printer immediately and wait 40 minutes for the fuser to cool. Try
to remove the jam after the printer has cooled. If the error persists, contact your Xerox
representative.

Caution: Do not attempt to clear any paper jams using tools or instruments, because they can
damage the printer permanently.

The following illustration shows where paper jams can occur along the paper path:

1. Paper Tray Feed Area: Door B

2. Bypass Tray

3. Fuser Area: Door A

4. Paper Output Area, and optional Finisher
Transport

5. Paper Trays 1–4

Note: Finisher jam locations are covered separately. For details, refer to Clearing Finisher Jams.

MMiinniimmiizziinngg PPaappeerr JJaammss
The printer is designed to function with minimal paper jams when you use Xerox-supported paper.
Other paper types can cause jams. If supported paper jams frequently in one area, clean that area of
the paper path.

The following can cause paper jams:

• Selecting the incorrect paper type in the print driver

• Using damaged paper

• Using unsupported paper
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• Loading paper incorrectly

• Loading paper above the maximum fill line in the paper tray

• Adjusting the paper guides improperly

• Polyester-coated paper that is designed especially for inkjet printers

• Paper that is folded, wrinkled, or excessively curled

• Loading more than one type, size, or weight of paper in a tray at the same time

• Allowing the output tray to become overfilled

To prevent most jams, follow these rules:

• Use only supported paper. For more information, refer to Supported Paper.

• Follow proper paper handling and loading techniques.

• Always use clean, undamaged paper.

• Avoid paper that is curled, torn, moist, creased, or folded.

• To separate the sheets before loading into the tray, fan the paper.

• Do not load paper above the maximum fill line.

• After loading paper in the trays, adjust the paper guides in all trays. A guide that is not properly
adjusted can cause poor print quality, misfeeds, skewed prints, and printer damage.

• After loading paper in the trays, at the control panel, select the correct paper type and size.

• Before printing, select the correct paper type and size in the print driver.

• Store paper in a dry location.

• When jams occur printing on heavy coated paper, load that paper into the printer a single sheet
at a time.
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CClleeaarriinngg PPaappeerr JJaammss

CClleeaarriinngg PPaappeerr JJaammss ffrroomm TTrraayyss 11––44
To resolve the error that appears on the control panel, clear all paper from the paper path.

1. Before removing the tray from the printer, review the paper jam message on the control panel. If
another jam error appears, clear that jam inside the printer first.

2. Pull out the tray until it stops.

3. Remove the paper from the tray.

4. If the paper is torn, remove the tray completely, then check inside the printer for torn pieces of
paper.

5. Reload the tray with undamaged paper, then push the tray in until it stops.

6. When paper trays are set to Fully Adjustable, you are prompted to verify or change the paper
settings.
• To confirm the same paper size, type, or color, touch OK.
• To select a new paper size, type, or color, touch the current setting, then select a new setting.

When finished, touch OK.

7. To return to the Home screen, press the Home button.
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CClleeaarriinngg PPaappeerr JJaammss ffrroomm tthhee BByyppaassss TTrraayy
To resolve the error that appears on the control panel, clear all paper from the paper path.

1. Remove the jammed paper from the tray. Ensure that the paper-feed entrance, where the tray
connects to the printer, is clear.

2. If the paper is torn, check inside the printer for torn pieces of paper.

3. Before you reload paper into the Bypass Tray, fan the paper, then ensure that all four corners are
aligned.

4. Insert the paper into the Bypass Tray with the print side face down. Ensure that the leading edge
of the paper lightly touches the paper-feed entrance.

5. When paper trays are set to Fully Adjustable, you are prompted to verify or change the paper
settings.
• To confirm the same paper size, type, or color, touch OK.
• To select a new paper size, type, or color, touch the current setting, then select a new setting.

When finished, touch OK.

6. To return to the Home screen, press the Home button.
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CClleeaarriinngg PPaappeerr JJaammss aatt DDoooorr AA
WARNING: Do not perform this procedure while the printer is printing.

Note: To resolve the error that appears on the control panel, clear all paper from the paper
path.

1. Lift the release lever, then open Door A.

WARNING: The area around the Fuser can be hot. Use caution to avoid injury.

Caution: Do not touch the Transfer Roller. Touching the roller can reduce image quality.

2. Remove the jammed paper.

3. If paper is jammed on the inside of Door A, remove it.
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4. If paper is jammed at the exit to the output tray, to remove the paper, carefully pull it straight
out in the direction shown.

Note: Toner can adhere to the Transfer Roller. This residual toner does not affect print
quality.
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5. If paper is jammed in the Fuser, remove the paper from areas A1 and A2.

a. To open the paper guide, pull out handle A1.

b. Remove any paper in area A1.

c. Lift handle A1 back into place.

d. To open the paper guide, lift handle A2.
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e. Remove any paper in area A2.

f. To close the paper guide, swing handle A2 down, then push the handle firmly in, until the
paper guide clicks into place.

Note: If the paper is torn, remove all torn pieces from the printer.
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6. To close Door A, push the door up firmly until it clicks into place.

CClleeaarriinngg PPaappeerr JJaammss aatt DDoooorr BB
Note: To resolve the error that appears on the control panel, clear all paper from the paper
path.

1. Pull the release lever, then open Door B.

2. Remove the jammed paper from the paper tray feed area.

Note: If the paper is torn, remove all torn pieces from the printer.

3. For paper jammed in the upper position, look inside the printer, locate the jammed paper, then
remove it.

Note: If the paper is inaccessible, refer to Clearing Paper Jams at Door A.
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4. For paper jammed at a tray feed roller, open Trays 3 and 4, then remove the paper.

Note: The optional Tandem Tray Module is shown.

5. For printers with a Tandem Tray Module, remove any paper jammed in the Tray 4 paper guide.

a. Grasp handle C, then pull the Tray 4 paper guide until it stops.

b. Lift the paper guide cover, then remove any paper.
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c. Lower the paper guide cover.

d. Push the paper guide back into position.

Xerox® VersaLink® C8000/C9000 Color Printer
User Guide

191

Troubleshooting



6. Close the paper trays.

7. Close Door B.

TTrroouubblleesshhoooottiinngg PPaappeerr JJaammss

MMuullttiippllee SShheeeettss PPuulllleedd TTooggeetthheerr

Probable Causes Solutions

The paper tray is too full. Remove some of the paper. Do not load paper above the maximum
fill line.

The edges of the paper are not even. Remove the paper, align the edges, and then reload the paper.

The paper is moist from humidity. Remove the paper from the paper tray. Load new, dry paper into
the tray.

Too much static electricity is present. Load a new ream of paper.

Using unsupported paper. Use only Xerox®-approved paper. For details, refer to Supported
Paper.

Humidity is too high for coated paper. • Feed paper one sheet at a time.
• Try loading paper in the Bypass tray.
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Probable Causes Solutions

The feed rollers are dirty. With a clean, lint-free cloth moistened with water, wipe the feed
rollers until they are clean. For details, refer to Cleaning the Printer.

Tray is loaded with mixed paper. Load the tray with only one type and size of paper.

PPaappeerr MMiissffeeeeddss

Probable Causes Solutions

The paper is not correctly positioned in the tray. • Remove the misfed paper, then properly repo-
sition it in the tray.

• Adjust the paper guides in the tray to match
the size of the paper.

The paper tray is too full. Remove some of the paper. Do not load paper
above the maximum fill line.

The paper guides are not correctly adjusted to the paper
size.

Adjust the paper guides in the tray to match the
size of the paper.

The tray contains warped or wrinkled paper. Remove, smooth out, then reload the paper. If it
still misfeeds, do not use that paper.

The paper is moist from humidity. Remove the moist paper and replace it with new,
dry paper.

The paper is the wrong size, thickness, or type. Use only Xerox approved paper. For more infor-
mation, refer to Supported Paper.

LLaabbeell aanndd EEnnvveellooppee MMiissffeeeeddss

Probable Causes Solutions

The label sheet is facing the wrong way in the tray. • Load label sheets according to the instructions
from the manufacturer.

• Load labels in the tray, face up.
• For more information, refer to Labels.

Labels are missing, curled, or pulled away from the
backing sheet.

Do not use any sheet where labels are missing, curled,
or pulled away from the backing sheet.
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Probable Causes Solutions

Envelopes are loaded incorrectly. You can print envelopes from the Bypass Tray or the
Envelope Tray.

For more information, refer to Envelopes.

Envelopes are wrinkling. • The heat and pressure of the laser printing proc-
ess can cause wrinkling.

• Use supported envelopes. For more information,
refer to Guidelines for Printing Envelopes.

Note: When you load envelopes long-edge
feed, ensure that you specify landscape orien-
tation in the print driver.

PPaappeerr JJaamm MMeessssaaggee SSttaayyss OOnn
Note: Check for, and remove, torn pieces of paper in the paper path.

Probable Causes Solutions

Some paper remains jammed in the
printer.

Recheck the paper path and make sure that you have removed all
of the jammed paper.

One of the printer doors is open. Check the doors on the printer. Close any door that is open.

JJaammss DDuurriinngg AAuuttoommaattiicc 22--SSiiddeedd PPrriinnttiinngg

Probable Causes Solutions

Using paper of the wrong size, thick-
ness, or type.

Use paper of the correct size, thickness, or type. For more informa-
tion, refer to Supported Paper Types and Weights for Automatic 2-
Sided Printing.

Paper is loaded in the wrong tray. Ensure that paper is loaded into the correct tray. For more informa-
tion, refer to Supported Paper.

Tray is loaded with mixed paper. Load the tray with only one type and size of paper.
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Clearing Finisher Jams

CClleeaarriinngg JJaammss iinn tthhee OOffffiiccee FFiinniisshheerr LLXX

CClleeaarriinngg JJaammss UUnnddeerr tthhee TToopp CCoovveerr ooff tthhee OOffffiiccee FFiinniisshheerr
WARNING: Do not perform this procedure while the printer is printing.

1. Pull up the lever on the top cover of the Office Finisher.

2. To open the top cover, rotate it to the left.
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3. Remove the jammed paper.

Note: If the paper is torn, remove all torn pieces from the finisher.

4. Close the top cover of the Office Finisher.

CClleeaarriinngg JJaammss iinn tthhee FFiinniisshheerr TTrraannssppoorrtt
1. To open the transport cover, lift the handle of the center tray straight up.

2. Remove the jammed paper.

Note: If the paper is torn, remove all torn pieces from the finisher.

3. Close the transport cover.
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CClleeaarriinngg JJaammss iinn tthhee BBuussiinneessss RReeaaddyy FFiinniisshheerr

CClleeaarriinngg JJaammss iinn tthhee CCeenntteerr TTrraayy
1. If the paper is jammed at the exit to the center output tray, pull the paper in the direction shown.

2. Open, then close, the finisher transport cover.
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CClleeaarriinngg JJaammss iinn tthhee FFiinniisshheerr TTrraannssppoorrtt
1. To open the transport cover, lift the handle of the center tray straight up.

2. Remove the jammed paper.

Note: If the paper is torn, remove all torn pieces from the finisher.

3. Close the transport cover.

CClleeaarriinngg JJaammss iinn tthhee BBRR FFiinniisshheerr aatt PPoossiittiioonn 33aa
1. If the paper is visible at the output tray exit, remove the paper by pulling it gently in the direction

shown.

2. Open the front door of the Business Ready Finisher.
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3. Lift green handle 3a.

4. Carefully remove the paper.

• If the paper is torn, remove all torn pieces from the finisher.

• If the paper is inaccessible, or if the press User Interface (UI) prompts you to release the
paper, turn green handle knob 3b in the direction shown.

5. Return green handle 3a to its original position.

6. Close the front door of the Business Ready Finisher.
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CClleeaarriinngg JJaammss iinn tthhee BBRR FFiinniisshheerr aatt PPoossiittiioonn 33cc
1. Open the front door of the Business Ready Finisher.

2. Move green lever 3c to the left.

3. Carefully remove the paper.

• If the paper is torn, remove all torn pieces from the finisher.

• If the paper is inaccessible, or if the press User Interface (UI) prompts you to release the
paper, turn green handle knob 3b in the direction shown.

4. Return green lever 3c to its original position.

5. Close the front door of the Business Ready Finisher.
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CClleeaarriinngg JJaammss iinn tthhee BBRR FFiinniisshheerr aatt PPoossiittiioonn 33dd
1. Open the front door of the finisher, and locate green lever 3d.

2. Move green lever 3d to the right.

3. Carefully remove the paper.

Note: If the paper is torn, remove all pieces from the finisher.

4. Return green lever 3d to its original position.

5. Close the front door of the Business Ready Finisher.
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CClleeaarriinngg JJaammss iinn tthhee BBRR FFiinniisshheerr aatt PPoossiittiioonn 44
1. Open the front door of the Business Ready Finisher.

2. Using the green handle, pull out unit 4 until it stops.

3. To remove the jammed paper, turn green knob 4 in either direction as shown.

Note: If the paper is torn, remove all torn pieces from the finisher.

4. Return unit 4 to its original position.

5. Close the front door of the Business Ready Finisher.
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CClleeaarriinngg JJaammss iinn tthhee BBooookklleett TTrraayy
1. Open the front door of the Business Ready Finisher.

2. To release the jammed paper, turn green knob 4 in the direction shown.

3. To remove the paper, pull it in the direction shown.

Note: If the paper is torn, remove all torn pieces from the finisher.

4. Close the front door of the Business Ready Finisher.
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Clearing Staple Jams

CClleeaarriinngg SSttaappllee JJaammss iinn tthhee OOffffiiccee FFiinniisshheerr LLXX
WARNING: Do not perform this procedure while the printer is printing.

1. Open the front door of the Office Finisher.

2. Reach into the finisher cabinet and pull the stapler assembly toward you until it stops.

3. Push the stapler assembly to the right as shown.
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4. Grip the staple cartridge by the orange handle and pull it firmly toward you to remove it.

5. Check inside the finisher for any loose staples and remove them.

6. Pull the staple cartridge clamp firmly in the direction shown to open it.

7. Remove the jammed staples by pulling them in the direction shown.

WARNING: The points of the jammed staples are sharp. Remove the jammed staples
carefully.

Xerox® VersaLink® C8000/C9000 Color Printer
User Guide

205

Troubleshooting



8. Push the clamp in the direction shown until it snaps into the locked position.

9. Grip the staple cartridge by the orange handle and insert it into the stapler assembly. Push it in
until it clicks.

10. Close the front door of the Office Finisher.
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CClleeaarriinngg BBooookklleett SSttaappllee JJaammss iinn tthhee OOffffiiccee FFiinniisshheerr LLXX
WARNING: Do not perform this procedure while the printer is printing.

1. Open the side cover of the Office Finisher.

2. If the staple cartridges are not visible, grip the vertical panels at the left and right of the opening
and slide them to the center.

3. Hold the tabs on both sides of the staple cartridge and pull the cartridge out of the finisher.
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4. Remove the jammed staples by pulling them in the direction shown.

WARNING: The points of the jammed staples are sharp. Remove the jammed staples
carefully.

5. Hold the tabs on both sides of the staple cartridge and insert it into the original position in the
finisher.

Note: If you have trouble inserting the cartridge, ensure that the staples are positioned
correctly in the cartridge.

Note: The booklet maker uses two staple cartridges. Booklet stapling requires that both
staple cartridges contain staples.

6. Starting at Step 2, repeat the procedure for the other staple cartridge.

7. Close the side cover of the Office Finisher.
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CClleeaarriinngg MMaaiinn SSttaappllee JJaammss iinn tthhee BBuussiinneessss RReeaaddyy
FFiinniisshheerr
1. Open the front door of the Business Ready Finisher.

2. Locate and hold the stapler assembly by the orange lever R1, then push it to the right.

3. To remove the staple cartridge, grasp the orange handle, then pull it firmly toward you.

4. Pull the staple cartridge clamp firmly in the direction shown to open it.
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5. Remove the jammed staples.

WARNING: The points of the jammed staples are sharp. Remove the jammed staples
carefully.

6. To close the staple clamp, push the clamp in the direction shown until it snaps into the locked
position.

7. Grasp the new staple cartridge by the orange handle, then insert the cartridge into the stapler
assembly until it clicks.

8. Return the staple cartridge assembly to its original position, then close the finisher door.
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CClleeaarriinngg SSttaappllee JJaammss iinn tthhee BBooookklleett MMaakkeerr ooff tthhee
BBuussiinneessss RReeaaddyy FFiinniisshheerr
1. Open the front door of the Business Ready Finisher.

2. Grasp the booklet maker handle and pull the unit toward you until the staple cartridges appear
on the top edge of unit.

3. To remove a staple cartridge from the booklet maker, push down on the staple cartridge handle,
then pull the cartridge out and up.

4. Turn over the staple cartridge.
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5. To open the staple cartridge handle, press in the green tabs, then pull the handle out and away
from the staple pack.

Note: If you do not see the staple jam, remove the staple case.

6. To remove the staple case, press the rear of the case as shown.

Note: If you can see the staple jam, open the clamp on the staple cartridge.
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7. To open to the staple cartridge, pull it firmly in the direction shown.

WARNING: The points of the jammed staples are sharp. Carefully remove the jammed
staples.

8. Remove the jammed staples, then push the clamp in the direction shown until it snaps into the
locked position.

9. To close the staple cartridge, push back the cartridge handle until it clicks.
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10. To return the staple cartridge to the booklet maker, insert the staple cartridge and push up on the
cartridge handle as shown.

11. Return the booklet maker to the original position, then close the front door of the Business Ready
Finisher.
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Clearing Hole Punch Jams

CClleeaarriinngg HHoollee PPuunncchh JJaammss iinn OOffffiiccee FFiinniisshheerr LLXX
If the printer stops printing and reports a hole-punch jam, empty the hole-punch waste container. For
details, refer to Emptying the Hole Punch Waste Container in the Office Finisher LX.

After emptying the hole-punch waste container, locate and remove any paper jams.
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Print-Quality Problems
Your printer is designed to produce consistently high-quality prints. If you observe print-quality prob-
lems, use the information in this section to troubleshoot the problem. For more information, go to
www.xerox.com/support/VLC8000support or www.xerox.com/support/VLC9000support.

Caution: Damage caused by using unsupported paper or specialty media is not covered by the
Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee. The Xerox® Total
Satisfaction Guarantee is available in the United States and Canada. Coverage can vary outside
these areas. Contact your local Xerox representative for details.

Note:

• To ensure consistent print quality, the toner, print, and drum cartridges for many devices are
designed to cease functioning at a predetermined point.

• Grayscale images printed with the composite black setting increment the color pages coun-
ter, because color consumables are used. Composite black is the default setting on most
printers.

CCoonnttrroolllliinngg PPrriinntt QQuuaalliittyy
Various factors can affect the quality of the output of your printer. For consistent and optimum print
quality, use paper designed for your printer, and correctly set the Print-Quality Mode and Color
Adjustments. Follow the guidelines in this section to maintain optimum print quality from your
printer.

Temperature and humidity affect the quality of the printed output. The range for optimal print
quality is 10–28°C (50–83°F) and 15–85% relative humidity. However, print quality can be affected
when operating near the limits for both temperature and humidity.

PPaappeerr aanndd MMeeddiiaa
Your printer is designed to use various paper and other media types. Follow the guidelines in this
section for the best print quality and to avoid jams:

• Use only Xerox-approved paper. For details, refer to Supported Paper.

• Use only dry, undamaged paper.

• Ensure that the paper type selected in your print driver matches the paper type on which you are
printing.

• If you have the same size paper loaded in more than one tray, ensure that the proper tray is
selected in the print driver.

• Store your paper and other media properly for optimum print quality. For details, refer to Paper
Storage Guidelines.
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Caution: Some paper and other media types can cause poor output quality, increased paper
jams, or damage your printer. Do not use the following:

• Rough or porous paper

• Inkjet paper

• Paper that has been photocopied

• Paper that has been folded or wrinkled

• Paper with cutouts or perforations

• Stapled paper

• Envelopes with windows, metal clasps, side seams, or adhesives with release strips

• Padded envelopes

• Plastic media

• Transparencies

SSoollvviinngg PPrriinntt--QQuuaalliittyy PPrroobblleemmss
When the print quality is poor, select the closest symptom from the following table, then refer to the
corresponding solution to correct the problem. To more precisely determine the print-quality problem,
you can print a Demonstration Print page. For details, refer to Printing Information Pages.

If the print quality does not improve after performing the appropriate action, contact your Xerox
representative.

Note:

• To maintain print quality, the toner and drum cartridges for many models of equipment
stop functioning at a predetermined point.

• Grayscale images printed with the composite black setting increment the color-pages
counter, because color consumables are used. Composite black is the default setting on
most printers.
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Symptom Probable Causes Solutions

• Page margins are
inconsistent.

• The image is not centered on
the page or the margins are
not consistent.

A paper registration adjustment is
needed.

To adjust the image position on the
page, use the paper registration
procedure. For details, refer to
Adjusting Paper Registration.

Faded printouts with multiple
colors.

The toner cartridges are not Xerox®

toner cartridges.
Verify that the toner cartridges
meet specifications. Replace the
cartridges if necessary.

The paper is outside the
recommended specification range.

Replace the paper with a
recommended size and type, then
confirm that the device control
panel and print driver settings are
correct. For details, refer to
Supported Paper.

The paper type in the paper tray is
heavier than the paper type
selection on the control panel or in
the print driver.

Ensure that paper loaded in the
paper tray matches your control
panel and print driver settings.

The bias transfer voltage is not
properly adjusted for the paper
type.

Verify that the paper types set in
the device control panel and the
print driver match the paper loaded
in the tray.

The settings in the application or
print driver are incorrect.

Print the Demonstration Print from
the Information Pages menu. For
details, refer to Printing
Information Pages. If the
Demonstration Print looks correct,
the printer is printing properly.
Verify that the application and the
print driver selections are correct
for your print job.

The paper is damp. Replace the paper.

The high-voltage supply is
defective.

For assistance, go to the Xerox®

Support website at www.xerox.
com/support/VLC8000support or
www.xerox.com/support/
VLC9000support.
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Symptom Probable Causes Solutions

Only one color is faded. The toner cartridge is empty or
damaged.

Check the condition of the toner
cartridge, then replace it if
necessary.

The drum cartridge is worn or
damaged.

Check the condition of the drum
cartridge, then replace it if
necessary.

The color around the edge of the
printed image is incorrect.

The color registration is incorrect. Adjust the color registration. For
details, refer to Color Registration.

The colors appear incorrect, or
composite grays do not look
neutral.

The color density or color balance
requires adjustment.

Adjust the color density or color
balance. For details, refer to Color
Calibration.

The transfer voltage requires
adjustment. Adjust the transfer voltage. For

details, refer to Transfer Voltage
Adjustment.

Stray black dots, or stray white
dots in a printed image.

The paper is outside the
recommended specification range.

Replace the paper with a
recommended size and type, then
confirm that the device control
panel and print driver settings are
correct. For details, refer to
Supported Paper.

There is debris on the rollers. To remove debris from the feed and
exit rollers, wipe them with a clean,
damp cloth.

Note: Do not touch the
Transfer Roller or the
exposed end of the Transfer
Belt. Fingerprints can cause
print-quality issues.

The toner cartridges are not Xerox®

toner cartridges.
Ensure that the toner cartridges
meet specifications. Replace the
cartridges if necessary.

The drum cartridge is worn or
damaged.

Check the condition of the drum
cartridge, then replace it if
necessary.

• Vertical black or color streaks,
or multiple colored streaks or
lines.

The toner cartridges are not Xerox®

toner cartridges.
Ensure that the toner cartridges
meet specifications. Replace the
cartridges if necessary.
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Symptom Probable Causes Solutions

• Streaks in only one color.
Debris in the printer is dragging
against the toner, before the toner
is fused to the paper.

Remove any debris or paper scraps
from the paper path under the rear
cover.

There is a problem with the toner
cartridge for that color.

Check the toner cartridge for
damage, then replace the cartridge
if necessary. For assistance, go to
the Xerox® Support website at
www.xerox.com/support/
VLC8000support or www.xerox.
com/support/VLC9000support.

The drum cartridge is worn or
damaged.

Check the condition of the drum
cartridge, then replace it if
necessary.

Partial blanks, creased paper, or
blotted printing.

The paper is damp. Replace the paper.

The paper is outside the
recommended specification range.

Replace the paper with a
recommended size and type. For
details, refer to Supported Paper.

A printer part is worn or damaged. For assistance, go to the Xerox®

Support website at www.xerox.
com/support/VLC8000support or
www.xerox.com/support/
VLC9000support.

The toner cartridges are not Xerox®

toner cartridges.
Verify that the toner cartridges
meet specifications, then replace if
necessary.

The paper is impeded in the paper
path.

• Remove any paper or debris
from the paper path.

• Ensure that the trays are
pushed in all the way.

• Ensure that the rear cover is
closed and locked.

Condensation inside the printer
causes partial blanks or creased
paper.

To remove the condensation, power
on the printer and leave it on for at
least 1 hour. For assistance, go to
the Xerox® Support website at
www.xerox.com/support/
VLC8000support or www.xerox.
com/support/VLC9000support.

Vertical blanks appear. The laser lenses are blocked. Clean the laser lenses. For details,
refer to Cleaning the Printhead
Lenses.
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Symptom Probable Causes Solutions

A printer part is worn or damaged. For assistance, go to the Xerox®

Support website at www.xerox.
com/support/VLC8000support or
www.xerox.com/support/
VLC9000support.

The toner cartridges are not Xerox®

toner cartridges.
Ensure that the toner cartridges
meet specifications, then replace if
necessary.

White lines or streaks running
through only one color.

Something is blocking the lens for
the affected color.

Clean the lens for the affected
color. For details, refer to Cleaning
the Printhead Lenses.

White line or lines running
through all colors.

Paper or debris is dragging the
bottom of the transfer belt.

• Remove the paper or debris
from the printer.

• For assistance, go to the Xerox®

Support website at www.xerox.
com/support/VLC8000support
or www.xerox.com/support/
VLC9000support.

Slanted printing. The paper guides in the trays are
not set correctly.

Reset the paper tray guides. For
details, refer to Loading Paper.
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Symptom Probable Causes Solutions

Blotchy or mottled images. The paper is too light or too thin. Choose a different paper type at
the device control panel, in the
application, and in the print driver.

The paper is damp. Replace the paper.

The humidity is too high. Reduce the humidity in the room or
move the printer to a new location.

Spots or lines appear at regular
intervals on the prints.

One or more of the components in
the paper path is marking the
paper.

1 Print the Repeating Defects
pages.At the device control
panel, touch
Device→Support→Support
Pages→Repeating Defects.

2 To determine the cause of the
printing problem, measure the
distance between the print
defects.
• 95 mm (3.74 in.): Drum

Cartridge
• 38 mm (1.5 in.): Drum

Cartridge
• 96 mm (3.78 in.): Fuser
• 88 mm (3.46 in.): Fuser
• 64 mm (2.52 in.): Transfer

Roller
• 33 mm (1.30 in.): Developer

Roller; for Service only
3 If the repeating defects match

one of these distances, replace
that item.

Note: For assistance with a
Fuser or Transfer Roller
image-quality problem,
contact Xerox technical
support. For details, go to
the Xerox® Support website
at www.xerox.com/support/
VLC8000support or www.
xerox.com/support/
VLC9000support.
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Getting Help
Your printer includes utilities and resources to help you troubleshoot printing problems.

VViieewwiinngg WWaarrnniinngg MMeessssaaggeess oonn tthhee CCoonnttrrooll PPaanneell
When a warning condition occurs, the printer alerts you of the problem. A message appears on the
control panel and the LED status light on the control panel flashes amber or red. Warning alerts
inform you about printer conditions, such as low supplies or open doors, that require your attention. If
more than one warning condition occurs, only one warning message appears on the control panel at
a time.

VViieewwiinngg CCuurrrreenntt EErrrroorrss oonn tthhee CCoonnttrrooll PPaanneell
When an error condition occurs, a message appears on the control panel to inform you of the
problem. Error messages warn you about printer conditions that prevent the printer from printing or
degrade printing performance. If more than one error occurs, only one is displayed on the control
panel.

UUssiinngg tthhee IInntteeggrraatteedd TTrroouubblleesshhoooottiinngg TToooollss
Your printer has a set of reports that you can print. These reports include the Demonstration Print
page and the Error History report that can assist you in troubleshooting certain problems. The
Demonstration Print page prints an image to show print quality. You can use this page to
troubleshoot print-quality issues with the printer. The Error History report prints information on the
most recent printer errors.

For more information, refer to Printing Information Pages.

PPrriinnttiinngg IInnffoorrmmaattiioonn PPaaggeess
1. At the printer control panel, press the Home button.

2. Touch Device→About→Information Pages.

3. To print an information page, touch the needed page.

4. To return to the Home screen, press the Home button.

PPrriinnttiinngg tthhee EErrrroorr HHiissttoorryy RReeppoorrtt
1. At the printer control panel, press the Home button.

2. To print the Error History Report, touch Device→Support→Support Pages→Error History Report.

3. To return to the Home screen, press the Home button.

OOnnlliinnee SSuuppppoorrtt AAssssiissttaanntt
The Online Support Assistant is a knowledge base that provides instructions and troubleshooting help
to solve your printer problems. You can find solutions for print-quality problems, paper jams, software
installation issues, and more.
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To access the Online Support Assistant, go to www.xerox.com/support/VLC8000support or www.xerox.
com/support/VLC9000support.

MMoorree IInnffoorrmmaattiioonn aabboouutt YYoouurr PPrriinntteerr
To obtain more information about your printer, refer to More Information.
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Printer Configurations and Options

AAvvaaiillaabbllee CCoonnffiigguurraattiioonnss
The printer is available in the following configurations:

The Xerox® VersaLink® C8000DT Color Printer:

• Tray 1 with 520-sheet capacity

• Tray 2 with 520-sheet capacity

• Bypass Tray with 100-sheet capacity

• Automatic 2-sided printing

• USB or network connectivity

• Embedded spot-color table

The Xerox® VersaLink® C9000DT Color Printer:

• Tray 1 with 520-sheet capacity

• Tray 2 with 520-sheet capacity

• Bypass Tray with 100-sheet capacity

• Automatic 2-sided printing

• USB or network connectivity

• Internal hard disk

• Embedded spot-color table with the ability to swap out for a PANTONE® approved color table

• Custom spot-color editor

SSttaannddaarrdd FFeeaattuurreess
Print Speed

• C8000: A4 (210 x 297 mm); Letter (8.5 x 11 in.): 45 ppm maximum
• C9000: A4 (210 x 297 mm); Letter (8.5 x 11 in.): 55 ppm maximum

2-Sided Print Speed

• C8000: A4 (210 x 297 mm); Letter (8.5 x 11 in.): 45 ppm maximum
• C9000: A4 (210 x 297 mm); Letter (8.5 x 11 in.): 55 ppm maximum

Print Resolution

1200 x 2400 dpi

Note: Enhanced print-quality mode only. Not available for the PCL print driver.
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Color Management

• C8000: Embedded spot-color table
• C9000:

– Default: Embedded spot-color table

– Optional: PANTONE®-approved color table

– Optional: Custom spot-color editor

Paper Capacity

• Bypass Tray: 100 sheets
• Tray 1: 520 sheets
• Tray 2: 520 sheets
• Output Tray: 500 sheets
• Optional Two-Tray Module: 1040 sheets
• Optional Tandem Tray Module: 2000 sheets
• Optional High-Capacity Feeder: 2000 sheets
• Optional Envelope Tray: 50 envelopes
• Optional Office Finisher LX: 2000 sheets
• Optional BR Booklet Maker Finisher: 1500-sheet Stacker Tray and 500-sheet Top Tray

Maximum Print Size

• Tray 1: 297 x 431.8 mm (11.69 x 17 in.)
• Tray 2: 320 x 457.2 mm (12.598 x 18 in.)
• Bypass Tray: 320 x 482.6 mm (12.6 x 19 in.); Banner Pages 320 x 1320.8 mm (12.6 x 52 in.)

Control Panel

5-inch LCD touch screen with Home and Power/Wake buttons

Connectivity

• 2 USB Type A Ports
• USB 3.0 Type B Port
• Ethernet 10/100/1000 Base-TX
• Optional Wi-Fi® and Wi-Fi Direct® connectivity with an IEEE 802.11 b/g/n-compliant Wi-Fi Kit
• Near Field Communication (NFC) Tap-to-Pair
• AirPrint
• MOPRIA™

• IC Card Reader support
• Foreign Device Interface (FDI)

Remote Access

Xerox Embedded Web Server

OOppttiioonnss aanndd UUppggrraaddeess
• Paper Trays:
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– Two-Tray Module

– Tandem Tray Module

– High-Capacity Feeder

– Envelope Tray, replaces Tray 1

• Office Finisher LX

• Office Finisher LX with Booklet Maker

• BR Finisher with Booklet Maker

• Wi-Fi Kit

• Hard Drive

• Internal Card Reader / RFID Kit

• Xerox® Precise Color Management System, includes software and meter. Optional for Xerox® Ver-
saLink® C9000 color printers only.
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Physical Specifications

WWeeiigghhttss aanndd DDiimmeennssiioonnss

BBaassee MMooddeell

Width: 62 cm (24.4 in.)
Depth: 72.3 cm (28.5 in.)
Height: 80.9 cm (31.9 in.)
Weight: 81 kg (179 lb.)

BBaassee MMooddeell wwiitthh aa TTwwoo--TTrraayy MMoodduullee oorr TTaannddeemm TTrraayy MMoodduullee

Width: 62 cm (24.4 in.)
Depth: 72.3 cm (28.5 in.)
Height: 107.1 cm (42.2 in.)
Weight with a Two-Tray Module: 108 kg (238
lb.)
Weight with Tandem Tray Module: 115 kg (254
lb.)
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BBaassee MMooddeell wwiitthh TTwwoo--TTrraayy MMoodduullee aanndd OOffffiiccee FFiinniisshheerr LLXX

Width with stability foot: 122.8 cm (48.4 in.)
Depth: 72.3 cm (28.5 in.)
Height: 107.1 cm (42.2 in.)
Weight: ≤ 136 kg (300 lb.)

BBaassee MMooddeell wwiitthh TTaannddeemm TTrraayy MMoodduullee aanndd BBRR FFiinniisshheerr

Width with stability foot: 143.8 cm (56.6 in.)
Depth: 72.3 cm (28.5 in.)
Height: 107.1 cm (42.2 in.)
Weight: ≤ 183 kg (404 lb.)
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TToottaall SSppaaccee RReeqquuiirreemmeennttss

CClleeaarraannccee RReeqquuiirreemmeennttss ffoorr BBaassee MMooddeell

Width: 129.9 cm (51.1 in.)
Depth: 167.8 cm (66.1 in.)
Height, without table: 80.9 cm (31.9
in.)

CClleeaarraannccee RReeqquuiirreemmeennttss wwiitthh aa TTwwoo--TTrraayy MMoodduullee oorr TTaannddeemm TTrraayy
MMoodduullee

Width: 129.9 cm (51.1 in.)
Depth: 167.8 cm (66.1 in.)
Height: 107.1 cm (42.2 in.)
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CClleeaarraannccee RReeqquuiirreemmeennttss wwiitthh aa TTwwoo--TTrraayy MMoodduullee aanndd HHiigghh--
CCaappaacciittyy FFeeeeddeerr

Width: 138.7 cm (54.6 in.)
Depth: 167.8 cm (66.1 in.)
Height: 107.1 cm (42.2 in.)

CClleeaarraannccee RReeqquuiirreemmeennttss wwiitthh aa TTwwoo--TTrraayy MMoodduullee,, aanndd OOffffiiccee
FFiinniisshheerr LLXX wwiitthh BBooookklleett MMaakkeerr

Width: 188.7 cm (74.3 in.)
Depth: 167.8 cm (66.1 in.)
Height: 108 cm (42.5 in.)
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CClleeaarraannccee RReeqquuiirreemmeennttss wwiitthh aa TTwwoo--TTrraayy MMoodduullee,, HHiigghh--CCaappaacciittyy
FFeeeeddeerr,, aanndd OOffffiiccee FFiinniisshheerr LLXX wwiitthh BBooookklleett MMaakkeerr

Width: 197.6 cm (77.8 in.)
Depth: 167.8 cm (66.1 in.)
Height: 108 cm (42.5 in.)

CClleeaarraannccee RReeqquuiirreemmeennttss wwiitthh aa TTaannddeemm TTrraayy MMoodduullee,, HHiigghh--
CCaappaacciittyy FFeeeeddeerr,, aanndd BBRR BBooookklleett MMaakkeerr FFiinniisshheerr

Width: 214.2 cm (84.3 in.)
Depth: 167.8 cm (66.1 in.)
Height: 107.1 cm (42.2 in.)
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CClleeaarraannccee RReeqquuiirreemmeennttss wwiitthh aa TTaannddeemm TTrraayy MMoodduullee aanndd BBRR
BBooookklleett MMaakkeerr FFiinniisshheerr

Width: 205.4 cm (80.8 in.)
Depth: 167.8 cm (66.1 in.)
Height: 107.1 cm (42,2 in.)
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Environmental Specifications

TTeemmppeerraattuurree
• Operating Temperature Range: 10° to 32°C (50° to 90°F)

• Optimal Temperature Range: 10° to 28°C (50° to 82°F)

RReellaattiivvee HHuummiiddiittyy
• Operating Humidity Range: 15% to 85%

• Optimal Humidity Range: 15% to 62.5% relative humidity at 28°C (82°F)

Note: Under extreme environmental conditions, such as 10°C (50°F) and 85% relative humid-
ity, printing defects can occur due to condensation inside the printer.

EElleevvaattiioonn
For optimum performance, use the printer at elevations below 2500 m (8200 ft.).

Note: To use the printer at elevations above 2000 m (6560 ft.), the printer may need
adjustment.
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Electrical Specifications

PPoowweerr CCoonnssuummppttiioonn
• 110–127 V:

– Maximum power consumption: 1.4 kW

– Sleep mode: 0.48 W or less

– Low-Power mode: 75.3 W or less

– Standby mode: 75.3 W or less

• 220–240 V:

– Maximum power consumption: 2.2 kW

– Sleep mode: 0.53 W or less

– Low-Power mode: 73.8 W or less

– Standby mode: 73.8 W or less

PPoowweerr SSuuppppllyy VVoollttaaggee aanndd FFrreeqquueennccyy

Power Supply Voltage Frequency Current Required

110–127 VAC +6%/-10%

(99–135 VAC)

50/60 Hz +/-3% 12 A

220–240 VAC +/-10%

(198–264 VAC)

50/60 Hz +/-3% 10 A

EENNEERRGGYY SSTTAARR QQuuaalliiffiieedd PPrroodduucctt
This product is ENERGY STAR® qualified under the ENERGY STAR Program Require-
ments for Imaging Equipment.
The ENERGY STAR and ENERGY STAR mark are registered United States
trademarks.
The ENERGY STAR Imaging Equipment Program is a team effort between United
States, European Union, and Japanese governments and the office equipment in-
dustry to promote energy-efficient copiers, printers, fax, multifunction printers, per-
sonal computers, and monitors. Reducing product energy consumption helps
combat smog, acid rain, and long-term changes to the climate by decreasing the
emissions that result from generating electricity.

ENERGY STAR settings are preset on Xerox® equipment at the factory to switch to Power Saver modes
after 10 minutes from the last copy or print.

Note: The ENERGY STAR qualification only applies to printer configurations with automatic 2-
sided printing.
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RReeccyycclliinngg SSuupppplliieess
For more information on the Xerox® supplies recycling program, go to www.xerox.com/recycling.

Xerox® VersaLink® C8000/C9000 Color Printer
User Guide

237

Specifications

https://www.xerox.com/perl-bin/product.pl?mode=recycling&referer=xrx


Performance Specifications
Feature Specifications

Printer warm-up time Power on: ≤ 60 seconds

Recovery from sleep mode ≤ 10 seconds

Recovery from low-power mode ≤ 10 seconds

PPrriinntt SSppeeeedd
Several factors affect print speed:

• Print mode: The fastest print mode is Standard.

• Paper orientation. For faster print speeds, load paper long-edge feed. Loading paper short-edge
feed reduces print speeds. Also, when printing short-edge feed, Letter (8.5 x 11 in.) prints slightly
faster than A4 (210 x 297 mm).

• Paper size: Letter (8.5 x 11 in.) and A4 (210 x 297 mm) sizes share the fastest print speeds. Larger
paper sizes reduce print speeds.

• Paper type and weights: For faster printing, use paper weights of 105 g/m² or less.

• Paper source: Internal paper trays are slightly faster than other paper sources, such as the Bypass
Tray.

Maximum Print Speeds for color, and black and white:

Xerox® VersaLink® C8000 Color Printer:

Paper Weight A4/Letter, LEF A3, SEF

1-Sided
Printing

2-Sided
Printing

1-Sided
Printing

2-Sided
Printing

Plain: 64–105 g/m2 45 ppm 45 ppm 22 ppm 15 ppm

Heavyweight 1: 106–176 g/m2 36 ppm 36 ppm 18 ppm 13.8 ppm

Coated 1: 106–176 g/m2 25 ppm 25 ppm 14 ppm 8.5 ppm

Heavyweight 2: 177–220 g/m2 25 ppm 25 ppm 14 ppm 8.5 ppm

Heavyweight 3: 106–176 g/m2 25 ppm 25 ppm 14 ppm 8.5 ppm

Label: 106–176 g/m2 36ppm NA 18 ppm NA

Envelope 25 ppm NA 14 ppm NA
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Xerox® VersaLink® C9000 Color Printer:

Note: For Heavyweight 3, for 2-sided printing, performance is not guaranteed.

Paper Weight A4/Letter, LEF A3, SEF

1-Sided
Printing

2-Sided
Printing

1-Sided
Printing

2-Sided
Printing

Plain: 64–105 g/m2 55 ppm 55 ppm 27 ppm 19 ppm

Heavyweight 1: 106–176 g/m2 36 ppm 36 ppm 18 ppm 13.8 ppm

Coated 1: 106–176 g/m2 25 ppm 25 ppm 14 ppm 8.5 ppm

Heavyweight 2: 177–220 g/m 2 25 ppm 25 ppm 14 ppm 8.5 ppm

Heavyweight 3: 221–300 g/m2 25 ppm 25 ppm 14 ppm 8.5 ppm

Extra Heavyweight: 301–350 g/m2

Note: Bypass Tray only

25 ppm NA 14 ppm NA

Label: 106–176 g/m2 36 ppm NA 18 ppm NA

Envelope 25 ppm NA 14 ppm NA

Note: For Heavyweight 3, for 2-sided printing, performance is not guaranteed.
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Basic Regulations
Xerox has tested this printer to electromagnetic emission and immunity standards. These standards
are designed to mitigate interference caused or received by this printer in a typical office
environment.

RReegguullaattoorryy IInnffoorrmmaattiioonn ffoorr 22..44--GGHHzz aanndd 55--GGHHzz
WWiirreelleessss NNeettwwoorrkk AAddaapptteerrss
This product contains a 2.4-GHz and 5-GHz Wireless LAN radio transmitter module that complies with
the requirements specified in FCC Part 15, Industry Canada RSS-210, and European Council Directive
2014/53/EU. Radio Frequency (RF) output power of this device will not exceed 20 dBm in either fre-
quency band.

Operation of this device is subject to the following two conditions:

1. This device may not cause harmful interference, and

2. This device must accept any interference received, including interference that may cause unde-
sired operation.

Changes or modifications to this device not specifically approved by the Xerox Corporation may void
the user's authority to operate this equipment.

UUnniitteedd SSttaatteess FFCCCC RReegguullaattiioonnss
This equipment has been tested and found to comply with the limits for a Class A digital device, pur-
suant to Part 15 and Part 18 of the FCC Rules. These limits are designed to provide reasonable protec-
tion against harmful interference when the equipment is operated in a commercial environment. This
equipment generates, uses, and can radiate radio frequency energy. If the equipment is not installed
and used in accordance with these instructions, it can cause harmful interference to radio communica-
tions. Operation of this equipment in a residential area is likely to cause harmful interference. Users
are required to correct the interference at their own expense.

If this equipment does cause harmful interference to radio or television reception, which can be deter-
mined by turning the equipment off and on, the user is encouraged to try to correct the interference
by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

• Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications to this equipment not approved by Xerox can void the authority of the user
to operate this equipment.

WARNING: To ensure compliance with Part 15 and Part 18 of the FCC rules, use shielded inter-
face cables.
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CCaannaaddaa
This Class A digital apparatus complies with Canadian ICES-003 and ICES-001.

Cet appareil numérique de la classe A est conforme à la norme NMB-003 et NMB-001 du Canada.

EEccooLLooggoo CCeerrttiiffiieedd ttoo OOffffiiccee MMaacchhiinneess CCCCDD--003355

This product is certified to EcoLogo standard for office machines, meeting all require-
ments for reduced environmental impact. As part of achieving certification, Xerox Cor-
poration has proven this product meets the EcoLogo criteria for energy efficiency.
Certified copier, printer, multifunctional device, and fax products must also meet crite-
ria such as reduced chemical emissions and demonstrate compatibility with recycled
supplies. EcoLogo was established in 1988 to help consumers find products and serv-
ices with reduced environmental impacts. EcoLogo is a voluntary, multi-attribute, and
lifecycle-based environmental certification. This certification indicates that a product
has undergone rigorous scientific testing, exhaustive auditing, or both, to prove its
compliance with stringent, third-party, environmental performance standards.

CCeerrttiiffiiccaattiioonnss iinn EEuurrooppee

The CE mark applied to this product symbolizes a declaration of conformity by Xerox
with the following applicable Directives of the European Union as of the date
indicated:
• April 16, 2014: Radio Equipment Directive 2014/53/EU

Hereby, Xerox declares that the radio equipment model VersaLink C8000/C9000 is in compliance with
Directive 2014/53/EU. The full text of the EU declaration of conformity can found at the following in-
ternet address:

• For Xerox® VersaLink® C8000 Color Printer: www.xerox.com/about-xerox/environment_europe

• For Xerox® VersaLink® C9000 Color Printer: www.xerox.com/about-xerox/environment_europe

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or
for the environment.

WARNING:

• Changes or modifications to this equipment not specifically approved by the Xerox Corpora-
tion may void the user's authority to operate this equipment.

• External radiation from Industrial, Scientific, and Medical (ISM) equipment can interfere
with the operation of this Xerox device. If external radiation from ISM equipment interferes
with this device, contact your Xerox representative for assistance.

• This is a class A product. In a domestic environment, this product can cause radio frequency
interference, in which case the user can be required to take adequate measures.

• To ensure compliance with European Union regulations, use shielded interface cables.
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EEuurrooppeeaann UUnniioonn LLoott 44 IImmaaggiinngg EEqquuiippmmeenntt AAggrreeeemmeenntt
EEnnvviirroonnmmeennttaall IInnffoorrmmaattiioonn
Environmental Information Providing Environmental Solutions and Reducing Cost
The following information has been developed to assist users and has been issued in relation to the
European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging
Equipment. This requires manufacturers to improve environmental performance of in scope products
and supports the EU action plan on energy efficiency.

In scope products are Household and Office equipment that meet the following criteria:

• Standard monochrome format products with a maximum speed less than 66 A4 images per
minute

• Standard color format products with a maximum speed less than 51 A4 images per minute

ENERGY STAR

The ENERGY STAR program is a voluntary scheme to promote the development
and purchase of energy-efficient models, which help to reduce environmental
impact. Details on the ENERGY STAR program and models qualified to ENERGY
STAR can be found at the following website: www.energystar.gov.
The ENERGY STAR and ENERGY STAR mark are registered United States
trademarks.
The ENERGY STAR Imaging Equipment Program is a team effort between United
States, European Union, Japanese governments, and the office equipment in-
dustry to promote energy-efficient copiers, printers, fax, multifunction printers,
personal computers, and monitors. Reducing product energy consumption helps
combat smog, acid rain, and long-term changes to the climate by decreasing the
emissions that result from generating electricity.

For more information on energy or other related topics, go to www.xerox.com/about-xerox/
environment/enus.html or www.xerox.co.uk/about-xerox/environment/engb.html.

Power Consumption and Activation Time
The amount of electricity that a device consumes depends on the way the device is used. This device
is designed and configured to enable you to reduce your electricity usage.

Power Saver modes are enabled on your device to reduce energy consumption. After the last print,
the device transitions to Ready mode. In this mode, the device can print again immediately. If the de-
vice is not used for a specified period, the device transitions to Low Power mode, then to Sleep mode.
In these modes, to enable reduced-power consumption, only essential functions remain active. The
device takes longer to produce the first print after it exits the Power Saver modes than it takes to print
in Ready mode. This delay is the result of the system waking up and is typical of most imaging devices
on the market.

To save power, you can enable Auto Power Off mode on your device. If Auto Power Off mode is en-
abled, you can configure the mode as follows:
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• Always Allowed: The device powers off automatically after the specified time, and the cumulative
Low Power mode and Sleep mode timeouts have elapsed.

• Allowed ONLY When Conditions are Met: The device automatically powers off only after time-
outs have elapsed. The device also powers off if Fax, USB Drive, and Wired and Non-Wired Net-
work have not been activated.

To change the Power Saver settings, refer to the User Guide at www.xerox.com/support/VLC8000docs
or www.xerox.com/support/VLC9000docs. For further assistance, contact your System Administrator
or refer to the System Administrator Guide.

To enable Auto Power Off mode, contact your System Administrator. For details, refer to the System
Administrator Guide at www.xerox.com/support/VLC8000docs or www.xerox.com/support/
VLC9000docs.

To learn more about Xerox participation in sustainability initiatives, go to: www.xerox.com/about-
xerox/environment/enus.html or www.xerox.co.uk/about-xerox/environment/engb.html.

Note: Changing the default Power Saver activation times can result in an overall higher energy
consumption of the device. Before you turn off Power Saver modes or set a long activation
time, consider the increase in device power consumption.

Default Power Saver Settings
This device is ENERGY STAR®-qualified under the ENERGY STAR Program Requirements for Imaging
Equipment. The transition time from Ready mode to Low-Power mode can be set up to 60 minutes.
The default value is 10 minutes. The transition time from Low-Power mode to Sleep mode can be set
up to 60 minutes. The default value is set at 1 minute. The total transition time from Ready mode to
Sleep mode can take up to 60 minutes.

To change the Power Saver settings, contact your System Administrator, or refer to the System Admin-
istrator Guide at:

• Xerox® VersaLink® 8000 Color Printer: www.xerox.com/support/VLC8000docs

• Xerox® VersaLink® 9000 Color Printer: www.xerox.com/support/VLC9000docs

Environmental Benefits of Duplex Printing
Most Xerox products have duplex printing, also known as 2-sided printing, capability. This enables you
to print on both sides of the paper automatically, and therefore helps to reduce the use of valuable re-
sources by reducing your paper consumption. The Lot 4 Imaging Equipment agreement requires that
on models greater than or equal to 40 ppm color or greater than or equal to 45 ppm monochrome
the duplex function has been auto-enabled, during the setup and driver installation. Some Xerox mod-
els below these speed bands may also be enabled with 2-sided printing settings defaulted on at the
time of install. Continuing to use the duplex function will reduce the environmental impact of your
work. However, should you require simplex/1-sided printing, you may change the print settings in the
print driver.

Paper Types
This product can be used to print on both recycled and virgin paper, approved to an environmental
stewardship scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper
(60 g/m²), which contains less raw material and thus saves resources per print, may be used in certain
applications. We encourage you to check if this is suitable for your printing needs.

Xerox® VersaLink® C8000/C9000 Color Printer
User Guide

245

Regulatory Information

http://www.support.xerox.com/support/versalink-c8000/documentation
http://www.support.xerox.com/support/versalink-c9000/documentation
http://www.support.xerox.com/support/versalink-c8000/documentation
http://www.support.xerox.com/support/versalink-c9000/documentation
http://www.support.xerox.com/support/versalink-c9000/documentation
https://www.xerox.com/en-us/about/ehs
https://www.xerox.com/en-us/about/ehs
https://www.xerox.co.uk/en-gb/about/ehs
http://www.support.xerox.com/support/versalink-c8000/documentation
http://www.support.xerox.com/support/versalink-c9000/documentation


EEuurraassiiaann EEccoonnoommiicc CCoommmmuunniittyy CCeerrttiiffiiccaattiioonn

Russia, Belarus, and Kazakhstan are working to establish a common customs union,
the Eurasian Economic Community, or EurAsEC. The Eurasian Economic Community
members anticipate sharing a common regulatory scheme and common EurAsEC cer-
tification mark, the EAC Mark.

GGeerrmmaannyy

GGeerrmmaannyy -- BBlluuee AAnnggeell

RAL, the German Institute for Quality Assurance and Labeling, has awarded this de-
vice the Blue Angel Environmental Label. This label distinguishes it as a device that
satisfies Blue Angel criteria for environmental acceptability in terms of device design,
manufacture, and operation. For more information, go to: www.blauer-engel.de.

BBlleennddsscchhuuttzz
Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz vorge-
sehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht im
unmittelbaren Gesichtsfeld platziert werden.

LLäärrmmeemmiissssiioonn
Maschinenlärminformations-Verordnung 3. GPSGV: Der höchste Schalldruckpegel beträgt 70 dB(A)
oder weniger gemäß EN ISO 7779.

IImmppoorrtteeuurr
Xerox GmbH

Hellersbergstraße 2-4

41460 Neuss

Deutschland

TTuurrkkeeyy RRooHHSS RReegguullaattiioonn
In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.”

“EEE yönetmeliğine uygundur.”
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Safety Certification
This device is certified by the following Agencies using the following safety standards.

Agency Standard

TÜV Rheinland (US/Canada) UL 60950-1, 2nd Edition, 2014-10-14

CAN/CSA C22.2 No. 60950-1-07, 2nd Edition, 2014-10

TÜV Rheinland (Europe) IEC 60950-1:2005 + A1:2009 + A2:2013

EN 60950-1:2006 + A11:2009 + A1:2010 + A12:2011 + A2:2013
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Material Safety Data Sheets
For Material Safety Data information regarding your printer, go to:

• North America: www.xerox.com/safety-data

• European Union: www.xerox.com/about-xerox/environment_europe

For the Customer Support Center phone numbers, go to www.xerox.com/worldcontacts.
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All Countries
If you are managing the disposal of your Xerox product, please note that the printer may contain
lead, mercury, perchlorate, and other materials whose disposal may be regulated due to environmen-
tal considerations. The presence of these materials is fully consistent with global regulations applica-
ble at the time that the product was placed on the market. For recycling and disposal information,
contact your local authorities. Perchlorate Material: This product may contain one or more Perchlo-
rate-containing devices, such as batteries. Special handling may apply. For more information, go to
www.dtsc.ca.gov/hazardouswaste/perchlorate.
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North America
Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative
(1-800-ASK-XEROX) to determine if this Xerox product is part of the program. For more information
about Xerox environmental programs, visit:

• Xerox® VersaLink® 8000 Color Printer: www.xerox.com/about-xerox/environment

• Xerox® VersaLink® 9000 Color Printer: www.xerox.com/about-xerox/environment

For recycling and disposal information, contact your local authorities.
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European Union
Some equipment may be used in both a domestic/household and a professional/business application.

DDoommeessttiicc//HHoouusseehhoolldd EEnnvviirroonnmmeenntt
Application of this symbol on your equipment is confirmation that you should not dis-
pose of the equipment in the normal household waste stream.

In accordance with European legislation, end of life electrical and electronic equipment subject to dis-
posal must be segregated from household waste.

Private households within EU member states may return used electrical and electronic equipment to
designated collection facilities free of charge. Please contact your local disposal authority for
information.

In some member states, when you purchase new equipment, your local retailer may be required to
take back your old equipment free of charge. Please ask your retailer for information.

PPrrooffeessssiioonnaall//BBuussiinneessss EEnnvviirroonnmmeenntt
Application of this symbol on your equipment is confirmation that you must dispose of
this equipment in compliance with agreed national procedures.

In accordance with European legislation, end of life electrical and electronic equipment subject to dis-
posal must be managed within agreed procedures.

Prior to disposal, please contact your local reseller or Xerox representative for end of life take-back
information.
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CCoolllleeccttiioonn aanndd DDiissppoossaall ooff EEqquuiippmmeenntt aanndd BBaatttteerriieess

These symbols on the products and/or accompanying documents mean that used electrical
and electronic products and batteries should not be mixed with general household waste.
For proper treatment, recovery, and recycling of old products and used batteries, please take
them to applicable collection points, in accordance with your national legislation and the Di-
rective 2002/96/EC and 2006/66/EC.
By disposing of these products and batteries correctly, you will help to save valuable resources
and prevent any potential negative effects on human health and the environment which
could otherwise arise from inappropriate waste handling.
For more information about collection and recycling of old products and batteries, please con-
tact your local municipality, your waste disposal service or the point of sale where you pur-
chased the items.
Penalties may be applicable for incorrect disposal of this waste, in accordance with national
legislation.

BBuussiinneessss UUsseerrss iinn tthhee EEuurrooppeeaann UUnniioonn
If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for
further information.

DDiissppoossaall OOuuttssiiddee ooff tthhee EEuurrooppeeaann UUnniioonn
These symbols are only valid in the European Union. If you wish to discard these items, please contact
your local authorities or dealer and ask for the correct method of disposal.

BBaatttteerryy SSyymmbbooll NNoottee

This wheeled bin symbol may be used in combination with a chemical symbol. This es-
tablishes compliance with the requirements set out by the Directive.

BBaatttteerryy RReemmoovvaall
Batteries should only be replaced by a manufacturer-approved service facility.
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Other Countries
Please contact your local waste management authority to request disposal guidance.
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